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About this Guide

This guide provides pre-installation, installation, and uninstallation instructions for
Software AG products, specifically Apama, Terracoa, and webMethods.

Note: For instructions on installing products not covered in this guide, see the
product documentation.

This guide is intended for use with Using the Software AG Installer. That guide explains
how to prepare your machine to use the Software AG Installer, and how to use the
Software AG Installer and Software AG Uninstaller to install and uninstall your
products.

Important: If you want to upgrade products, you must use the instructions in the
appropriate product upgrade guide. The instructions in this installation
guide do not cover upgrades, so following the instructions in this guide for
upgrades would have unpredictable results.

Document Conventions

Convention Description

Bold Identifies elements on a screen.

Narrowfont Identifies storage locations for services on webMethods
Integration Server, using the convention folder.subfolder:service .

UPPERCASE Identifies keyboard keys. Keys you must press simultaneously
are joined with a plus sign (+).

Italic Identifies variables for which you must supply values specific to
your own situation or environment. Identifies new terms the first
time they occur in the text.

Monospace
font

Identifies text you must type or messages displayed by the
system.

{ } Indicates a set of choices from which you must choose one. Type
only the information inside the curly braces. Do not type the { }
symbols.
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Convention Description

| Separates two mutually exclusive choices in a syntax line. Type
one of these choices. Do not type the | symbol.

[ ] Indicates one or more options. Type only the information inside
the square brackets. Do not type the [ ] symbols.

... Indicates that you can type multiple options of the same type.
Type only the information. Do not type the ellipsis (...).

Online Information
Software AG Documentation Website

You can find documentation on the Software AG Documentation website at hp://
documentation.softwareag.com. The site requires Empower credentials. If you do not
have Empower credentials, you must use the TECHcommunity website.

Software AG Empower Product Support Website

You can find product information on the Software AG Empower Product Support
website at hps://empower.softwareag.com.

To submit feature/enhancement requests, get information about product availability,
and download products, go to Products.

To get information about fixes and to read early warnings, technical papers, and
knowledge base articles, go to the Knowledge Center.

Software AG TECHcommunity

You can find documentation and other technical information on the Software AG
TECHcommunity website at hp://techcommunity.softwareag.com. You can:

Access product documentation, if you have TECHcommunity credentials. If you do
not, you will need to register and specify "Documentation" as an area of interest.

Access articles, code samples, demos, and tutorials.

Use the online discussion forums, moderated by Software AG professionals, to
ask questions, discuss best practices, and learn how other customers are using
Software AG technology.

Link to external websites that discuss open standards and web technology.

http://documentation.softwareag.com
http://documentation.softwareag.com
https://empower.softwareag.com
https://empower.softwareag.com/Products/default.asp
https://empower.softwareag.com/KnowledgeCenter/default.asp
http://techcommunity.softwareag.com
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How to Use This Guide
This guide provides product-specific preparation, installation, and uninstallation
instructions. These instructions are intended for use with Using the Software AG Installer.
That guide explains how to prepare your machine to use the Software AG Installer, and
how to use the Software AG Installer to install and uninstall your products. It describes
the various methods you can use to install and uninstall, such as using the installer
wizard, the installer console mode, an installation script, or an installation image. It
describes JDK support for the installer, the uninstaller, and the products, and explains
installation and uninstallation logging

Recommendations
Software AG strongly recommends that you create installation images of your
products and store them on your internal network. Create an image for each
operating system on which you plan to install that is covered by your license
agreement. Storing images enables you to ensure consistency across installations
over time; the installer provides only the latest product releases, while installation
images contain the product releases you download into them. In addition, installing
from images helps you reduce WAN traffic and improve installation speeds. For
instructions on creating an installation image, see Using the Software AG Installer.

When you need multiples of the same release of a product on one machine,
Software AG recommends that you create multiple instances of the product in the
same installation rather than creating multiple installations of the same product
on the machine. Most products now offer this functionality. The valid use cases for
creating multiple installations on the same machine are when those installations are
from different releases (for example, side-by-side upgrade), different environments
(for example, production environment on fix level 1 and test environment on fix level
2), or different projects (for example, installations used by different departments
within an organization).

Note: If you are using a virtualization layer such as VMWare, the above use cases
are typically handled using different VM instances on a single powerful
VM server, with a single installation on each VM instance.

Product Licenses
You must provide license files to install and, later, to start some products. Software AG
sends these license files with your installation message; save the license files in a
directory whose name and path do not contain any spaces.

When you provide the license files during installation, the installer validates that:
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The license file is the correct one for the product.

The license file has not been changed.

The license file has not expired.

The product is licensed on the operating system on which you are installing.

You will only be able to install a product if its license file passes these checks. The
products will repeat these checks at startup.
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Methods for Installing and Uninstalling Products
You can install products using different methods. The methods can involve Software AG
Installer, Command Central, and Platform Manager. Platform Manager is an agent that
enables Command Central to install and administer products.

You can use the Software AG Installer to install all products. The installer
automatically installs Platform Manager with the products so they can be
administered from Command Central. For instructions on installing using the
Software AG Installer, see Using the Software AG Installer and this guide.

You can use Command Central and Platform Manager to install most products.
For the list of products Command Central can install, see the Command Central
readme. For instructions on where to install Command Central, see "Installing and
Uninstalling Command Central, Platform Manager, Deployer, and Asset Build
Environment" on page 21 of this guide. For detailed instructions on the steps
below, see Software AG Command Central Help.

1. Use the Command Central bootstrapper to install Command Central.

2. Install Platform Manager on target installation machines as follows:

If the target installation machine is configured for remote access (typically the
case for UNIX systems and for Windows systems equipped with OpenSSH),
use Command Central to install Platform Manager.

If the target installation machine is not configured for remote access, log on to
the target installation machine and use the Platform Manager bootstrapper to
install Platform Manager.

3. Use Command Central to install products. You can install these products in the
same installation directory as Platform Manager.

You can uninstall products using Software AG Installer or Command Central. You do
not have to use the same tool to uninstall that you used to install.
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Administration and Deployment Installations

Install Command Central
You can manage multiple installations of most products from Command Central.
You can use Command Central to install products and fixes; create and configure
product instances; and start, stop and monitor runtime components. You can also
create new environments and clone existing installations using templates. For the list of
products Command Central supports, see the Command Central readme. This release of
Command Central can manage installations that are release 9.0 or later.

Install one Command Central to manage all development and test environments. Install
a separate Command Central to manage all production environments. In each case, the
host machine must have access to all products you want to manage.

You can install Command Central, Deployer, and ABE in the same installation directory
(see "Install Deployer and ABE" on page 22). However, do not install any other
Software AG products in that installation directory.

Restrict access to the machine to only those people who need to use Command
Central, such as release managers, infrastructure engineers, system administrators, and
operators.

Platform Manager is an agent that enables Command Central to install and administer
products. For instructions on installing Platform Manager, see "Installation and
Uninstallation Methods" on page 19.

Install Deployer and ABE
You can deploy assets from one environment to another (for example, from a
development environment to a production environment) using Deployer and the Asset
Build Environment (ABE). In runtime-based deployment, you use Deployer to deploy
assets from source servers to target servers. In repository-based deployment, you use
ABE to build assets from source servers or a VCS to a file-based repository, and then
use Deployer to deploy the assets from the repository to target servers. Software AG
recommends using repository-based deployment.

If no firewall separates your development, test, and production environments, install
one Deployer to handle all environments. The host machine must have access to all
source servers you want to deploy from, and all target servers you want to deploy
to. If you are using Command Central, install Deployer on the same machine as the
Command Central you install to manage your development and test environments.

If you want to use repository-based deployment, install ABE on the same machine as
Deployer. The machine must be able to access the file system that will host the file-based
repository. If you want to build assets from a VCS instead of source servers, the machine
must be able to access the VCS.
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If a firewall separates your development and test environments from your production
environments, install a separate Deployer to handle your production environments.
The host machine must have access to all target servers you want to deploy to. If you
are using Command Central, install Deployer on the same machine as the Command
Central you install to manage your production environments.

You can install Command Central, Deployer, and ABE in the same installation directory.
However, do not install any other Software AG products in that installation directory.

Restrict access to the machine to only those people who need to use Deployer or
ABE, such as release managers, infrastructure engineers, system administrators, and
operators.

Software and Hardware Support and Requirements

Operating System and Browser Support
For information on operating systems, RDBMSs, and browsers that are supported by
your products, see System Requirements for Software AG Products.

For information on supported database drivers, see "Database Components" on page
156.

Software Requirements and Considerations

Product Software Requirements and Considerations

All If the vendor for your operating system recommends installing
the latest service packs, patch-bundles, and fixes, Software AG
encourages you to follow that recommendation. If you
experience problems with installed service packs, patch-bundles,
or fixes, report those problems directly to the vendor.

Integration
Server

On Mac OS X systems, Integration Servers cannot connect to
webMethods Brokers using SSL.

Hardware Requirements
The table below lists the minimum and recommended hardware requirements for your
products. Recommended amounts are shown in parentheses. Deployer has minimal or
no requirements beyond the host Integration Server. Asset Build Environment has no
requirements.
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Important: The hardware requirements below are for the listed products only. They do
not include 2GB of hard drive space for Software AG infrastructure shared
libraries required by most products and installed once per installation
directory. They do not include requirements for supporting software such as
RDBMSs. You must determine the overall hardware requirements for each of
your machines based on the overall requirements of your operating system
and software.

Product Hard Drive Space RAM CPUs

Command Central 500MB 512MB (1GB for 100
nodes)

1 (2)

Integration Server 300MB
(500MB)

1GB (2GB) 1 (2)

Platform Manager 500MB 128MB 1

Command Central and Platform Manager need additional hard drive space if you use
template-based provisioning functionality. The space required depends on the total
size of template-generated files, such as images, configuration files to store, upload, and
download.

Deployer needs additional hard drive space for the deployment projects you create.
When allocating space, allow for the number of projects to increase over time.

Shut Down Products
Shut down all non-Software AG applications that are running on the machine on which
you are going to install. If these applications are not shut down, product files might
become corrupted.

Install Products

Start the Installer, Provide General Information, and Choose the
Products to Install
As you go through the Software AG Installer, you will be asked for various types of
information, such as product license files and database connection parameters. Scan the
pages in this chapter that show the installer panels you will encounter, and gather the
information you will need before starting the installer.
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Read the requirements in Using the Software AG Installer (for example, the requirement
to create a user account that has the proper privileges for Windows and that is non-root
for UNIX). Follow the instructions in that guide to start the installer and provide general
information such as proxy server, release to install, installation directory, and how to use
the product selection tree.

On the product selection tree, select the products to install.

After the product selection tree, the installer displays the language pack selection tree.
For information on language packs, see the international operating environments
appendix in this guide. The installer then displays panels (GUI mode) or prompts
(console mode) that ask for product configuration information. The sections below show
the panels, but the information and fields on the panels are identical to the information
and fields in the prompts.

Important: Make sure all ports you specify on panels or in response to prompts are
not already being used by other products on your machine. The installer
cannot detect whether ports are in use when products are shut down, and
the shuing down of products is a requirement for running the installer. See
the list of default ports used by Software AG products.

Supply Product Configuration Information

Sudo
When you install on a UNIX system, the panel below might appear.

https://empower.softwareag.com/sl24sec/SecuredServices/Products.nav5/Component_Downloads.lnk2/TCPIP/tcpip_used_ports.pdf
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You must either have the installer run the afterInstallAsRoot.sh script, or you must run
the script manually after installation as explained later in this chapter. If you want to
have the installer run the script, the user under which you are running the installer must
be in the sudoers configuration.

For security reasons, the installer does not store the sudo password in installation
scripts. If you are creating or installing from an installation script, therefore, the
option to use sudo is not available. You will have to run the afterInstallAsRoot.sh
script manually after installation as a user who is in the sudoers configuration. See the
instructions for registering daemons and seing file permissions later in this chapter.
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Command Central Server
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Integration Server

For Database Connection, accept the default choice of Embedded database.
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Platform Manager

Complete the Installation
For some products, you must perform certain tasks before startup. This section explains
those tasks.

For instructions on starting products and performing post-startup configuration and
customization, see the product documentation.
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Change Default Passwords
Products are installed with default passwords. For security reasons, you should change
these passwords as soon as possible. For instructions, see the product documentation.

Install Latest Fixes
Install the latest fixes on the products you installed. For instructions on using the
Software AG Update Manager, see Using the Software AG Update Manager. Each fix
includes a readme file that contains instructions on installing the fix.

Register Daemons and Set File Permissions
If you were asked whether to use sudo during installation on a UNIX system
and you chose not to, the installer was not able to register daemons and set file
permissions. Perform these tasks now by running the script Software AG_directory /bin/
afterInstallAsRoot.sh as a user who is in the sudoers configuration.

Important: You must run this script or your products might not work correctly.

The installer and this script register daemons for certain products only; for other
products, you perform the daemon registration yourself. For complete details and
instructions, see "Register Daemons to Automatically Start and Shut Down Products on
UNIX Systems" on page 193.

Complete the Integration Server Installation on a Mac OS X or Other
UNIX System
If non-root users will be running Integration Server, you might want to change the
ownership of the installed files to allow a single non-root user to run Integration Server
(chown), change the file group to the group of users who will run Integration Server
(chgrp), or change file permissions to allow all users to run Integration Server (chmod).

Connect Products to Each Other
If you installed all products at the same time, and did not change any port seings or
default passwords after installation, many inter-product connections are configured
automatically. For instructions on connecting products to each other, see the product
documentation.
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Uninstall Products
Follow the instructions in Using the Software AG Installer, with the additional guidelines
below.

If you are going to uninstall from a Mac OS or other UNIX system, and you used sudo to
register daemons and set file permissions during or after installation, you must also use
sudo to unregister daemons and remove file permissions, as follows:

If you are not going to use an uninstallation script to uninstall, you can choose
the uninstaller option to perform this task, or you can perform this task before
starting the uninstaller by executing the script Software AG_directory/bin/
beforeUninstallAsRoot.sh as a user who is in the sudoers configuration.

If you are going to use an uninstallation script, the uninstaller cannot execute the
script because it does not store the sudo password, for security reasons. You must
execute the script yourself before starting the uninstaller.

Important: You must either have the uninstaller execute the script or run it yourself, or
some products might not work correctly.
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Typical Development Installation
The Software AG Installer offers typical development installations of products that
enable you to perform a certain task. When you select a typical development installation,
the installer automatically selects all products that make up that installation. The typical
development installation for this product is called Apama.

To create production environments, work with your administrators, Software AGGlobal
Consulting Services, and best practices documentation.

Software and Hardware Support and Requirements

Operating System and Browser Support
For information on operating system and browser support for your products, see System
Requirements for Software AG Products and Apama Supported Platforms.

Software Requirements and Considerations

Product Software Requirements and Considerations

All If the vendor for your operating system recommends installing
the latest service packs, patch-bundles, and fixes, Software AG
encourages you to follow that recommendation. If you experience
problems with installed service packs, patch-bundles, or fixes, report
those problems directly to the vendor.

Apama To build samples and develop Apama applications using Apama
APIs, you might need to install additional compilers. For details, see
the Apama documentation.

Hardware Requirements

Minimum and Recommended Hardware Requirements
The table below lists approximate minimum hardware requirements for your products.

Important: The hardware requirements below are for Apama only. They do not include
2GB of hard drive space for Software AG infrastructure shared libraries
required by most products and installed once per installation directory.
You must determine the overall hardware requirements for each of your
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machines based on the overall requirements of your operating system and
software.

Product Hard Drive
Space

RAM CPUs

Apama    

 Server 750MB 4GB 2

 Capital Markets Foundation 55MB 4GB 2

 Dashboard Viewer 400MB 4GB 2

 Adapter (one) 5MB 4GB 2

Predictive Analytics Engine 25MB 4GB 2

Software AG Designer Eclipse
platform

380MB 1.5GB
(2GB)

1 (2)

Additional Hardware Requirements

Product Additional Hardware Requirements

Apama Hard drive space, RAM, and CPU requirements for Apama vary
significantly depending on the Apama application you run. You
will need to determine processing and memory requirements
by measuring the application, since these requirements vary.
Contact Software AG Global Support for help.

Software AG
Designer

Using the Software AG Installer lists free space the Software AG
Installer requires in its system temp (Windows) or temporary
(UNIX) directory. For the Software AG Designer Eclipse
platform, the installer needs 700MB additional free hard drive
space in that directory.

Each product plug-ins you install in Software AG Designer can
require from 50K to 150MB of additional free hard drive space.
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Shut Down Products
Shut down all non-Software AG applications that are running on the machine on which
you are going to install. If these applications are not shut down, product files might
become corrupted.

If you are installing new products into an existing Software AG product installation
directory (that contains products from the same release), running products in that
directory must be shut down so the installer can update key files that are locked by
the operating system. If the products are running as applications, shut them down
manually. If the products are running as services or daemons, the installer will
automatically shut down many of them (and later restart them), but you must manually
shut down the products listed below (and later restart them).

Product Steps

CentraSite Shut down the Software AG Runtime service and the
CentraSite Registry Repository service.

Content Service
Platform

See the instructions in the product documentation.

Software AG
Designer

Click File > Exit.

Terracoa Server
Array

Run the bin/stop-tc-server.{bat|sh} command. If you are
running a mirror group, shut down the passive server and
then the active server.

Prepare Your Machine
The Apama Server port must be accessible to the Apama Dashboard Viewer. If you are
going to install on a Windows system, and the firewall is enabled, unblock network
access for this port. The default value for the port is 3278.

If you are going to install on a Linux system:

Turn off the Security Enhanced Linux (SELinux). Apama does not support this
option.

Linux systems are often run with their core file size limit set to zero. If problems
occur, no core file can be wrien, which makes it difficult to determine the cause of
the problem. Set the core file size to unlimited in the login configuration for each
Apama user.
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Install Products

Start the Installer, Provide General Information, and Choose the
Products to Install
As you go through the Software AG Installer, you will be asked for various types of
information, such as product license files and database connection parameters. Scan the
pages in this chapter that show the installer panels you will encounter, and gather the
information you will need before starting the installer.

Read the requirements in Using the Software AG Installer (for example, the requirement
to create a user account that has the proper privileges for Windows and that is non-root
for UNIX). Follow the instructions in that guide to start the installer and provide general
information such as proxy server, release to install, installation directory, and how to use
the product selection tree.

Important: Unless otherwise stated for a specific product, do not install products from
this release into a Software AG directory that contains products from any
other release. Unless otherwise stated for a specific product, you cannot mix
products from different releases in the same installation directory; if you do
so, you will experience problems or be unable to access functionality.

On the product selection tree, select the Apama components to install.

Supply Product Configuration Information

Apama
If you are installing the Apama Server or Dashboard Viewer, the installer displays the
panel below.
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Field Entry

License This field displays when you select Apama Server for
installation. If you do not enter a license, Apama Server will run
for 30 minutes and then will shut down.

Work directory Apama stored user-created content such as log files in its work
directory. Software AG recommends that you also store your
Apama applications in this directory.
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Complete the Installation

Install Latest Fixes
Install the latest fixes on the products you installed. For instructions on using the
Software AG Update Manager, see Using the Software AG Update Manager. Each fix
includes a readme file that contains instructions on installing the fix.

Uninstall Products
Follow the instructions in Using the Software AG Installer, with the additional guidelines
below.

If you are going to uninstall Software AG Designer Eclipse, and you want to review or
preserve Eclipse installation information, do so before starting the uninstaller, because
the uninstaller will delete the entire Software AG Designer installation directory. User-
created data that is stored in other directories, such as your workspace, will remain
untouched.
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Typical Development Installations
The Software AG Installer offers typical development installations of products that
enable you to perform a certain task. When you select a typical development installation,
the installer automatically selects all products that make up that installation. For
detailed information on how the products in each typical development installation work
together, see Understanding Software AG Products.

For some typical development installations, you must create certain database components.
A database component is a grouping of database objects that is used by one or more
products. The table below lists these database components. For complete information
about each database component, see "Creating and Dropping Database Components" on
page 155.

For some typical development installations, you might want to install additional
optional items. You can select these items after the installer selects the products that
make up your selected typical development installation. The table below lists the
additional optional items.

To create production environments, work with your administrators, Software AGGlobal
Consulting Services, and best practices documentation.

Typical
Installation

Database Components Additional Optional Items

ActiveTransfer ActiveTransfer, and all
for Integration Server
and My webMethods
Server

 

Application
Integration
Development

All for Integration
Server, My
webMethods Server,
and Trading Networks

Integration Server VSS, ClearCase,
or Subversion Support to maintain
Software AG Designer elements

Application
Platform
Development

All for Integration
Server

Integration Server VSS, ClearCase,
or Subversion Support to maintain
Software AG Designer elements

Business
Process
Development

All for Integration
Server, BPM, and My
webMethods Server;
optionally, Staging and
Reporting

Same as Application Integration

Central CentraSite Registry
Repository to support collaboration
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Typical
Installation

Database Components Additional Optional Items

CloudStreams
Service
Development

CloudStreamsEvents,
and all for Integration
Server

 

Composite
Application
Development

All for My webMethods
Server

Central CentraSite Registry
Repository to support collaboration

Software and Hardware Support and Requirements

Operating System and Browser Support
For information on operating systems, RDBMSs, and browsers that are supported by
your products, see System Requirements for Software AG Products.

For information on supported database drivers, see "Database Components" on page
156.

Software Requirements and Considerations

Product Software Requirements and Considerations

All If the vendor for your operating system recommends installing
the latest service packs, patch-bundles, and fixes, Software AG
encourages you to follow that recommendation. If you experience
problems with installed service packs, patch-bundles, or fixes,
report those problems directly to the vendor.

AgileApps See the AgileApps wiki.

Integration
Server

On Mac OS X systems, Integration Servers cannot connect to
webMethods Brokers using SSL.

http://www.agileappscloud.info/aa105
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Hardware Requirements

Minimum and Recommended Hardware Requirements
The table below lists the minimum and recommended hardware requirements for your
products. Recommended amounts are shown in parentheses.

Most products that are hosted by Integration Server (for example, CloudStreams or
Process Engine) or by My webMethods Server (for example, Business Console and Task
Engine) have minimal or no hardware requirements beyond the host product and are
therefore not listed below.

Important: The hardware requirements below are for the listed products only. They do
not include 2GB of hard drive space for Software AG infrastructure shared
libraries required by most products and installed once per installation
directory. They do not include requirements for supporting software such
as RDBMSs. They do not include the additional requirements listed in
"Additional Hardware Requirements" on page 45. You must determine
the overall hardware requirements for each of your machines based on the
overall requirements of your operating system and software.

Product Hard Drive
Space

RAM CPUs

ActiveTransfer Server 100MB
(200MB)

512MB 1

AgileApps 20GB 8GB 1 (4)

Collaboration 1.3GB 2GB (3GB) 2 (4)

Content Service Platform Server 1GB 2GB 1

Software AG Designer Eclipse
platform

380MB 1.5GB (2GB) 1 (2)

Integration Agent 275MB
(500MB)

512MB
(1GB)

1

Integration Server 300MB
(500MB)

1GB (2GB) 1 (2)

MashZone 10GB 7GB (16GB) 2 (4)



M
Odd Header

Installing and Uninstalling Application Integration, B2B Integration, or BPM

Installing Software AG Products Version 9.9 45

Product Hard Drive
Space

RAM CPUs

My webMethods Server 300MB
(500MB)

1GB (2GB) 1

Trading Networks Server 50MB  1

Additional Hardware Requirements

Product Additional Hardware Requirements

ActiveTransfer
Server

ActiveTransfer Server needs additional hard drive space if you
use the hard drive as your virtual file system. The space required
depends on the total size of documents ActiveTransfer Server
needs to store, upload, and download. ActiveTransfer Server
might need additional hard drive space for log files.

AgileApps See the AgileApps wiki.

Software AG
Designer

Using the Software AG Installer lists free space the Software AG
Installer requires in its system temp (Windows) or temporary
(UNIX) directory. For Software AG Designer Eclipse platform,
the installer needs 700MB additional free hard drive space in that
directory.

Each product plug-ins you install in Software AG Designer can
require from 50K to 150MB of additional free hard drive space.

Trading
Networks

To use large document handling, Trading Networks Server
needs additional hard drive space on which to temporarily save
documents (instead of storing them in memory). For detailed
information, see webMethods Trading Networks User’s Guide.

Shut Down Products
Shut down all non-Software AG applications that are running on the machine on which
you are going to install. If these applications are not shut down, product files might
become corrupted.

If you are installing new products into an existing Software AG product installation
directory (that contains products from the same release), running products in that
directory must be shut down so the installer can update key files that are locked by
the operating system. If the products are running as applications, shut them down

http://www.agileappscloud.info/aa105
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manually. If the products are running as services or daemons, the installer will
automatically shut down many of them (and later restart them), but you must manually
shut down the products listed below (and later restart them).

Product Steps

CentraSite Shut down the Software AG Runtime service and the
CentraSite Registry Repository service.

Content Service
Platform

See the instructions in the product documentation.

Software AG
Designer

Click File > Exit.

Terracoa Server
Array

Run the bin/stop-tc-server.{bat|sh} command. If you are
running a mirror group, shut down the passive server and
then the active server.

Prepare Your Machine

Prepare to Install Collaboration or MashZone on a Linux System
Check the seing for shared memory (kernel parameter shmmax) by executing
the command sysctl -a | fgrep kernel.shmmax. If the value is less than
629145600, log on as root user and increase the value by executing sysctl -w
kernel.shmmax=629145600 or echo "kernel.shmmax=629145600" >> /etc/
sysctl.conf, then activate the new value by executing sysctl -p.

Check the seings for the system-wide maximum number of file descriptors (kernel
parameter fs.file-max) by executing the command sysctl -a | fgrep fs.file-
max. If the value is less than 200000, log on as the root user and increase the value by
executing sysctl -w fs.file-max=200000 or echo "fs.file-max=200000" >> /
etc/sysctl.conf, then activate the new value by executing sysctl -p.

Check the user, group, and process seings for the maximum number of open file
descriptors by executing the command ulimit -Hn and ulimit -Sn, where -
Hn is the hard limit and -Sn is the soft limit. If the value is less than 200000, log
on as a non-root user and increase the value by executing ulimit -n 200000. To
permanently save this seing for the user, execute:
echo "<user name> soft nofile 200000" >> /etc/security/limits.conf
echo "<user name> hard nofile 200000" >> /etc/security/limits.conf

Enter the host name of the machine on which you are installing products in the DNS
of the network or in the file /etc/hosts.



M
Odd Header

Installing and Uninstalling Application Integration, B2B Integration, or BPM

Installing Software AG Products Version 9.9 47

Prepare to Install Integration Agent or Integration Server on a Mac
OS X or Other UNIX System
The ability of Integration Agent or Integration Server to handle traffic is constrained by
the number of file descriptors available to the product’s process. On most systems, 64
file descriptors are available to each process by default. If you are going to install the
product on a Mac OS X or other UNIX system, Software AG recommends that you ask
your system administrator to increase the number of file descriptors available to the
product process to at least 1024.

Important: You might have to increase this number depending on the number of files
Integration Agent or Integration Server needs to have open at one time.
It is dangerous to set the rlim_fd_max value higher than 1024 because of
limitations with the select function, so if the product requires more file
descriptors, ask the system administrator to set the setrlimit value directly.

Prepare to Install My webMethods Server
If you are going to install the My webMethods Server on a UNIX system, make sure
you have set sufficient user limits for the shell you use to start the installation and the
product daemons. For example, if you have multiple language packs installed for My
webMethods Server, or if there are multiple products on the machine, the daemons for
My webMethods Server will run out of memory if they are started from the shell with a
low user limit for data. If your system policy allows it, Software AG recommends seing
the value for coredump, data, file, memory, and threads to at least 32768, and the value
of nofiles to 8192. For more information about seing and displaying the ulimits, read
the man page or ask your system administrator.

Database Connection Information
Some products require you to supply database connection information during
installation. Sample URL formats for supported database drivers are shown in the
product panels. Keep in the mind the following:

Most products use the DataDirect Connect JDBC 5.1 driver. For information about
options supported by this driver, see DataDirect Connect for JDBC User's Guide and
Reference 5.1, available on the Software AG Documentation website.

If you are using the installer GUI mode, for ease of use, the database connection
values you enter on one panel are reflected on the next as you go forward through
the installer the first time.

Use the DataDirect Connect connection option MaxPooledStatements=35 on all
database URLs except those for Trading Networks. This connection option improves
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performance by caching prepared statements. (Trading Networks caches its
prepared statements using its own pooling mechanism).

If the database user and password do not yet exist, specify the database user and
password you will create after installation. You can use one database user for
multiple database components, or you can use a different database user for each
database component.

For DB2, if the product will connect to a schema other than the default schema
for the specified database user, you must specify these connection options in the
database URL, where AlternateID is the name of the default schema that is used to
qualify unqualified database objects in dynamically prepared SQL statements:
;AlternateId=schema ;"InitializationString=(SET CURRENT 
PATH=current_path ,schema )";MaxPooledStatements=35

Install Products

Start the Installer, Provide General Information, and Choose the
Products to Install
As you go through the Software AG Installer, you will be asked for various types of
information, such as product license files and database connection parameters. Scan the
pages in this chapter that show the installer panels you will encounter, and gather the
information you will need before starting the installer.

Read the requirements in Using the Software AG Installer (for example, the requirement
to create a user account that has the proper privileges for Windows and that is non-root
for UNIX). Follow the instructions in that guide to start the installer and provide general
information such as proxy server, release to install, installation directory, and how to use
the product selection tree.

Important: Unless otherwise stated for a specific product, do not install products from
this release into a Software AG directory that contains products from any
other release. Unless otherwise stated for a specific product, you cannot mix
products from different releases in the same installation directory; if you do
so, you will experience problems or be unable to access functionality.

On the product selection tree, select the products to install.

If you select packages for Integration Server, the installer will copy the packages
into a package repository in the Integration Server installation. “Packages” include
the products listed under Integration Server in the tree as well as products that are
hosted by Integration Server but listed elsewhere, such as adapters, eStandards
Modules, and CloudStreams Server. The installer will also create a server instance
and will ask whether to install all packages in the package repository on the server
instance. On the language pack selection tree, the installer will copy all language
packs you select into the package repository and will always install them on the
server instance. After installation, you can create additional server instances and
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install packages and language packs from the package repository on those server
instances and the server instance created during installation. For instructions, see the
webMethods Integration Server Administrator’s Guide.

Note: You can only install the Application Platform Support and the
ActiveTransfer Support packages on the server instance created during
installation.

If you install Integration Agent, the installer creates a server instance named
“default” in the Software AG_directory/IntegrationServer/instances directory and
installs CloudStreams Server on that server instance. Do not install any other
product or package on Integration Agent.

If you install My webMethods Server, and later install Business Console, Task
Engine, or My webMethods user interfaces in a separate run of the installer, those
components are installed on all My webMethods Server instances in the target
installation directory.

After the product selection tree, the installer displays the language pack selection tree.
For information on language packs, see the international operating environments
appendix in this guide. The installer then displays panels (GUI mode) or prompts
(console mode) that ask for product configuration information. The sections below show
the panels, but the information and fields on the panels are identical to the information
and fields in the prompts.

Important: Make sure all ports you specify on panels or in response to prompts are
not already being used by other products on your machine. The installer
cannot detect whether ports are in use when products are shut down, and
the shuing down of products is a requirement for running the installer. See
the list of default ports used by Software AG products.

Supply Product Configuration Information

Sudo
When you install on a UNIX system, the panel below might appear.

https://empower.softwareag.com/sl24sec/SecuredServices/Products.nav5/Component_Downloads.lnk2/TCPIP/tcpip_used_ports.pdf
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You must either have the installer run the afterInstallAsRoot.sh script, or you must run
the script manually after installation as explained later in this chapter. If you want to
have the installer run the script, the user under which you are running the installer must
be in the sudoers configuration.

For security reasons, the installer does not store the sudo password in installation
scripts. If you are creating or installing from an installation script, therefore, the
option to use sudo is not available. You will have to run the afterInstallAsRoot.sh
script manually after installation as a user who is in the sudoers configuration. See the
instructions for registering daemons and seing file permissions later in this chapter.
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ActiveTransfer Server

Field Entry

Run as
Server or
Gateway

You can install ActiveTransfer Server to run as a server or as a
Gateway (reverse proxy).

License
file

If you chose to run ActiveTransfer Server as a server, specify the full
path to the license file that permits that functionality. If you chose to
run ActiveTransfer Server as a Gateway, specify the full path to the
license file that permits that functionality.
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Field Entry

Database
Connection

If you are running ActiveTransfer Server as a server, specify
the connection ActiveTransfer Server is to use to connect to
the ActiveTransfer database component. If you do not do so,
ActiveTransfer Server will not start after installation.

AgileApps

Field Entry

JTA library jar Full path to the JTA library you downloaded.
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Field Entry

MySQL driver
jar

Full path to the MySQL driver jar file you downloaded.

Database
Connection

AgileApps uses a database to store assets such as custom objects,
JSPs, Java code, business processes, and templates.

Content Service Platform Server

Content Service Platform uses a database to store document metadata, configuration
data, and document-specific security seings.
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Integration Agent
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Integration Server

Field Entry

Install as If you are installing Integration Server with the Application Platform
package and Software AG Designer with the Application Platform
plug-ins in the same installation directory for development purposes,
install Integration Server as an application. The Application Platform
plug-ins invoke scripts that start and stop Integration Server from
Software AG Designer.

In other use cases, you can choose to install as application or service.
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Field Entry

Instance
name

The installer creates the server instance in the Software AG_directory/
IntegrationServer/instances directory.

Do not change the instance name from “default” if you are using
Integration Server with the Local Version Control Integration plug-in
to Software AG Designer.

License
file

The license file you specify varies based on the product you are
installing. Specify the full path to the license file indicated below.

Installing a production Integration Server - full path to the
Integration Server production license file.

Installing Integration Server as an Enterprise Gateway - full path to
the Enterprise Gateway license file.

Installing CloudStreams Server when you have not licensed
Integration Server - full path to the CloudStreams license file.

The licenses for Enterprise Gateway and CloudStreams allow only
partial Integration Server functionality. Install each of these products
on its own host Integration Server. Do not install other products on
an Integration Server that hosts Enterprise Gateway or CloudStreams
Server, or those other products might not work properly.

Install all
packages...

The installer will copy the packages you selected on the product
selection tree into the package repository in the Integration Server
installation, and will create a server instance. If you want the installer
to install all the packages in the package repository on the server
instance, select the check box.

Database
Connection

Available when you select External RDBMS. You must decide where to
store data wrien by Integration Server. For complete information,
see "Data Storage" on page 157.
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MashZone

Select a system configuration for MashZone that can handle your expected usage needs.

System
Configuration

RAM CPUs

Small 4GB 2

Medium 16GB 4

Large 64GB 8
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My webMethods Server

Select the check box to create a My webMethods Server instance and complete the port
and database fields. If you select External RDMBS, you must decide where to store data
wrien by My webMethods Server. For complete information, see "Data Storage" on
page 157.
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Rules Engine
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Trading Networks Server

Create Database Components
Many products require you to create database components. For a list of such products
and instructions, see "Creating and Dropping Database Components" on page 155.
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Complete the Installation
For some products, you must perform certain tasks before startup. This section explains
those tasks.

For instructions on starting products and performing post-startup configuration and
customization, see the product documentation.

Change Default Passwords
Products are installed with default passwords. For security reasons, you should change
these passwords as soon as possible. For instructions, see the product documentation.

Install Latest Fixes
Install the latest fixes on the products you installed. For instructions on using the
Software AG Update Manager, see Using the Software AG Update Manager. Each fix
includes a readme file that contains instructions on installing the fix.

Register Daemons and Set File Permissions
If you were asked whether to use sudo during installation on a UNIX system
and you chose not to, the installer was not able to register daemons and set file
permissions. Perform these tasks now by running the script Software AG_directory /bin/
afterInstallAsRoot.sh as a user who is in the sudoers configuration.

Important: You must run this script or your products might not work correctly.

The installer and this script register daemons for certain products only; for other
products, you perform the daemon registration yourself. For complete details and
instructions, see "Register Daemons to Automatically Start and Shut Down Products on
UNIX Systems" on page 193.

Complete the Content Service Platform Installation
1. Create the database user and password you want to use to create the Content Service

Platform database tables. The database user must have privileges to create tables and
indices. For Oracle, grant the database user CONNECT and RESOURCE privileges
only.

2. Set up the Content Service Platform Server. Open a command window, go to the
Software AG_directory/CSP/server directory, and run this command:
cspconfigurator.{bat|sh} -Dsetup.env.db.user=database_user
-Dsetup.env.db.password=password
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Note: Do not run this command more than once.

3. If you installed the Content Service Platform Windows Client, go to the
Software AG_directory\CSP\winclient directory and locate the Software AG
webMethods CSP Client Setup 9.0.exe file. If the file is on a Windows system,
double-click the .exe file. If the file is on a non-Windows system, copy the file to a
Windows system and then double-click the .exe. The client installer wizard opens;
follow the instructions to install the client.

Note: The .exe file name might contain additional numbers.

4. On a Windows system, you were given the choice to install Content Service Platform
as an application or a service. If you installed Content Service Platform as an
application, the Windows Start menu includes entries for starting and stopping
Content Service Platform. If you installed Content Service Platform as a service, you
must open a command window, go to the Software AG_directory/CSP/server directory
and run the command csp install to complete the installation of the service and
create Windows Start menu entries.

Complete the Integration Agent or Integration Server Installation on a
Mac OS X or Other UNIX System
If non-root users will be running Integration Agent or Integration Server, you might
want to change the ownership of the installed files to allow a single non-root user to
run the product (chown), change the file group to the group of users who will run
the product (chgrp), or change file permissions to allow all users to run the product
(chmod).

Complete the MashZone Installation
The MashZone Cloud Agent is installed automatically on Windows systems. On Linux
systems, you must install it manually, as a daemon. Go to the Software AG_directory/
ppmmashzone/server/bin directory and run the call ./CloudAgentApp.sh install
with sudo or root privileges.

Complete the My webMethods Server Installation

Set Up Automatic Startup on a UNIX System
If you installed My webMethods Server on a UNIX system and want My webMethods
Server to start automatically each time you start your system, execute the My
webMethods Server service registration script, as follows:
Software AG_directory
/MWS/bin su ./mws.sh -s server_instance
installservice mws.user=My
webMethods Server_user_account  [platform={suse|redhat}]
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For more information on My webMethods Server startup, including optional
parameters, see the section on running My webMethods Server from the command line
in Administering My webMethods Server.

Connect Products to Each Other
If you installed all products at the same time, and did not change any port seings or
default passwords after installation, many inter-product connections are configured
automatically. For instructions on connecting products to each other, see the product
documentation.

Uninstall Products
Follow the instructions in Using the Software AG Installer, with the additional guidelines
below.

If you are going to uninstall Software AG Designer Eclipse, and you want to review or
preserve Eclipse installation information, do so before starting the uninstaller, because
the uninstaller will delete the entire Software AG Designer installation directory. User-
created data that is stored in other directories, such as your workspace, will remain
untouched.

If you are going to uninstall Integration Server, retract all assets you have published to
CentraSite. For instructions, see the webMethods BPM and CAF CentraSite Metadata Help.

If you are going to uninstall MashZone, the Cloud Agent will be uninstalled
automatically from Windows systems. From Linux systems, you must uninstall
the Cloud Agent daemon manually. After shuting down all products, go to the
Software AG_directory/ppmmashzone/server/bin directory and run these scripts with
sudo or root privileges:
ARISCloudAgentApp.sh remove
ARISCloudAgentApp.sh start

If you are going to uninstall from a Mac OS or other UNIX system, and you used sudo to
register daemons and set file permissions during or after installation, you must also use
sudo to unregister daemons and remove file permissions, as follows:

If you are not going to use an uninstallation script to uninstall, you can choose
the uninstaller option to perform this task, or you can perform this task before
starting the uninstaller by executing the script Software AG_directory/bin/
beforeUninstallAsRoot.sh as a user who is in the sudoers configuration.

If you are going to use an uninstallation script, the uninstaller cannot execute the
script because it does not store the sudo password, for security reasons. You must
execute the script yourself before starting the uninstaller.

Important: You must either have the uninstaller execute the script or run it yourself, or
some products might not work correctly.
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If you are uninstalling Integration Server, you have two choices:

You can choose to uninstall only certain packages from the package repository and
from all instances. In this case, select those packages on the product selection tree.

You can choose to uninstall all packages from the package repository and uninstall
all instances. In this case, select Integration Server > Server on the product selection
tree.
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Overview
The information provided in this chapter for Terracoa Server Array and Universal
Messaging applies to when you are using those products with webMethods products.
For information on Terracoa Server Array and Universal Messaging in other contexts,
see the Terracoa BigMemory Max and Universal Messaging product documentation,
respectively.

Typical Installation
The Software AG Installer offers typical development installations of products that
enable you to perform a certain task. When you select a typical development installation,
the installer automatically selects all products that make up that installation. The typical
installation for these products is called Intelligent Business Operations.

For this typical installation, you must create certain database components. A database
component is a grouping of database objects that is used by one or more products. You
must create all of the database components for Integration Server, My webMethods
Server, and Optimize. For complete information about each database component, see
"Creating and Dropping Database Components" on page 155.

To create production environments, work with your administrators, Software AGGlobal
Consulting Services, and best practices documentation.

Software and Hardware Support and Requirements

Operating System and Browser Support
For information on operating systems, RDBMSs, and browsers that are supported by
your products, see System Requirements for Software AG Products.

For information on supported database drivers, see "Database Components" on page
156.

Software Requirements and Considerations

Product Software Requirements and Considerations

All If the vendor for your operating system recommends installing
the latest service packs, patch-bundles, and fixes, Software AG
encourages you to follow that recommendation. If you experience
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Product Software Requirements and Considerations
problems with installed service packs, patch-bundles, or fixes,
report those problems directly to the vendor.

Process
Performance
Manager

You cannot install Process Performance Manager on integrated
network drives or on substituted drives.

Universal
Messaging

If you anticipate large-scale numbers of client connections or
throughput, Software AG recommends using a 64-bit JVM for
Universal Messaging realm servers, to enable larger heap sizes.

On HP-UX systems, shared memory drivers are currently not
supported due to an implementation problem with the HP JVM.

Hardware Requirements

Minimum and Recommended Hardware Requirements
The table below lists the minimum and recommended hardware requirements for your
products. Recommended amounts are shown in parentheses.

Important: The hardware requirements below are for the listed products only. They do
not include 2GB of hard drive space for Software AG infrastructure shared
libraries required by most products and installed once per installation
directory. They do not include requirements for supporting software such
as RDBMSs. They do not include the additional requirements listed in
"Additional Hardware Requirements" on page 68. You must determine
the overall hardware requirements for each of your machines based on the
overall requirements of your operating system and software.

Product Hard Drive
Space

RAM CPUs

Optimize    

 Analytic Engine 1GB 4GB (8GB) 2
(4)

 Infrastructure Data Collector 300MB 2GB* 1

 Web Service Data Collector 100MB 256MB 1
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Product Hard Drive
Space

RAM CPUs

Presto 650MB 8GB 1

Process Performance Manager 10GB 7GB (16GB) 2
(4)

Process Performance Manager
Analysis GUI

5GB 4GB 1

Terracoa Server Array used with
webMethods products

200MB
(500MB)

3GB 1

Universal Messaging realm server
used with webMethods products

500MB 1GB 1

Additional Hardware Requirements

Product Additional Hardware Requirements

Optimize
Analytic
Engine

The Analytic Engine needs 1GB virtual swap space and a disk
subsystem with 10GB available free space. In a production
environment, the disk subsystem must have a redundant array of
independent disks (RAID 5), an UltraWide SCSI, and 10K to 15K
RPM drives.

Also in a production environment, the Analytic Engine needs
additional hard drive space for log files. The recommended
amount is 100MB; the engine needs 50MB of space for each log
file.

Optimize
Web Service
Data
Collector

Each Web Service Data Collector needs 128MB of virtual swap
space. In a production environment, each Web Service Data
Collector needs additional hard drive space for log files. The
recommended amount is 75MB; each Web Service Data Collector
needs 5MB of hard drive space for each log file. More hard drive
space might be needed if you use debug level or higher logging.

Process
Performance
Manager

You might need additional RAM and hard drive space,
depending on the number of process instances you import
and store in Process Performance Manager. The more process
instances, the more RAM and hard drive space you will need.
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Product Additional Hardware Requirements

Universal
Messaging

If you use persistent topics or queues, or persistent messages,
Universal Messaging needs additional hard drive space to persist
the published data. The amount of space required would be
loosely based on this equation: messages per second x message
size x message time to live. If you store messages in memory
only, Universal Messaging needs additional heap within the JVM
to hold references to these messages. The heap size required is
based on the same equation.

Universal Messaging realm servers support high-performance
spin locks. If you enable spin locking for a realm server, and
then add the realm server to a cluster, the realm server needs
two additional CPUs to handle high-performance cluster event
processing.

If you enable a Universal Messaging realm server to use shared
memory, the realm server needs two additional CPUs for each
client that connects to it with shared memory.

Shut Down Products
Shut down all non-Software AG applications that are running on the machine on which
you are going to install. If these applications are not shut down, product files might
become corrupted.

If you are installing new products into an existing Software AG product installation
directory (that contains products from the same release), running products in that
directory must be shut down so the installer can update key files that are locked by
the operating system. If the products are running as applications, shut them down
manually. If the products are running as services or daemons, the installer will
automatically shut down many of them (and later restart them), but you must manually
shut down the products listed below (and later restart them).

Product Steps

CentraSite Shut down the Software AG Runtime service and the
CentraSite Registry Repository service.

Content Service
Platform

See the instructions in the product documentation.

Software AG
Designer

Click File > Exit.
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Product Steps

Terracoa Server
Array

Run the bin/stop-tc-server.{bat|sh} command. If you are
running a mirror group, shut down the passive server and
then the active server.

Prepare Your Machine

Prepare to Install Process Performance Manager

Prepare to Install Process Performance Manager on a Windows System
Windows systems offer only 5000 ports for TCP/RMI connections. This number might
not be sufficient for error-free communication if the system is too busy (for example,
distributed systems, use of Performance Dashboard). To change the parameter, add
an entry like the one below to the Windows registry. This example entry increases the
number of available ports to 8192.
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters, 
"MaxUserPort"=dword:00002000

Prepare to Install Process Performance Manager on a Linux System
Check the seing for shared memory (kernel parameter shmmax) by executing
the command sysctl -a | fgrep kernel.shmmax. If the value is less than
629145600, log on as the root user and increase the value by executing sysctl -
w kernel.shmmax=629145600 or echo "kernel.shmmax=629145600" >> /etc/
sysctl.conf, then activate the new value by executing sysctl -p.

Check the seings for the system-wide maximum number of file descriptors (kernel
parameter fs.file-max) by executing the command sysctl -a | fgrep fs.file-
max. If the value is less than 200000, log on as the root user and increase the value by
executing sysctl -w fs.file-max=200000 or echo "fs.file-max=200000" >> /
etc/sysctl.conf, then activate the new value by executing sysctl -p.

Check the user, group, and process seings for the maximum number of open file
descriptors by executing the command ulimit -Hn and ulimit -Sn, where -
Hn is the hard limit and -Sn is the soft limit. If the value is less than 200000, log
on as a non-root user and increase the value by executing ulimit -n 200000. To
permanently save this seing for the user, execute:
echo "<user name> soft nofile 200000" >> /etc/security/limits.conf
echo "<user name> hard nofile 200000" >> /etc/security/limits.conf

Enter the host name of the machine on which you are installing products in the DNS
of the network or in the file /etc/hosts.
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Prepare to Install Optimize
If you are going to install the Optimize Analytic Engine on a UNIX system, make sure
you have set sufficient user limits for the shell you use to start the installation and the
product daemons. For example, the daemons for the Optimize infrastructure will run
out of memory if they are started from the shell with a low user limit for data. If your
system policy allows it, Software AG recommends seing the value for coredump, data,
file, memory, and threads to at least 32768, and the value of nofiles to 8192. For more
information about seing and displaying the ulimits, read the man page or ask your
system administrator.

Database Connection Information
Some products require you to supply database connection information during
installation. Sample URL formats for supported database drivers are shown in the
product panels. Keep in the mind the following:

Most products use the DataDirect Connect JDBC 5.1 driver. For information about
options supported by this driver, see DataDirect Connect for JDBC User's Guide and
Reference 5.1, available on the Software AG Documentation website.

If you are using the installer GUI mode, for ease of use, the database connection
values you enter on one panel are reflected on the next as you go forward through
the installer the first time.

Use the DataDirect Connect connection option MaxPooledStatements=35 on all
database URLs.

If the database user and password do not yet exist, specify the database user and
password you will create after installation. You can use one database user for
multiple database components, or you can use a different database user for each
database component.

For DB2, if the product will connect to a schema other than the default schema
for the specified database user, you must specify these connection options in the
database URL, where AlternateID is the name of the default schema that is used to
qualify unqualified database objects in dynamically prepared SQL statements:
;AlternateId=schema ;"InitializationString=(SET CURRENT 
PATH=current_path ,schema )";MaxPooledStatements=35
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Install Products

Start the Installer, Provide General Information, and Choose the
Products to Install
As you go through the Software AG Installer, you will be asked for various types of
information, such as product license files and database connection parameters. Scan the
pages in this chapter that show the installer panels you will encounter, and gather the
information you will need before starting the installer.

Read the requirements in Using the Software AG Installer (for example, the requirement
to create a user account that has the proper privileges for Windows and that is non-root
for UNIX). Follow the instructions in that guide to start the installer and provide general
information such as proxy server, release to install, installation directory, and how to use
the product selection tree.

If you are installing Process Performance Manager on Windows 2012 Server, 2008
Server, 8/8.1, or 7, you must install using the Windows Administrator user account. To
do so, instead of double-clicking the installer .exe file to start the installer, right-click
the .exe file and click Run as administrator. Other user accounts do not work, even if they
were assigned administrator privileges.

Important: Unless otherwise stated for a specific product, do not install products from
this release into a Software AG directory that contains products from any
other release. Unless otherwise stated for a specific product, you cannot mix
products from different releases in the same installation directory; if you do
so, you will experience problems or be unable to access functionality.

On the product selection tree, choose the products to install.

After the product selection tree, the installer displays the language pack selection tree.
For information on language packs, see the international operating environments
appendix in this guide. The installer then displays panels (GUI mode) or prompts
(console mode) that ask for product configuration information. The sections below show
the panels, but the information and fields on the panels are identical to the information
and fields in the prompts.

Important: Make sure all ports you specify on panels or in response to prompts are
not already being used by other products on your machine. The installer
cannot detect whether ports are in use when products are shut down, and
the shuing down of products is a requirement for running the installer. See
the list of default ports used by Software AG products.

https://empower.softwareag.com/sl24sec/SecuredServices/Products.nav5/Component_Downloads.lnk2/TCPIP/tcpip_used_ports.pdf
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Supply Product Configuration Information

Sudo
When you install on a UNIX system, the panel below might appear.

You must either have the installer run the afterInstallAsRoot.sh script, or you must run
the script manually after installation as explained later in this chapter. If you want to
have the installer run the script, the user under which you are running the installer must
be in the sudoers configuration.

For security reasons, the installer does not store the sudo password in installation
scripts. If you are creating or installing from an installation script, therefore, the
option to use sudo is not available. You will have to run the afterInstallAsRoot.sh
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script manually after installation as a user who is in the sudoers configuration. See the
instructions for registering daemons and seing file permissions later in this chapter.

Optimize

If you have multiple network interfaces, identify the one to use; the default is the default
network interface for local machine. Do not use localhost.
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Optimize Infrastructure Data Collector
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Presto

Presto comes with an embedded Universal Messaging.
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Process Performance Manager

Select a system configuration for Process Performance Manager that can handle your
expected usage needs. In each use case below, the values are valid only for the specified
number of PPM clients. The database is not included in the estimate.

System
Configuration

PPM Clients Users System Hardware

Small 1 Up to 5 20 GB free hard drive space, 4
GB RAM, 2 CPUs
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System
Configuration

PPM Clients Users System Hardware

Medium 1 Up to 10 Depends on PPM
customization

Large Several Up to 100 Depends on PPM
customization

Process Performance Manager Analysis GUI
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Terracotta
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Universal Messaging

The panel shown above displays when you choose to install a Universal Messaging
realm server (alone or with Enterprise Manager, Template Applications, or both). Select
the check box to create a realm server instance and complete all fields on the panel.

Field Entry

License file If you do not have a Universal Messaging license file, you can use
Universal Messaging on a trial basis for up to 90 days.
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Field Entry

Note: If you obtain a Universal Messaging license file after
installation, you can add it at that time. For instructions, see
the product documentation.

NHP interface
binding

If your machine has multiple IP addresses and you want
Universal Messaging to listen to a specific one, select that IP
address from the list.

NHP interface
port

The installer sets up a bootstrap Universal Messaging interface
to which all sample Universal Messaging applications and
tools connect by default. Specify the port to which to bind the
bootstrap interface.

Realm server
name

Name for the realm server instance. If you are also installing an
Enterprise Manager instance, Template Applications instance, or
both, those instances will also use this name.

Note: Different types of instances can have the same name.
However, the name you supply here must be unique among
instances of the same type (that is, among instances of realm
servers).

Data directory Full path to the directory in which to store the data for the realm
server instance.

Note: If you use a non-default location for the data directory, you
will have to manually migrate the data directory when you
upgrade Universal Messaging.

If you install multiple realm server instances on the same
machine, use a different data directory for each instance.
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The panel shown above displays when you choose to install Universal Messaging
Enterprise Manager, Template Applications, or both, without also choosing to install
a Universal Messaging realm server. Select the check box to create an instance of each
selected component and complete all fields on the panel. You can specify a realm server
that is already installed or that will be installed later.

Field Entry

Realm name/
client profile

Name for the Enterprise Manager instance, Template
Applications instance, or both. You might want to use the name
of the realm server instance to which the tools will connect. The
list shows the names of any realm server instances that already
exist in the installation directory, but you can also type a name.
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Field Entry

Note: Different types of instances can have the same name.
However, the name you supply here must be unique
among instances of the same type (that is, among instances
of Enterprise Managers, and among instances of Template
Applications).

Realm server
URL (RNAME)

URL for the realm server instance to which the Enterprise
Manager instance, Template Applications instance, or both
should connect.

Create Database Components
Many products require you to create database components. For a list of such products
and instructions, see "Creating and Dropping Database Components" on page 155.

Complete the Installation
For some products, you must perform certain tasks before startup. This section explains
those tasks.

For instructions on starting products and performing post-startup configuration and
customization, see the product documentation.

Change Default Passwords
Products are installed with default passwords. For security reasons, you should change
these passwords as soon as possible. For instructions, see the product documentation.

Install Latest Fixes
Install the latest fixes on the products you installed. For instructions on using the
Software AG Update Manager, see Using the Software AG Update Manager. Each fix
includes a readme file that contains instructions on installing the fix.

Register Daemons and Set File Permissions
If you were asked whether to use sudo during installation on a UNIX system
and you chose not to, the installer was not able to register daemons and set file
permissions. Perform these tasks now by running the script Software AG_directory /bin/
afterInstallAsRoot.sh as a user who is in the sudoers configuration.
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Important: You must run this script or your products might not work correctly.

The installer and this script register daemons for certain products only; for other
products, you perform the daemon registration yourself. For complete details and
instructions, see "Register Daemons to Automatically Start and Shut Down Products on
UNIX Systems" on page 193.

Complete the Process Performance Manager Installation
The Process Performance Manager Cloud Agent is installed automatically on
Windows systems. On Linux systems, you must install it manually, as a daemon. Go
to the Software AG_directory/ppmmashzone/server/bin directory and run the call ./
CloudAgentApp.sh install with sudo or root privileges.

Complete the Terracotta Installation
For instructions on configuring Terracoa when you are using it with webMethods
products, see Geing Started with the webMethods Product Suite and Terracoa.
For instructions on configuring Terracoa in other contexts, see the Terracoa
BigMemory Max product documentation.

Complete the Universal Messaging Installation

Enable High-Performance Spin Locks
Universal Messaging realm servers support high-performance spin locks. If you installed
a realm server on a machine that is equipped with more than four CPUs, you can
configure the realm server to consume the available CPUs by enabling spin locking. To
do so, go to the Software AG_directory/UniversalMessaging/server/realm_server_name /bin
directory, open the nserver.conf file, and add the line wrapper.java.additional.19=-
DCORE_SPIN=true

Add License
You can use Universal Messaging on a trial basis for up to 90 days; if you are doing this,
you installed Universal Messaging without a license. If you later obtain a license, rename
the license file licence.xml and copy it over the existing license file of the same name in
the Software AG_directory/UniversalMessaging/server/realm_server_name  directory.

Connect Products to Each Other
If you installed all products at the same time, and did not change any port seings or
default passwords after installation, many inter-product connections are configured
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automatically. For instructions on connecting products to each other, see the product
documentation.

Uninstall Products
Follow the instructions in Using the Software AG Installer, with the additional guidelines
below.

If you are going to uninstall Software AG Designer Eclipse, and you want to review or
preserve Eclipse installation information, do so before starting the uninstaller, because
the uninstaller will delete the entire Software AG Designer installation directory. User-
created data that is stored in other directories, such as your workspace, will remain
untouched.

If you are going to uninstall Process Performance Manager, the Cloud Agent will be
uninstalled automatically from Windows systems. From Linux systems, you must
uninstall the Cloud Agent daemon manually. Before starting the uninstaller, go to the
Software AG_directory/ppmmashzone/server/bin directory and run these scripts with
sudo or root privileges:
ARISCloudAgentApp.sh remove
ARISCloudAgentApp.sh start

If you are going to uninstall from a Mac OS or other UNIX system, and you used sudo to
register daemons and set file permissions during or after installation, you must also use
sudo to unregister daemons and remove file permissions, as follows:

If you are not going to use an uninstallation script to uninstall, you can choose
the uninstaller option to perform this task, or you can perform this task before
starting the uninstaller by executing the script Software AG_directory/bin/
beforeUninstallAsRoot.sh as a user who is in the sudoers configuration.

If you are going to use an uninstallation script, the uninstaller cannot execute the
script because it does not store the sudo password, for security reasons. You must
execute the script yourself before starting the uninstaller.

Important: You must either have the uninstaller execute the script or run it yourself, or
some products might not work correctly.
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Software and Hardware Support and Requirements

Operating System and Browser Support
For information on operating systems, RDBMSs, and browsers that are supported by
your products, see System Requirements for Software AG Products.

For information on supported database drivers, see "Database Components" on page
156.

Software Requirements and Considerations

Product Software Requirements and Considerations

All If the vendor for your operating system recommends installing
the latest service packs, patch-bundles, and fixes, Software AG
encourages you to follow that recommendation. If you
experience problems with installed service packs, patch-bundles,
or fixes, report those problems directly to the vendor.

Locate On Windows systems, install Microsoft Visual C++ Runtime 2005
or higher in any directory on the machine that will host Locate.

Hardware Requirements
The table below lists the minimum and recommended hardware requirements for your
products. Recommended amounts are shown in parentheses.

Important: The hardware requirements below are for the listed products only. They do
not include 2GB of hard drive space for Software AG infrastructure shared
libraries required by most products and installed once per installation
directory. They do not include requirements for supporting software such as
RDBMSs. You must determine the overall hardware requirements for each of
your machines based on the overall requirements of your operating system
and software.

Product Hard Drive
Space

RAM CPUs

Locate 20GB (40GB) 512MB (4GB) 1 (3)



M
Odd Header

Installing and Uninstalling Master Data Management

Installing Software AG Products Version 9.9 89

Product Hard Drive
Space

RAM CPUs

OneData    

 Server 512MB 2GB (4GB) 1 (2)

 MDR Modules 50MB   

 Customer MDM Template 20MB   

The hard disk space for Locate must be in a RAID configuration. The range of hardware
requirements in the table is intended to accommodate your needs up to the largest
dataset you could install (see "Complete the Locate Installation" on page 95).

OneData needs additional hard drive space for temp, import, and export files in the
Software AG_directory\OneData\config directory.

Shut Down Products
Shut down all non-Software AG applications that are running on the machine on which
you are going to install. If these applications are not shut down, product files might
become corrupted.

If you are installing new products into an existing Software AG product installation
directory (that contains products from the same release), running products in that
directory must be shut down so the installer can update key files that are locked by
the operating system. If the products are running as applications, shut them down
manually. If the products are running as services or daemons, the installer will
automatically shut down many of them (and later restart them), but you must manually
shut down the products listed below (and later restart them).

Product Steps

CentraSite Shut down the Software AG Runtime service and the
CentraSite Registry Repository service.

Content Service
Platform

See the instructions in the product documentation.

Software AG
Designer

Click File > Exit.
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Product Steps

Terracoa Server
Array

Run the bin/stop-tc-server.{bat|sh} command. If you are
running a mirror group, shut down the passive server and
then the active server.

Database Connection Information
Some products require you to supply database connection information during
installation. Sample URL formats for supported database drivers are shown in the
product panels. Keep in the mind the following:

Most products use the DataDirect Connect JDBC 5.1 driver. For information about
options supported by this driver, see DataDirect Connect for JDBC User's Guide and
Reference 5.1, available on the Software AG Documentation website.

If you are using the installer GUI mode, for ease of use, the database connection
values you enter on one panel are reflected on the next as you go forward through
the installer the first time.

Use the DataDirect Connect connection option MaxPooledStatements=35 on all
database URLs. This connection option improves performance by caching prepared
statements.

If the database user and password do not yet exist, specify the database user and
password you will create after installation. You can use one database user for
multiple database components, or you can use a different database user for each
database component.

For DB2, if the product will connect to a schema other than the default schema
for the specified database user, you must specify these connection options in the
database URL, where AlternateID is the name of the default schema that is used to
qualify unqualified database objects in dynamically prepared SQL statements:
;AlternateId=schema ;"InitializationString=(SET CURRENT 
PATH=current_path ,schema )";MaxPooledStatements=35

Install Products

Start the Installer, Provide General Information, and Choose the
Products to Install
As you go through the Software AG Installer, you will be asked for various types of
information, such as product license files and database connection parameters. Scan the
pages in this chapter that show the installer panels you will encounter, and gather the
information you will need before starting the installer.
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Read the requirements in Using the Software AG Installer (for example, the requirement
to create a user account that has the proper privileges for Windows and that is non-root
for UNIX). Follow the instructions in that guide to start the installer and provide general
information such as proxy server, release to install, installation directory, and how to use
the product selection tree.

Important: Unless otherwise stated for a specific product, do not install products from
this release into a Software AG directory that contains products from any
other release. Unless otherwise stated for a specific product, you cannot mix
products from different releases in the same installation directory; if you do
so, you will experience problems or be unable to access functionality.

On the product selection tree, select the products to install.

After the product selection tree, the installer displays the language pack selection tree.
For information on language packs, see the international operating environments
appendix in this guide. The installer then displays panels (GUI mode) or prompts
(console mode) that ask for product configuration information. The sections below show
the panels, but the information and fields on the panels are identical to the information
and fields in the prompts.

Important: Make sure all ports you specify on panels or in response to prompts are
not already being used by other products on your machine. The installer
cannot detect whether ports are in use when products are shut down, and
the shuing down of products is a requirement for running the installer. See
the list of default ports used by Software AG products.

https://empower.softwareag.com/sl24sec/SecuredServices/Products.nav5/Component_Downloads.lnk2/TCPIP/tcpip_used_ports.pdf
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Supply Product Configuration Information

OneData
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Field Entry

Repository
ID

OneData provides a repository in which to store your master data.
Provide an ID for the repository (for example, DevRepo). The ID will
be used internally in OneData.

Repository
name

Provide a name for the repository (for example, OneData
Development Repository). The name will appear in the OneData user
interface.

Connection
Prefix

If you enter a value other than the default (that is, onedata), you will
have to edit the database connections for the Work Area and Release
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Field Entry
Area after you start OneData. For instructions, see the OneData
documentation.

Database
Connection

The URL you specify must include the option catalogOptions=1
so that OneData can retrieve database metadata information
for various operations (for example, jdbc:wm:oracle://
localhost:1521;serviceName=XE;catalogOptions=1).

The prefix you specify will be added to each of the three schema
connection names (that is, prefix _md, prefix _wa, and prefix _ra).
Provide a different database user and password for each of the three
schemas.

You must specify schema names if you use a SQL Server RDBMS.

Create Database Components
OneData requires you to create database components. For a list of such products and
instructions, see "Creating and Dropping Database Components" on page 155.

Complete the Installation
For some products, you must perform certain tasks before startup. This section explains
those tasks.

For instructions on starting products and performing post-startup configuration and
customization, see the product documentation.

Change Default Passwords
Products are installed with default passwords. For security reasons, you should change
these passwords as soon as possible. For instructions, see the product documentation.

Install Latest Fixes
Install the latest fixes on the products you installed. For instructions on using the
Software AG Update Manager, see Using the Software AG Update Manager. Each fix
includes a readme file that contains instructions on installing the fix.



M
Odd Header

Installing and Uninstalling Master Data Management

Installing Software AG Products Version 9.9 95

Complete the Locate Installation
You must now download datasets that contain address reference data for a specific
country or region to use with Locate. Go to the Empower Product Support website.
Under Download Products, click Software Downloads, and then click Software
Download Center (SDC). In the Releases menu, click Software AG Product Suite 9.8.
In the Products menu, click Locate Datasets - country  Geocode/Verify_date . Download
all dataset files listed under Product Items to the Software AG_directory \Locate\data
directory. The file name for each dataset indicates its size after decompressing.

If you have access to both Geocode and Verify dataset links for a licensed country, use
these criteria to download datasets:

Geocoding is a process for translating a location map based on geographic data such
as street addresses or postal codes to specific coordinates on the earth’s surface.
Geocode datasets are needed only when geocoding information; that is, when
latitudinal and longitudinal coordinates have to be added to addresses. Country-
specific geocode links also contain Verify datasets, so you need not explicitly
download the verify links.

If you only require address verification and not geocoding, ignore the geocode
datasets and download datasets using the country-specific Verify links.

Connect Products to Each Other
If you installed all products at the same time, and did not change any port seings or
default passwords after installation, many inter-product connections are configured
automatically. For instructions on connecting products to each other, see the product
documentation.

Uninstall Products
Follow the instructions in Using the Software AG Installer.
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Typical Installation
The Software AG Installer offers typical development installations of products that
enable you to perform a certain task. When you select a typical development installation,
the installer automatically selects all products that make up that installation. For
CentraSite, the typical development installation is called SOA Governance.

If you intend to publish Mediator events (that is, runtime performance data and policy
events) to a relational database or the Integration Server audit log, you must create
certain database components. A database component is a grouping of database objects
that is used by one or more products. You must create the MediatorEvents database
component, and all of the database components for the Integration Server that hosts
Mediator. For complete information about each database component, see "Creating and
Dropping Database Components" on page 155.

To create production environments, work with your administrators, Software AGGlobal
Consulting Services, and best practices documentation.

Software and Hardware Support and Requirements

Operating System and Browser Support
For information on operating system and browser support for your products, see System
Requirements for Software AG Products.

For information on supported database drivers, see "Database Components" on page
156.

Software Requirements and Considerations

Product Software Requirements and Considerations

All If the vendor for your operating system recommends installing
the latest service packs, patch-bundles, and fixes, Software AG
encourages you to follow that recommendation. If you experience
problems with installed service packs, patch-bundles, or fixes, report
those problems directly to the vendor.

CentraSite If you are going to install on a Linux system, the library libcrypt.so
must be present to support the security infrastructure, or the login
using OS user names/authentication will not work. If you do not
see the libcrypt.so file in the /usr/lib64 directory for Linux x86_64,
or /usr/lib for Linux x86, install the rpm package glibc-devel.
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Product Software Requirements and Considerations

If you are going to install on a Linux x86_64 system, install the rpm
package compat-libstdc++ from your operating system distribution
using the vendor instructions.

Hardware Requirements
The table below lists the minimum and recommended hardware requirements for your
products. Recommended amounts are shown in parentheses.

Mediator has minimal or no hardware requirements beyond its host Integration Server.

Important: The hardware requirements below are for the listed products only. They do
not include 2GB of hard drive space for Software AG infrastructure shared
libraries required by most products and installed once per installation
directory. They do not include requirements for supporting software such as
RDBMSs. You must determine the overall hardware requirements for each of
your machines based on the overall requirements of your operating system
and software.

Product Hard Drive
Space

RAM CPUs

API-Portal 20GB 8GB 4

CentraSite    

 Registry Repository* 2.25GB (3GB) 64-bit 4GB
(8GB)

1 (2)

 Application Server Tier* 2.25GB (3GB) 4GB (8GB) 1 (2)

Software AG Designer Eclipse
platform

380MB 1.5GB (2GB) 1 (2)

Integration Server 300MB
(500MB)

1GB (2GB) 1 (2)

*Includes 2GB hard drive space, 1GB RAM, and 1 CPU for required and
automatically installed infrastructure components.

Using the Software AG Installer lists free space the Software AG Installer requires in its
system temp (Windows) or temporary (UNIX) directory. For Software AG Designer
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Eclipse platform, the installer needs 700MB additional free hard drive space in that
directory. Each product plug-ins you install in Software AG Designer can require from
50K to 150MB of additional free hard drive space.

Shut Down Products
Shut down all non-Software AG applications that are running on the machine on which
you are going to install. If these applications are not shut down, product files might
become corrupted.

If you are installing new products into an existing Software AG product installation
directory (that contains products from the same release), running products in that
directory must be shut down so the installer can update key files that are locked by
the operating system. If the products are running as applications, shut them down
manually. If the products are running as services or daemons, the installer will
automatically shut down many of them (and later restart them), but you must manually
shut down the products listed below (and later restart them).

Product Steps

CentraSite Shut down the Software AG Runtime service and the
CentraSite Registry Repository service.

Content Service
Platform

See the instructions in the product documentation.

Software AG
Designer

Click File > Exit.

Terracoa Server
Array

Run the bin/stop-tc-server.{bat|sh} command. If you are
running a mirror group, shut down the passive server and
then the active server.

Prepare Your Machine

Prepare to Install API-Portal on a UNIX System
Check the seing for shared memory (kernel parameter shmmax) by executing
the command sysctl -a | fgrep kernel.shmmax. If the value is less than
629145600, log on as root user and increase the value by executing sysctl -w
kernel.shmmax=629145600 or echo "kernel.shmmax=629145600" >> /etc/
sysctl.conf, then activate the new value by executing sysctl -p.
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Check the seings for the system-wide maximum number of file descriptors (kernel
parameter fs.file-max) by executing the command sysctl -a | fgrep fs.file-
max. If the value is less than 200000, log on as the root user and increase the value by
executing sysctl -w fs.file-max=200000 or echo "fs.file-max=200000" >> /
etc/sysctl.conf, then activate the new value by executing sysctl -p.

Check the user, group, and process seings for the maximum number of open file
descriptors by executing the command ulimit -Hn and ulimit -Sn, where -
Hn is the hard limit and -Sn is the soft limit. If the value is less than 200000, log
on as a non-root user and increase the value by executing ulimit -n 200000. To
permanently save this seing for the user, execute:
echo "<user name> soft nofile 200000" >> /etc/security/limits.conf
echo "<user name> hard nofile 200000" >> /etc/security/limits.conf

Enter the host name of the machine on which you are installing products in the DNS
of the network or in the file /etc/hosts.

Prepare to Install CentraSite on a UNIX System
Make sure you have set sufficient user limits for the shell you use to start the
installation and the product daemons. For example, the daemons for the CentraSite
database and infrastructure will run out of memory if they are started from the
shell with a low user limit for data. If your system policy allows it, Software AG
recommends seing the value for coredump, data, file, memory, and threads to
unlimited, and the value of nofiles to 8192. For more information about seing and
displaying the ulimits, read the man page or ask your system administrator.

Set the shmmax parameter to the memory (RAM) that is physically available on your
machine. Otherwise you might have problems during CentraSite startup.

Prepare to Install Integration Server on a UNIX System
Integration Server's ability to handle traffic is constrained by the number of file
descriptors available to the Integration Server process. On most systems, 64 file
descriptors are available to each process by default. If you are going to install Integration
Server on a UNIX system, Software AG recommends that you ask your system
administrator to increase the number of file descriptors available to the Integration
Server process to at least 1024.

Important: You might have to increase this number depending on the number of files
Integration Server needs to have open at one time. It is dangerous to set
the rlim_fd_max value higher than 1024 because of limitations with the
select function, so if Integration Server requires more file descriptors, ask the
system administrator to set the setrlimit value directly.
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Database Connection Information
Some products require you to supply database connection information during
installation. Sample URL formats for supported database drivers are shown in the
product panels. Keep in the mind the following:

Most products use the DataDirect Connect JDBC 5.1 driver. For information about
options supported by this driver, see DataDirect Connect for JDBC User's Guide and
Reference 5.1, available on the Software AG Documentation website.

If you are using the installer GUI mode, for ease of use, the database connection
values you enter on one panel are reflected on the next as you go forward through
the installer the first time.

Use the DataDirect Connect connection option MaxPooledStatements=35 on all
database URLs. This connection option improves performance by caching prepared
statements.

If the database user and password do not yet exist, specify the database user and
password you will create after installation. You can use one database user for
multiple database components, or you can use a different database user for each
database component.

For DB2, if the product will connect to a schema other than the default schema
for the specified database user, you must specify these connection options in the
database URL, where AlternateID is the name of the default schema that is used to
qualify unqualified database objects in dynamically prepared SQL statements:
;AlternateId=schema ;"InitializationString=(SET CURRENT 
PATH=current_path ,schema )";MaxPooledStatements=35

Install Products

Start the Installer, Provide General Information, and Choose the
Products to Install
As you go through the Software AG Installer, you will be asked for various types of
information, such as product license files and database connection parameters. Scan the
pages in this chapter that show the installer panels you will encounter, and gather the
information you will need before starting the installer.

Read the requirements in Using the Software AG Installer (for example, the requirement
to create a user account that has the proper privileges for Windows and that is non-root
for UNIX). Follow the instructions in that guide to start the installer and provide general
information such as proxy server, release to install, installation directory, and how to use
the product selection tree.
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Important: Unless otherwise stated for a specific product, do not install products from
this release into a Software AG directory that contains products from any
other release. Unless otherwise stated for a specific product, you cannot mix
products from different releases in the same installation directory; if you do
so, you will experience problems or be unable to access functionality.

You can install the CentraSite Registry Repository and Application Server Tier on
different machines, or in the same directory on the same machine. If you install the
components on different machines, or in the same directory on the same machine but at
different times, you must install the Registry Repository first.

Note: You cannot install multiple instances of the CentraSite Application Server Tier
or Registry Repository on the same machine.

On the installation directory panel, the installer auto-detects a host name or IP address
for the machine on which you are running the installer. If you are installing CentraSite,
you might need to change that value, as follows:

If you install the Application Server Tier and Registry Repository on different
machines, the value when you install the Registry Repository must specify a host
name or IP address that the Application Server Tier can use to access the Registry
Repository.

If you are installing CentraSite in the cloud, the installer auto-detects the internal
IP address of the cloud instance. If you want CentraSite to be accessible from
outside the cloud instance (for example, from another cloud instance running other
products), replace the auto-detected value with an externally accessible host name or
IP address.

On the product selection tree, select the products to install. CentraSite offers Eclipse
plug-ins that let you work with and generate reports about CentraSite assets. You can
install these plug-ins as part of Software AG Designer by selecting them on the product
selection tree, or you can add the plug-ins to your own Eclipse environment later using
instructions in the CentraSite documentation.

On the language pack selection tree, if you select the CentraSite Application Server Tier
language pack, you must also select the CentraSite Shared Files language pack.

After the product selection tree, the installer displays the language pack selection tree.
For information on language packs, see the international operating environments
appendix in this guide. The installer then displays panels (GUI mode) or prompts
(console mode) that ask for product configuration information. The sections below show
the panels, but the information and fields on the panels are identical to the information
and fields in the prompts.

Important: Make sure all ports you specify on panels or in response to prompts are
not already being used by other products on your machine. The installer
cannot detect whether ports are in use when products are shut down, and
the shuing down of products is a requirement for running the installer. See
the list of default ports used by Software AG products.

https://empower.softwareag.com/sl24sec/SecuredServices/Products.nav5/Component_Downloads.lnk2/TCPIP/tcpip_used_ports.pdf
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Supply Product Configuration Information

Sudo
When you install on a UNIX system, the panel below might appear.

You must either have the installer run the afterInstallAsRoot.sh script, or you must run
the script manually after installation as explained later in this chapter. If you want to
have the installer run the script, the user under which you are running the installer must
be in the sudoers configuration.

For security reasons, the installer does not store the sudo password in installation
scripts. If you are creating or installing from an installation script, therefore, the
option to use sudo is not available. You will have to run the afterInstallAsRoot.sh
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script manually after installation as a user who is in the sudoers configuration. See the
instructions for registering daemons and seing file permissions later in this chapter.

API-Portal
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CentraSite

Field Entry

ActiveSOA license
file ports

If you licensed CentraSite ActiveSOA, full path to the license
file.

Application Server
Tier ports

Defaults shown are for the bundled Software AG Web Server
based on Apache Tomcat.
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Field Entry

Remote Registry
Repository fields

Required when installing the Application Server Tier if the
Registry Repository is on a different machine. Do not use
localhost.

Integration Server

Field Entry

License file Specify the full path to the Mediator license file.
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Field Entry

The license for Mediator allows only partial Integration Server
functionality. Install Mediator on its own host Integration Server.
Do not install other products on an Integration Server that hosts
Mediator, or those other products might not work properly.

Install all
packages...

The installer will copy the Mediator package you selected
on the product selection tree into the package repository in
the Integration Server installation, and will create a default
Integration Server instance. If you want the installer to install
Mediator on the default instance, select the check box.

Database
Connection

Available when you select External RDBMS. You must decide
where to store data wrien by Integration Server and Mediator.
For complete information, see "Data Storage" on page 157.

Complete the Installation
For some products, you must perform certain tasks before startup. This section explains
those tasks.

For instructions on starting products and performing post-startup configuration and
customization, see the product documentation.

Change Default Passwords
Products are installed with default passwords. For security reasons, you should change
these passwords as soon as possible. For instructions, see the product documentation.

Install Latest Fixes
Install the latest fixes on the products you installed. For instructions on using the
Software AG Update Manager, see Using the Software AG Update Manager. Each fix
includes a readme file that contains instructions on installing the fix.

Register Daemons and Set File Permissions
If you were asked whether to use sudo during installation on a UNIX system
and you chose not to, the installer was not able to register daemons and set file
permissions. Perform these tasks now by running the script Software AG_directory /bin/
afterInstallAsRoot.sh as a user who is in the sudoers configuration.

Important: You must run this script or your products might not work correctly.
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The installer and this script register daemons for certain products only; for other
products, you perform the daemon registration yourself. For complete details and
instructions, see "Register Daemons to Automatically Start and Shut Down Products on
UNIX Systems" on page 193.

Complete the CentraSite Installation

Set Internet Browser
Clear your browser's cache to avoid JavaScript errors and make sure the browser is set
up to allow JavaScript to execute.

Complete the Integration Server Installation on a Mac OS X or Other
UNIX System
If non-root users will be running Integration Server, you might want to change the
ownership of the installed files to allow a single non-root user to run Integration Server
(chown), change the file group to the group of users who will run Integration Server
(chgrp), or change file permissions to allow all users to run Integration Server (chmod).

Connect Products to Each Other
If you installed all products at the same time, and did not change any port seings or
default passwords after installation, many inter-product connections are configured
automatically. For instructions on connecting products to each other, see the product
documentation.

Uninstall Products
Follow the instructions in Using the Software AG Installer, with the additional guidelines
below.

If you are going to uninstall Software AG Designer Eclipse, and you want to review or
preserve Eclipse installation information, do so before starting the uninstaller, because
the uninstaller will delete the entire Software AG Designer installation directory. User-
created data that is stored in other directories, such as your workspace, will remain
untouched.

If you are going to uninstall from a Mac OS or other UNIX system, and you used sudo to
register daemons and set file permissions during or after installation, you must also use
sudo to unregister daemons and remove file permissions, as follows:

If you are not going to use an uninstallation script to uninstall, you can choose
the uninstaller option to perform this task, or you can perform this task before
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starting the uninstaller by executing the script Software AG_directory/bin/
beforeUninstallAsRoot.sh as a user who is in the sudoers configuration.

If you are going to use an uninstallation script, the uninstaller cannot execute the
script because it does not store the sudo password, for security reasons. You must
execute the script yourself before starting the uninstaller.

Important: You must either have the uninstaller execute the script or run it yourself, or
some products might not work correctly.

If you are going to uninstall CentraSite:

If the CentraSite Registry Repository is on a different machine than the Application
Server Tier, uninstall the Application Server Tier first, and then uninstall the Registry
Repository.

The CentraSite Registry Repository database will not be deleted after uninstallation
is complete. There are many circumstances in which you should retain the database
after uninstalling CentraSite; for example, when the database contains information
that is important for your enterprise. If you do want to delete the CentraSite database
after uninstallation is complete, Software AG strongly recommends making a
backup copy of its contents first. Then delete the Software AG_directory/CentraSite/
data directory.
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Typical Development Installation
The Software AG Installer offers typical development installations of products that
enable you to perform a certain task. When you select a typical development installation,
the installer automatically selects all products that make up that installation. For
Mobile products, the typical development installation is called Mobile Application
Development.

For this typical development installation, you must create certain database components.
A database component is a grouping of database objects that is used by one or more
products. You must create the MobileSupport database component, and all of the
database components for the Integration Server that hosts Mobile Support. For complete
information about each database component, see "Creating and Dropping Database
Components" on page 155.

To create production environments, work with your administrators, Software AGGlobal
Consulting Services, and best practices documentation.

Software and Hardware Support and Requirements

Operating System and Browser Support
For information on operating systems, RDBMSs, and browsers that are supported by
your products, see System Requirements for Software AG Products.

For information on supported database drivers, see "Database Components" on page
156.

Software Requirements and Considerations

Product Software Requirements and Considerations

All If the vendor for your operating system recommends installing
the latest service packs, patch-bundles, and fixes, Software AG
encourages you to follow that recommendation. If you
experience problems with installed service packs, patch-bundles,
or fixes, report those problems directly to the vendor.

Mobile
Administrator

When installing Mobile Administrator on a physical machine,
you need some common development tools. Install those tools
by running the appropriate commands below.

Red Hat Enterprise Linux / CentOS:
yum install gettext make gcc gcc-c++ openssl-devel \
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Product Software Requirements and Considerations
 libicu-devel zlib-devel readline-devel autoconf \
 perl-ExtUtils-MakeMaker

Debian:
apt-get install gettext make gcc g++ libssl-dev curl \
 libicu-dev zlib1g-dev libreadline6-dev autoconf \
 libmodule-build-perl libmodule-install-perl libc6-dev \
 libmysql++-dev libsqlite3-dev build-essential \
 libssl-dev

SuSE Enterprise Linux Server:
zypper install gettext-tools make gcc libopenssl-devel \
 curl libicu-devel zlib-devel readline-devel autoconf \
 perl-ExtUtils-PkgConfig libxslt-devel libMagickWand1 \
 libcurl-devel p7zip ImageMagick-Devel libxml2-devel \
 libmysqlclient-devel apache2-worker \
 apache2-mod_xsendfile mysql-client gcc-c++ mysql

When installing Mobile Administrator on a virtual machine
(used when hosting Mobile Administrator in the cloud or
running Mobile Administrator for demos), install Oracle VM
VirtualBox or Vagrant.

Mobile
Designer

Install an integrated development environment (IDE).
Software AG recommends using the Eclipse provided with
Software AG Designer on the Software AG Installer.

If you are going to use Mobile Designer separately from
Software AG Designer, install Apache ANT 1.8 or higher using
the instructions in the vendor documentation.

Hardware Requirements

Minimum and Recommended Hardware Requirements
The table below lists the minimum and recommended hardware requirements for
your products. Recommended amounts are shown in parentheses. Mobile Support has
minimal or no requirements beyond the host Integration Server.

Important: The hardware requirements below are for the listed products only. They do
not include 2GB of hard drive space for Software AG infrastructure shared
libraries required by most products and installed once per installation
directory. They do not include requirements for supporting software such
as RDBMSs. They do not include the additional requirements listed in
"Additional Hardware Requirements" on page 114. You must determine
the overall hardware requirements for each of your machines based on the
overall requirements of your operating system and software.
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Product Hard Drive Space RAM CPUs

Software AG Designer
Eclipse platform

380MB 1.5GB
(2GB)

1 (2)

Integration Server 300MB (500MB) 1GB
(2GB)

1 (2)

Mobile    

 Mobile
Administrator

300MB 4GB 2

 Mobile Designer 1GB 1GB 1

My webMethods Server 300MB (500MB) 1GB
(2GB)

1

Additional Hardware Requirements

Product Additional Hardware Requirements

Software AG
Designer

Using the Software AG Installer lists free space the Software AG
Installer requires in its system temp (Windows) or temporary
(UNIX) directory. For Software AG Designer Eclipse platform,
the installer needs 700MB additional free hard drive space in that
directory.

Each product plug-ins you install in Software AG Designer can
require from 50K to 150MB of additional free hard drive space.

Mobile
Administrator

You will need additional hard drive space depending on the
number of applications you plan to add, the size of their source
code, builds, screen shots, and logs.

Mobile
Designer

You will need additional hard drive space to accommodate the
SDKs for the mobile devices for which you want to develop
applications.
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Shut Down Products
Shut down all non-Software AG applications that are running on the machine on which
you are going to install. If these applications are not shut down, product files might
become corrupted.

If you are installing new products into an existing Software AG product installation
directory (that contains products from the same release), running products in that
directory must be shut down so the installer can update key files that are locked by
the operating system. If the products are running as applications, shut them down
manually. If the products are running as services or daemons, the installer will
automatically shut down many of them (and later restart them), but you must manually
shut down the products listed below (and later restart them).

Product Steps

CentraSite Shut down the Software AG Runtime service and the
CentraSite Registry Repository service.

Content Service
Platform

See the instructions in the product documentation.

Software AG
Designer

Click File > Exit.

Terracoa Server
Array

Run the bin/stop-tc-server.{bat|sh} command. If you are
running a mirror group, shut down the passive server and
then the active server.

Prepare Your Machine

Prepare to Install My webMethods Server
If you are going to install the My webMethods Server on a UNIX system, make sure
you have set sufficient user limits for the shell you use to start the installation and the
product daemons. For example, if you have multiple language packs installed for My
webMethods Server, or if there are multiple products on the machine, the daemons for
My webMethods Server will run out of memory if they are started from the shell with a
low user limit for data. If your system policy allows it, Software AG recommends seing
the value for coredump, data, file, memory, and threads to at least 32768, and the value
of nofiles to 8192. For more information about seing and displaying the ulimits, read
the man page or ask your system administrator.
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Database Connection Information
Some products require you to supply database connection information during
installation. Sample URL formats for supported database drivers are shown in the
product panels. Keep in the mind the following:

Most products use the DataDirect Connect JDBC 5.1 driver. For information about
options supported by this driver, see DataDirect Connect for JDBC User's Guide and
Reference 5.1, available on the Software AG Documentation website.

If you are using the installer GUI mode, for ease of use, the database connection
values you enter on one panel are reflected on the next as you go forward through
the installer the first time.

Use the DataDirect Connect connection option MaxPooledStatements=35 on all
database URLs. This connection option improves performance by caching prepared
statements.

If the database user and password do not yet exist, specify the database user and
password you will create after installation. You can use one database user for
multiple database components, or you can use a different database user for each
database component.

For DB2, if the product will connect to a schema other than the default schema
for the specified database user, you must specify these connection options in the
database URL, where AlternateID is the name of the default schema that is used to
qualify unqualified database objects in dynamically prepared SQL statements:
;AlternateId=schema ;"InitializationString=(SET CURRENT 
PATH=current_path ,schema )";MaxPooledStatements=35

Install Products

Start the Installer, Provide General Information, and Choose the
Products to Install
As you go through the Software AG Installer, you will be asked for various types of
information, such as product license files and database connection parameters. Scan the
pages in this chapter that show the installer panels you will encounter, and gather the
information you will need before starting the installer.

Read the requirements in Using the Software AG Installer (for example, the requirement
to create a user account that has the proper privileges for Windows and that is non-root
for UNIX). Follow the instructions in that guide to start the installer and provide general
information such as proxy server, release to install, installation directory, and how to use
the product selection tree.
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Important: Unless otherwise stated for a specific product, do not install products from
this release into a Software AG directory that contains products from any
other release. Unless otherwise stated for a specific product, you cannot mix
products from different releases in the same installation directory; if you do
so, you will experience problems or be unable to access functionality.

On the product selection tree, select the products to install.

After the product selection tree, the installer displays the language pack selection tree.
For information on language packs, see the international operating environments
appendix in this guide. The installer then displays panels (GUI mode) or prompts
(console mode) that ask for product configuration information. The sections below show
the panels, but the information and fields on the panels are identical to the information
and fields in the prompts.

Important: Make sure all ports you specify on panels or in response to prompts are
not already being used by other products on your machine. The installer
cannot detect whether ports are in use when products are shut down, and
the shuing down of products is a requirement for running the installer. See
the list of default ports used by Software AG products.

https://empower.softwareag.com/sl24sec/SecuredServices/Products.nav5/Component_Downloads.lnk2/TCPIP/tcpip_used_ports.pdf
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Supply Product Configuration Information

Integration Server

If you select External RDBMS, you must decide where to store data wrien by Integration
Server. For complete information, see "Data Storage" on page 157.
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Mobile Designer
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Mobile Support
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My webMethods Server

Select the check box to create a My webMethods Server instance and complete the port
and database fields. If you select External RDMBS, you must decide where to store data
wrien by My webMethods Server. For complete information, see "Data Storage" on
page 157.

Create Database Components
Mobile requires you to create database components. For instructions, see "Creating and
Dropping Database Components" on page 155.
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Complete the Installation
For some products, you must perform certain tasks before startup. This section explains
those tasks.

For instructions on starting products and performing post-startup configuration and
customization, see the product documentation.

Change Default Passwords
Products are installed with default passwords. For security reasons, you should change
these passwords as soon as possible. For instructions, see the product documentation.

Install Latest Fixes
Install the latest fixes on the products you installed. For instructions on using the
Software AG Update Manager, see Using the Software AG Update Manager. Each fix
includes a readme file that contains instructions on installing the fix.

Complete the Integration Server Installation on a Mac OS X or Other
UNIX System
If non-root users will be running Integration Server, you might want to change the
ownership of the installed files to allow a single non-root user to run Integration Server
(chown), change the file group to the group of users who will run Integration Server
(chgrp), or change file permissions to allow all users to run Integration Server (chmod).

Complete the Mobile Administrator Installation
This step varies depending on whether you installed Mobile Administrator on a physical
or virtual machine.

If you installed on a physical machine, go to the Software AG_directory/
MobileAdministrator directory and run the command ./install.sh as root. If the
installation is successful, you will see the message Notice: Finished catalog run
in 2594.71 seconds, and the installed Mobile Administrator will be available via
HTTP or HTTPS at the IP address of the host machine. If an error occurs, you will see
the complete error message.

If Mobile Administrator cannot connect to the Apache web server on ports 80
(HTTP) and 443 (HTTPS), make sure your firewall is configured correctly. If the
host machine has SELinux enabled, go to the /var/www/appfresh/log directory and
open the apache_error.log file. If you see error messages similar to (13)Permission



M
Odd Header

Installing and Uninstalling Mobile Products

Installing Software AG Products Version 9.9 123

denied: proxy: HTTP: attempt to connect to 127.0.0.1:5000 (localhost)
failed, run the command below as root:
# setsebool -P httpd_can_network_connect 1

If you installed on a virtual machine, the Mobile Administrator virtual installer is
a Vagrantfile. The installer sets up a virtual machine with a Linux distribution and
installs Mobile Administrator. Go to the Software AG_directory/MobileAdministrator
directory and execute Vagrantfile by running the appropriate command below.

Distribution Command

Debian 6.0.7 vagrant up standalone

SuSE
Enterprise
Linux Server
11

APPFRESH_LINUX=sles vagrant up standalone

CentOS 6.5 APPFRESH_LINUX=centos vagrant up standalone

Distribution Command

If the installation is successful, you will see the message Notice: Finished
catalog run in 2594.71 seconds, and the installed Mobile Administrator will be
available at hps://192.168.10.10. If an error occurs, you will see the complete error
message.

Connect Products to Each Other
If you installed all products at the same time, and did not change any port seings or
default passwords after installation, many inter-product connections are configured
automatically. For instructions on connecting products to each other, see the product
documentation.

Uninstall Products

Uninstall Mobile Administrator
To uninstall Mobile Administrator from a virtual machine, follow the Oracle VM
VirtualBox or Vagrant instructions.

To uninstall Mobile Administrator from a physical machine, follow the instructions
below.
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1. Back up your data files (for example, application binaries or screenshots that have
been generated by Mobile Administrator). The data files are stored in the /var/www/
appfresh/public/datafiles directory.

2. Export your MySQL database. For instructions, see the vendor documentation.

3. Go to the Software AG_directory /MobileAdministrator directory.

4. Stop Mobile Administrator by running the command /etc/init.d/appfresh-
mobile stop

5. Remove the appfresh directory by running the command rm -rf /var/www/
appfresh

6. Remove the appfresh-mobile directory by running the command rm -rf /var/run/
appfresh-mobile

7. Remove the database by running the command mysql -uroot -e 'drop database
appfreshmobile'

8. Remove the Apache virtual host by running the command rm /etc/apache2/
sites-enabled/25-appfresh*

Uninstall All Other Products
Follow the instructions in Using the Software AG Installer, with the additional guidelines
below.

If you are going to uninstall Software AG Designer Eclipse, and you want to review or
preserve Eclipse installation information, do so before starting the uninstaller, because
the uninstaller will delete the entire Software AG Designer installation directory. User-
created data that is stored in other directories, such as your workspace, will remain
untouched.
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Software and Hardware Support and Requirements

Operating System and Browser Support
For information on operating systems, RDBMSs, and browsers that are supported by
your products, see System Requirements for Software AG Products.

For information on supported database drivers, see "Database Components" on page
156.

Software Requirements and Considerations
On Windows and Linux systems, Software AG offers dedicated 64-bit and 32-bit
versions of Broker Server. The 64-bit version is installed on 64-bit systems, while the
32-bit version is installed on 32-bit systems.

On Solaris, HP-UX, and AIX systems, Software AG offers 64-bit and 32-bit (LP32
Object Code) versions of the webMethods Broker C API. If you select the C API for
installation, the installer installs both versions, in the Software AG_directory/Broker/lib
and /lib32 directories, respectively.

If you are going to install on a Solaris 10 system, install the SUNWxcu4 package.

If you are going to install on a Solaris 11 system, install the system/xopen/xcu4
package.

If you are going to install on a Linux system, the library libcrypt.so must be
present to support the security infrastructure, or the login using OS user names/
authentication will not work. If you do not see the libcrypt.so file in the /usr/lib64
directory for Linux x86_64, or /usr/lib for Linux x86, install the rpm package glibc-
devel.

If you are going to install on a Linux x86_64 system, install the rpm package compat-
libstdc++ from your operating system distribution using the vendor instructions.

Hardware Requirements
The table below lists the minimum and recommended hardware requirements for your
products. Recommended amounts are shown in parentheses.

Important: The hardware requirements below are for the listed products only. They do
not include 2GB of hard drive space for Software AG infrastructure shared
libraries required by most products and installed once per installation
directory. You must determine the overall hardware requirements for each of
your machines based on the overall requirements of your operating system
and software.



M
Odd Header

Installing and Uninstalling webMethods Broker

Installing Software AG Products Version 9.9 127

Product Hard Drive
Space

RAM CPUs

webMethods Broker 750MB
(1.2GB)

512MB
(2GB)

1

webMethods Broker might need additional hard drive space if your documents are
large, or if your clients use many guaranteed documents.

Shut Down Products
Shut down all non-Software AG applications that are running on the machine on which
you are going to install. If these applications are not shut down, product files might
become corrupted.

If you are installing new products into an existing Software AG product installation
directory (that contains products from the same release), running products in that
directory must be shut down so the installer can update key files that are locked by
the operating system. If the products are running as applications, shut them down
manually. If the products are running as services or daemons, the installer will
automatically shut down many of them (and later restart them), but you must manually
shut down the products listed below (and later restart them).

Product Steps

CentraSite Shut down the Software AG Runtime service and the
CentraSite Registry Repository service.

Content Service
Platform

See the instructions in the product documentation.

Software AG
Designer

Click File > Exit.

Terracoa Server
Array

Run the bin/stop-tc-server.{bat|sh} command. If you are
running a mirror group, shut down the passive server and
then the active server.
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Prepare Your Machine

Prepare to Install webMethods Broker on a UNIX System
Information about webMethods Broker installations is stored in the webMethods
Broker installations.txt file in the /var/opt/webmethods directory. Make sure the user
that you are going to use to install has write permission to that directory.

Broker Monitor and Broker Server require certain minimum system and user limits
on UNIX systems. Ask your system administrator to set the following values for each
process:

Limit Value

Maximum threads 512

Maximum open files 8192

Core dump size unlimited

On Solaris, HP-UX, and AIX systems, Broker Server is a 64-bit binary application. If
you are going to install Broker Server on one of these systems, you must configure
the operating system kernel to run in 64-bit mode.

If you are going to configure Broker Server to create data files on an NFS-mounted
partition, mount the partition using the command below. The options on the
command help protect data integrity.
mount -o hard,nointr,proto=tcp host :/path  /mount_point       

Option Description

hard By default, if the NFS server does not respond to requests from the
Broker Server, the Broker Server tries a few times and then fails. The
hard option forces the Broker Server to keep retrying until the NFS
server responds. The Broker Server hangs during this period.

nointr Prevents users from shuing down the Broker Server while it waits
for the NFS server to respond.

proto=tcp By default, the NFS-mounted partition uses the user datagram
protocol (UDP) protocol to communicate with the Broker Server.
The proto=tcp option forces the partition to use transmission control
protocol (TCP) instead. TCP is more reliable than UDP.
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Suppose the partition you want to mount is on a machine named netappca, the data
directory on the partition is wmbroker_data, and you want to mount the partition on
the local file system at /var/opt/wmbroker_data. The command would be as follows:
mount -o hard,nointr,proto=tcp netappca:/wmbroker_data /var/opt/wmbroker_data

For information on other ways to protect data integrity, see your NFS server
documentation.

If you are going to install Broker Server on an NFS file system, the Basic
Authentication feature will only work if you mount the NFS file system with the suid
option, which allows set-user-identifier or set-group-identifier bits to take effect.

Install Products

Start the Installer, Provide General Information, and Choose the
Products to Install
As you go through the Software AG Installer, you will be asked for various types of
information, such as product license files and database connection parameters. Scan the
pages in this chapter that show the installer panels you will encounter, and gather the
information you will need before starting the installer.

Read the requirements in Using the Software AG Installer (for example, the requirement
to create a user account that has the proper privileges for Windows and that is non-root
for UNIX). Follow the instructions in that guide to start the installer and provide general
information such as proxy server, release to install, installation directory, and how to use
the product selection tree.

Important: Unless otherwise stated for a specific product, do not install products from
this release into a Software AG directory that contains products from any
other release. Unless otherwise stated for a specific product, you cannot mix
products from different releases in the same installation directory; if you do
so, you will experience problems or be unable to access functionality.

On the product selection tree, select the products to install.

After the product selection tree, the installer displays the language pack selection tree.
For information on language packs, see the international operating environments
appendix in this guide. The installer then displays panels (GUI mode) or prompts
(console mode) that ask for product configuration information. The sections below show
the panels, but the information and fields on the panels are identical to the information
and fields in the prompts.

Important: Make sure all ports you specify on panels or in response to prompts are
not already being used by other products on your machine. The installer
cannot detect whether ports are in use when products are shut down, and



M
Even Header

Installing and Uninstalling webMethods Broker

Installing Software AG Products Version 9.9 130

the shuing down of products is a requirement for running the installer. See
the list of default ports used by Software AG products.

Supply Product Configuration Information

webMethods Broker

When you install webMethods Broker, you install the following:

A default Broker. Brokers execute client messaging requests.

Optionally, a Broker Server. Broker Servers host Brokers; they receive client requests,
send them to Brokers, and return responses to clients. They also manage memory
and disk resources for the Brokers they host.

https://empower.softwareag.com/sl24sec/SecuredServices/Products.nav5/Component_Downloads.lnk2/TCPIP/tcpip_used_ports.pdf
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A Broker Monitor. Broker Monitors continually check the state of Broker Servers and
automatically restarts them if they stop running.

Field Entry

IP address to
bind to

By default, Broker Monitor will bind to all IP addresses on the
local machine. If necessary, bind Broker Monitor to a specific IP
address instead.

Create a
Broker Server
Configuration

Every Broker Server has it own data directory, which holds
theBroker Server's configuration file and log files, and storage
session, which stores configuration (metadata) and run-time data.

You would not create the Broker Server configuration at this time
(that is, using the installer) if you want to use a different storage
size than is offered by the installer or if you want to create a
combined storage session for configuration and run-time data. If
you do not need to back up configuration data without shuing
down your Broker Server, using a combined session might save
you a small amount of disk space. If you choose to not create
the Broker Server configuration at this time, you must create it
after installation is complete, using instructions in Administering
webMethods Broker.

You would create the Broker Server configuration at this time
(that is, using the installer) if you want to use a storage size that
is offered by the installer and you want to create separate storage
sessions for configuration (metadata) and run-time data. Using
separate storage sessions minimizes the risk of corruption that
goes with a combined storage location and enables you to back
up configuration data without having to shut down your Broker
Server.

Software AG recommends creating separate sessions. You cannot
later change from a combined session to separate sessions or vice
versa.

To create the Broker Server configuration, select the check box
and complete the fields below.

Data directory Full path to the directory for Broker Server data. If you install
multiple Broker Server instances on the same machine, use a
different data directory for each instance.

Storage size Select a pre-configured storage session for the Broker Server that
can handle your expected usage needs.



M
Even Header

Installing and Uninstalling webMethods Broker

Installing Software AG Products Version 9.9 132

Field Entry

Small. Ideal for running development Broker Servers or small
number of production integrations, low document volumes, and
no document logging. Fastest Broker Server startup time.

Medium. Standard deployment size, fits more cases than Small;
larger maximum transaction size and twice the storage capacity
of Small. Broker Server startup time two times longer than Small.

Large. Suitable for production deployments with many
integrations running at high document volumes, possibly using
document logging as well. Broker Server startup time two times
longer than Medium, four times longer than Small.

When determining the appropriate size for the log file, the factors to balance are Broker
Server startup time and the desired maximum transaction size. The smaller the log file,
the faster the startup; however, with a larger log file, you can send larger messages (that
is, one larger-sized single document or a batch of documents). If necessary, you can
remove or replace log files after installation, and you can increase or decrease their size.
Startup time does not depend on the size of the storage file; additional storage capacity
merely prevents the Broker Server from running out of room. After installation, if the
amount of storage allocated turns out to be insufficient, you can add storage files and
increase their size. You cannot remove storage files or decrease their size. Administering
webMethods Broker provides complete information on Broker Server storage sessions and
instructions on working with log files and storage files.

Complete the Installation
For some products, you must perform certain tasks before startup. This section explains
those tasks.

For instructions on starting products and performing post-startup configuration and
customization, see the product documentation.

Change Default Passwords
Products are installed with default passwords. For security reasons, you should change
these passwords as soon as possible. For instructions, see the product documentation.

Install Latest Fixes
Install the latest fixes on the products you installed. For instructions on using the
Software AG Update Manager, see Using the Software AG Update Manager. Each fix
includes a readme file that contains instructions on installing the fix.
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Complete the webMethods Broker Installation

Make Sure Broker Server is Running and the Default Broker Exists
After installation, Broker Monitor starts automatically and then starts the Broker Server,
which begins running with a default Broker. Make sure the Broker Server is running and
the default Broker exists by running this command:
broker_status [Broker #1@]Broker Server_host [:Broker Server_port ]

Enable Full Core Dumps on an AIX System
On AIX systems, you must enable full core dumps. Using the AIX System Management
Interface Tool (SMIT), run the command smitty chgsys and set Enable full CORE
dump to true.

Connect Products to Each Other
If you installed all products at the same time, and did not change any port seings or
default passwords after installation, many inter-product connections are configured
automatically. For instructions on connecting products to each other, see the product
documentation.

Uninstall Products
Follow the instructions in Using the Software AG Installer, with the additional guidelines
below.

If your Broker Monitor was configured to run as a daemon, you can delete the
Broker Monitor startup script from your UNIX startup directories after uninstalling
webMethods Broker. If you had configured a single Broker Monitor to run as a daemon,
the startup script is named Snumber brokerrelease  (for example, S45broker95). If you
had configured multiple Broker Monitors to run as daemons, the names of the startup
scripts have an additional character at the end to make them unique (for example,
S45broker95_1, S45broker95_2, and so on).
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Typical Development Installation
The Software AG Installer offers typical development installations of products that
enable you to perform a certain task. When you select a typical development installation,
the installer automatically selects all products and components that make up that
installation. The typical development installation for this product is called ApplinX.

Note: In a collaborative development environment, CentraSite Registry Repository
would be installed on a shared machine and accessed by development users.

To create production environments, work with your administrators, Software AGGlobal
Consulting Services, and best practices documentation.

Software and Hardware Support and Requirements

Operating System and Browser Support
For information on operating system and browser support for your productss, see
System Requirements for Software AG Products.

Software Requirements

Product Software Requirements and Considerations

All If the vendor for your operating system recommends installing
the latest service packs, patch-bundles, and fixes, Software AG
encourages you to follow that recommendation. If you experience
problems with installed service packs, patch-bundles, or fixes, report
those problems directly to the vendor.

ApplinX If you are going to install on a Windows system, and you want
to develop .NET ApplinX Web applications in Visual Basic or
C#, install Microsoft Visual Studio 2005, or install Microsoft
Visual Studio 2008 or 2010 and the Microsoft Visual J# .NET 2.0
Redistributable Package. Microsoft Visual Studio does not have to
be running when you install ApplinX.

If you do not install Microsoft Visual Studio, you will not be
able to install the ApplinX Visual Studio Add-in component,
and the ApplinX .NET Framework component will have limited
functionality; you will not be able to develop composite Web
applications.
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Product Software Requirements and Considerations

If you are going to install on a Linux x86_64 system, install the rpm
package compat-libstdc++ from your operating system distribution
using the vendor instructions.

Hardware Requirements
The table below lists the minimum and recommended hardware requirements for your
products. Recommended amounts are shown in parentheses.

Important: The hardware requirements below are for ApplinX only. They do not include
2GB of hard drive space for Software AG infrastructure shared libraries
required by most products and installed once per installation directory.
You must determine the overall hardware requirements for each of your
machines based on the overall requirements of your operating system and
software.

Product Hard Drive Space RAM CPUs

ApplinX    

 Server 100MB 80MB+300KB per
user

2 (4)

 Administration 75MB 40MB  

 JSP Framework 50MB 2GB  

 C#.NET Framework 55MB 2GB  

 VB.NET Framework 30MB 2GB  

 Visual Studio Add-In 1MB 2GB  

Software AG Designer
Eclipse platform

380MB 1.5GB (2GB) 1 (2)

Using the Software AG Installer lists free space the Software AG Installer requires in its
system temp (Windows) or temporary (UNIX) directory. For Software AG Designer
Eclipse platform, the installer needs 700MB additional free hard drive space in that
directory. Each product plug-ins you install in Software AG Designer can require from
50K to 150MB of additional free hard drive space.
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For additional hardware requirements, see the ApplinX documentation.

Shut Down Products
Shut down all non-Software AG applications that are running on the machine on which
you are going to install. If these applications are not shut down, product files might
become corrupted.

If you are installing new products into an existing Software AG product installation
directory (that contains products from the same release), running products in that
directory must be shut down so the installer can update key files that are locked by
the operating system. If the products are running as applications, shut them down
manually. If the products are running as services or daemons, the installer will
automatically shut down many of them (and later restart them), but you must manually
shut down the products listed below (and later restart them).

Product Steps

CentraSite Shut down the Software AG Runtime service and the
CentraSite Registry Repository service.

Content Service
Platform

See the instructions in the product documentation.

Software AG
Designer

Click File > Exit.

Terracoa Server
Array

Run the bin/stop-tc-server.{bat|sh} command. If you are
running a mirror group, shut down the passive server and
then the active server.

Prepare Your Machine
If you are going to install on a UNIX system, make sure you have set sufficient user
limits for the shell you use to start the installation and the product daemons. For
example, the daemons for the Software AG Runtime will run out of memory if they
are started from the shell with a low user limit for data. If your system policy allows
it, Software AG recommends seing the value for coredump, data, file, memory, and
threads to unlimited, and the value of nofiles to 8192. For more information about seing
and displaying the ulimits, read the man page or ask your system administrator.
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Install ApplinX

Start the Installer, Provide General Information, and Choose ApplinX
Components
As you go through the Software AG Installer, you will be asked for various types of
information, such as product license files and database connection parameters. Scan the
pages in this chapter that show the installer panels you will encounter, and gather the
information you will need before starting the installer.

Read the requirements in Using the Software AG Installer (for example, the requirement
to create a user account that has the proper privileges for Windows and that is non-root
for UNIX). Follow the instructions in that guide to start the installer and provide general
information such as proxy server, release to install, installation directory, and how to use
the product selection tree.

Important: Unless otherwise stated for a specific product, do not install products from
this release into a Software AG directory that contains products from any
other release. Unless otherwise stated for a specific product, you cannot mix
products from different releases in the same installation directory; if you do
so, you will experience problems or be unable to access functionality.

On the product tree, choose the ApplinX components to install.

After the product selection tree, the installer displays the language pack selection tree.
For information on language packs, see the international operating environments
appendix in this guide. The installer then displays panels (GUI mode) or prompts
(console mode) that ask for product configuration information. The sections below show
the panels, but the information and fields on the panels are identical to the information
and fields in the prompts.

Important: Make sure all ports you specify on panels or in response to prompts are
not already being used by other products on your machine. The installer
cannot detect whether ports are in use when products are shut down, and
the shuing down of products is a requirement for running the installer. See
the list of default ports used by Software AG products.

Supply Product Configuration Information

ApplinX
If you are installing the ApplinX Server, the installer displays the panel below.

Note: The Migrate data field is for use with pre-8.1 release upgrades only. For
complete information, see the ApplinX upgrade documentation.

https://empower.softwareag.com/sl24sec/SecuredServices/Products.nav5/Component_Downloads.lnk2/TCPIP/tcpip_used_ports.pdf
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Complete the Installation

Install Latest Fixes
Install the latest fixes to ApplinX. Fixes are available from the Empower Product Support
website. Each fix includes a readme file that contains instructions on installing the fix.

Set Environment Variable
After the installer finishes, if you installed on a UNIX system, source the Software AG
environment file apxenv to set the environment variable APPLINX_ROOT, or set the
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variable permanently by copying the seing from the apxenv file into your profile. The
apxenv file is located in the Software AG_directory/ApplinX directory.

Uninstall ApplinX
Follow the instructions in Using the Software AG Installer, with the additional guidelines
below.

If you are going to uninstall Software AG Designer Eclipse, and you want to review or
preserve Eclipse installation information, do so before starting the uninstaller, because
the uninstaller will delete the entire Software AG Designer installation directory. User-
created data that is stored in other directories, such as your workspace, will remain
untouched.
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Typical Development Installation
The Software AG Installer offers typical development installations of products that
enable you to perform a certain task. When you select a typical development installation,
the installer automatically selects all products and components that make up that
installation. The typical development installation for this product is called EntireX.

To create production environments, work with your administrators, Software AGGlobal
Consulting Services, and best practices documentation.

Software and Hardware Support and Requirements

Operating System and Browser Support
For information on operating system and browser support for your products, see System
Requirements for Software AG Products.

Software Requirements

Product Software Requirements and Considerations

All If the vendor for your operating system recommends installing
the latest service packs, patch-bundles, and fixes, Software AG
encourages you to follow that recommendation. If you
experience problems with installed service packs, patch-bundles,
or fixes, report those problems directly to the vendor.

EntireX If you are going to install on a Linux system, the library
libcrypt.so must be present to support the security
infrastructure, or the login using OS user names/authentication
will not work. If you do not see the libcrypt.so file in the /usr/
lib64 directory for Linux x86_64, or /usr/lib for Linux x86, install
the rpm package glibc-devel.

If you are going to install on a Linux x86_64 system, install the
rpm package compat-libstdc++ from your operating system
distribution using the vendor instructions.

If you are going to install on a SUSE Linux Enterprise Server
11 SP1 system, and you have configured the system to use the
Blowfish algorithm to encrypt user passwords, download and
install patch 18 Aug 2011 - glibc 4944 from Novell Support.
This patch fixes an operating system bug relating to user
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Product Software Requirements and Considerations
authentication. For detailed information, see Novell’s SUSE
Security Announcement: SUSE-SA:2011:035.

Hardware Requirements
The table below lists the minimum and recommended hardware requirements for your
products. Recommended amounts are shown in parentheses.

Important: The hardware requirements below are for EntireX only. They do not include
2GB of hard drive space for Software AG infrastructure shared libraries
required by most products and installed once per installation directory.
You must determine the overall hardware requirements for each of your
machines based on the overall requirements of your operating system and
software.

Product Hard Drive
Space Windows

Hard Drive
Space UNIX

RAM CPUs

EntireX     

 Core Files 100MB 100MB 2GB 1

 Administration 140MB* 170MB* 1GB 1

 Broker 20MB 30MB   

 Libraries 10MB 10MB 1GB 1

 Web Services Runtime 140MB** 150MB** 1GB 1

Software AG Designer
Eclipse platform

380MB 5GB 1.5GB
(2GB)

1
(2)

 EntireX plug-in 50MB 50MB   

*Includes 120MB hard drive space, 1GB RAM, and 1 CPU for the required and
automatically installed System Management Hub.

**Includes 120MB hard drive space, 1GB RAM, and 1 CPU for the required and
automatically installed Web Services Stack.
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Using the Software AG Installer lists free space the Software AG Installer requires in its
system temp (Windows) or temporary (UNIX) directory. For EntireX, the installer needs
800MB additional free hard drive space in that directory. For Software AG Designer
Eclipse platform, the installer needs 700MB additional free hard drive space in that
directory.

Shut Down Products
Shut down all non-Software AG applications that are running on the machine on which
you are going to install. If these applications are not shut down, product files might
become corrupted.

If you are installing new products into an existing Software AG product installation
directory (that contains products from the same release), running products in that
directory must be shut down so the installer can update key files that are locked by
the operating system. If the products are running as applications, shut them down
manually. If the products are running as services or daemons, the installer will
automatically shut down many of them (and later restart them), but you must manually
shut down the products listed below (and later restart them).

Product Steps

CentraSite Shut down the Software AG Runtime service and the
CentraSite Registry Repository service.

Content Service
Platform

See the instructions in the product documentation.

Software AG
Designer

Click File > Exit.

Terracoa Server
Array

Run the bin/stop-tc-server.{bat|sh} command. If you are
running a mirror group, shut down the passive server and
then the active server.

Prepare Your Machine
If you are going to install on a UNIX system, make sure you have set sufficient user
limits for the shell you use to start the installation and the product daemons. For
example, the daemons for System Management Hub will run out of memory if they
are started from the shell with a low user limit for data. If your system policy allows
it, Software AG recommends seing the value for coredump, data, file, memory,
and threads to unlimited, and the value of nofiles to 8192. For more information
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about seing and displaying the ulimits, read the man page or ask your system
administrator.

If you are going to install the Administration component on a UNIX NFS file system,
the Basic Authentication feature will only work if you mount the NFS file system
with the suid option, which allows set-user-identifier or set-group-identifier bits to
take effect.

Install EntireX

Start the Installer, Provide General Information, and Choose EntireX
Components
As you go through the Software AG Installer, you will be asked for various types of
information, such as product license files and database connection parameters. Scan the
pages in this chapter that show the installer panels you will encounter, and gather the
information you will need before starting the installer.

Read the requirements in Using the Software AG Installer (for example, the requirement
to create a user account that has the proper privileges for Windows and that is non-root
for UNIX). Follow the instructions in that guide to start the installer and provide general
information such as proxy server, release to install, installation directory, and how to use
the product selection tree.

Important: Unless otherwise stated for a specific product, do not install products from
this release into a Software AG directory that contains products from any
other release. Unless otherwise stated for a specific product, you cannot mix
products from different releases in the same installation directory; if you do
so, you will experience problems or be unable to access functionality.

On the product tree, select the EntireX components to install. If you select EntireX, the
installer automatically selects the Administration component, which in turn selects
System Management Hub. The Administration component enables you to administer
the EntireX Broker, Broker Agent, and Authorization Rules, and to use the System
Management Hub to administer the EntireX RPC server. If you need only a lightweight
EntireX installation (for example, for use with NaturalONE), you might not need the
Administration component. Without this component, you will only be able to start and
stop the default EntireXBroker. For complete information on functionality provided by
the Administration component, see "System Management Hub" in the EntireX product
documentation.

To install all required EntireX libraries, select Infrastructure > Libraries > EntireX
Libraries. These libraries replace the EntireX Mini Runtime.

After the product selection tree, the installer displays the language pack selection tree.
For information on language packs, see the international operating environments
appendix in this guide. The installer then displays panels (GUI mode) or prompts
(console mode) that ask for product configuration information. The sections below show



M
Even Header

Installing and Uninstalling EntireX

Installing Software AG Products Version 9.9 148

the panels, but the information and fields on the panels are identical to the information
and fields in the prompts.

Important: Make sure all ports you specify on panels or in response to prompts are
not already being used by other products on your machine. The installer
cannot detect whether ports are in use when products are shut down, and
the shuing down of products is a requirement for running the installer. See
the list of default ports used by Software AG products.

Supply Product Configuration Information

System Management Hub
EntireX is managed by System Management Hub, so the installer displays the panel
below.

https://empower.softwareag.com/sl24sec/SecuredServices/Products.nav5/Component_Downloads.lnk2/TCPIP/tcpip_used_ports.pdf


M
Odd Header

Installing and Uninstalling EntireX

Installing Software AG Products Version 9.9 149

The actions you can take depend on the contents of your machine.

In this case... You can...

No instances of System
Management Hub exist on the
machine

Customize port values, calculate port values
from a specified base port, or use the legacy
port values that were used by System
Management Hub in earlier releases.

An earlier release of System
Management Hub exists on the
machine

Customize port values or calculate port values
from a specified base port.
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In this case... You can...

One or more instances of
System Management Hub exist
on the machine

Calculate port values from a specified base
port.

Sudo
When you install on a UNIX system, the panel below might appear.

You must either have the installer run the afterInstallAsRoot.sh script, or you must run
the script manually after installation as explained later in this chapter. If you want to
have the installer run the script, the user under which you are running the installer must
be in the sudoers configuration.
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For security reasons, the installer does not store the sudo password in installation
scripts. If you are creating or installing from an installation script, therefore, the
option to use sudo is not available. You will have to run the afterInstallAsRoot.sh
script manually after installation as a user who is in the sudoers configuration. See the
instructions for registering daemons and seing file permissions later in this chapter.

EntireX

Field Entry

License file Full path to the EntireX license file.
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Field Entry

Note: If you are also installing NaturalONE, EntireX uses the
NaturalONE license file.

Default EntireX
Broker TCP/IP and
SSL ports, and
Autostart

When you install EntireX Broker:

TCP/IP and SSL ports to use for the Broker.

Whether the installer should start the default Broker after
installation and turn on the Autostart option so the Broker
will start automatically whenever you start your system.

Application
Monitoring Data
Collector port and
Autostart

Port to use for the Data Collector.

Whether the installer should start the Data Collector
automatically after installation and whenever you start your
system.

System
Management
Hub EntireX
administrator and
Administration
TCP/IP and SSL
ports

When you install the EntireX Administration component:

Administrator name to use to connect to System
Management Hub. If you are installing on a Windows
system and you want the administrator to be a user from
the Active Directory, you must also specify the domain (see
the EntireX documentation).

TCP/IP and SSL ports to use for administration.

Complete the Installation

Install Latest Fixes
Install the latest fixes to EntireX. Fixes might be available from the Empower Product
Support website or the Software AG Update Manager. For instructions on using the
laer, see Using the Software AG Update Manager. Each fix includes a readme file that
contains instructions on installing the fix.

Register Daemons and Set File Permissions
If you installed any EntireX component besides the EntireX Libraries on a UNIX system
and did not use sudo:

1. The installer was not able to register daemons and set file permissions for EntireX
and System Management Hub. Perform these tasks now by executing the script
Software AG_directory/bin/ afterInstallAsRoot.sh as a user who is in the sudoers
configuration.
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Important: You must run this script or some products might not work correctly.

2. Restart the EntireX Broker Admin Service. To do so, run the command /etc/
init.d/sagnetbsrv restart, where n  matches the number in the sagn etbsrv
script in your Software AG_directory/EntireX/bin directory.

3. During installation, you might have told the installer to enable autostart so the
EntireX Broker would start automatically whenever you start your system. However,
since you did not use sudo to install, the installer could not actually enable autostart.
If you want to enable autostart, see the section on seing the local EntireX Broker
autostart in the System Management Hub documentation for instructions.

Set Environment Variables on a UNIX System
If you installed any EntireX component besides the EntireX Libraries on a UNIX system,
you must set the EXXDIR environment variable to the Software AG_directory/EntireX
directory, and set the PATH and LD_LIBRARY_PATH environment variables to include
that directory. To do so, source the EntireX environment script exxenv.csh or exxenv,
depending on the shell you are using. The script is located in the Software AG_directory/
EntireX/INSTALL directory.

Uninstall EntireX
Follow the instructions in Using the Software AG Installer, with the additional guidelines
below.

When shuing down products, also shut down all EntireX Brokers, RPC Servers, and
customer applications that use EntireX libraries. For instructions, see the product
documentation.

If you are going to uninstall Software AG Designer Eclipse, and you want to review or
preserve Eclipse installation information, do so before starting the uninstaller, because
the uninstaller will delete the entire Software AG Designer installation directory. User-
created data that is stored in other directories, such as your workspace, will remain
untouched.

If you are going to uninstall from a Mac OS or other UNIX system, and you used sudo to
register daemons and set file permissions during or after installation, you must also use
sudo to unregister daemons and remove file permissions, as follows:

If you are not going to use an uninstallation script to uninstall, you can choose
the uninstaller option to perform this task, or you can perform this task before
starting the uninstaller by executing the script Software AG_directory/bin/
beforeUninstallAsRoot.sh as a user who is in the sudoers configuration.

If you are going to use an uninstallation script, the uninstaller cannot execute the
script because it does not store the sudo password, for security reasons. You must
execute the script yourself before starting the uninstaller.
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Important: You must either have the uninstaller execute the script or run it yourself, or
some products might not work correctly.
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Database Components
If you installed the products below, you must create database components for them.

ActiveTransfer

Blaze

CloudStreams

Integration Server

Mediator

Mobile Support

Monitor

My webMethods Server

OneData

Optimize

Process Engine

Rules Engine

Trading Networks

A database component is a grouping of database objects that can be used by one or more
products. For example, Integration Servers write service status data to the ISCoreAudit
database component, and Monitor reads the data and displays it in the My webMethods
user interface. Each database component is named for the type of data that is wrien to
it.

Database Drivers
The products that have Software AG database components use Java Database
Connectivity (JDBC) to interact with their databases; specifically, to query and update
data in database components.

Blaze uses database drivers supplied by the database vendors. For more information, see
Using Blaze Rules with BPM and CAF.

All other products use the DataDirect Connect JDBC 5.1 database driver. The products
come with the client component of this driver; it is a Type 5 JDBC native-protocol
driver that does not have a server component. The products use the driver to convert
JDBC requests from Java programs directly into the vendor-specific database protocol
that each type of RDBMS can understand. The products execute DDL commands at
install time and sometimes design time for each RDBMS with which they interact. For
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information about the DataDirect Connect JDBC driver, see DataDirect Connect for JDBC
User's Guide and Reference 5.1, available on the Software AG Documentation website.

To enable products to interact with a database component, you provide database
connection parameters, usually during product installation, and the Software AG
Installer uses the parameters to configure JDBC connection pools. After product
installation and database component creation is complete, you set up the products to use
the appropriate connection pools.

Note: If you want your products to exchange data with databases outside the
product suite database components, you can use the webMethods Adapter
for JDBC. For more information, see the webMethods Adapter for JDBC
documentation.

Data Storage

Integration Server Data Storage
Integration Server can persist the types of data below.

Note: For detailed information on product concepts mentioned below, see the
relevant product documentation.

Database
Component

Types of Data Integration Server
writes this data
when...

ISInternal Scheduled tasks, client certificate
mappings, run-time data for
pub.storage services, audit log of
guaranteed delivery transactions,
trigger joins, and configuration and
runtime data for OAuth.

You are using the
features listed in
the Types of Data
column

ISCoreAuditLog Error, guaranteed delivery, service,
security, and session audit data.

Logging is
enabled

 Documents that are in doubt, have
failed, or have exhausted trigger
retries.

You are using
triggers

CrossReference Cross-referencing data for publish-
and-subscribe solutions.

You are using
publish-and-
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Database
Component

Types of Data Integration Server
writes this data
when...
subscribe
solutions

DocumentHistory Document history data for exactly-
once processing in publish-and-
subscribe solutions. Integration Server
uses the data to detect and reject
duplicate documents.

You are using
exactly-once
processing

DistributedLocking Information that coordinates access to
resources across distributed servers
and processes.

Executing
services in the
pub.storage
folder.

Embedded Database versus External RDBMS
When you install Integration Server, the installer asks whether you want Integration
Server to write data to an external RDBMS or an embedded database. You must use an
RDBMS if you are going to:

Cluster Integration Servers.

Install Integration Server in a production environment with high transaction
volumes or large datasets.

Need a database that is scalable, visible, and highly reliable, and that has robust
management and recovery tools.

Write document history or cross-referencing data.

Write Process Audit Log and Process Engine data for business processes.

Have services log their input pipelines, or post user-defined progress messages.

Use triggers.

Use Business Rules.

Use Monitor.

Use pub.storage for high-volume storage.

If none of the above apply, and your database demands are low, your needs might
be met by using the embedded database. For example, you can use the embedded
database as a runtime for adapters, eStandards Modules, or Deployer. You should use
the embedded database with an Integration Server that is an Enterprise Gateway.
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Using the Embedded Database

Integration Server uses Derby, a file-based database, as its embedded database. If one
database file gets corrupted, the entire database might become unusable. Software AG
therefore recommends backing up the Software AG_directory\IntegrationServer\db
folder periodically so you will be able to return to the last known good state if necessary.

When you choose to use the embedded database, Integration Server writes IS Internal
and Cross Reference data to that database, and writes IS Core Audit Log data to files.

If you later want to write these types of data to an external RDBMS instead, you will
need to create the necessary database components in the RDBMS (see "Product Database
Component Descriptions and Installation Requirements" on page 161) and configure
Integration Server to write to them (see "Connect Products to Database Components"
on page 189). You must also complete the steps for switching from the embedded
database to an external RDBMS as described in the webMethods Integration Server
Administrator’s Guide.

Using the External RDBMS

When you use an external RDBMS, you must create the ISCoreAudit, ISInternal, and
DistributedLocking database components in the RDBMS. You must create the ISInternal
and DistributedLocking database components in the same schema (Oracle) or database
(DB2 or SQL Server). You will also create other database components as needed. For
example, if you are using publish-and-subscribe solutions and exactly-once processing,
you will need the CrossReference and DocumentHistory database components; if you
are running business processes, you will need the ProcessAudit and ProcessEngine
database components. For complete information about the database components you
will need to create, see "Product Database Component Descriptions and Installation
Requirements" on page 161.

When you choose to use an external RDBMS, the installer asks you to supply the
database connection. From this information, the installer creates a JDBC connection
pool and configures Integration Server to write IS Internal, IS Core Audit Log, Cross
Reference, Distributed Locking, Document History, Process Audit Log, and Process
Engine data to the external RDBMS using that pool.

Note: This auto-configuration of Integration Server is for ease of use only. You need
not create all the corresponding database components; only create those you
will actually use. Also, in a production environment, you might want to create
additional JDBC connection pools and reconfigure Integration Server to write
different types of data using different pools. "Connect Products to Database
Components" on page 189 provides instructions.

If you are clustering Integration Servers, create an ISCoreAudit database component,
an ISInternal database component, and a DistributedLocking database component in
the same schema (Oracle) or database (DB2 or SQL Server) for the cluster to share.
Also create a CrossReference database component and a DocumentHistory database
component for the cluster to share.
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If you are not clustering Integration Servers, create an ISInternal database component
and a Distributed Locking database component in the same schema (Oracle) or database
(DB2 or SQL Server) for all Integration Servers to share. Also create the ISCoreAudit,
CrossReference, and DocumentHistory database components; you can create a single
instance of each of those database components for all Integration Servers to share, or you
can create a separate instance of each of those database components for each Integration
Server.

My webMethods Server Data Storage
My webMethods Server and Task Engine persist the types of data below.

My webMethods Server writes data about deployment, configuration, security,
portal pages, and run-time operations. It uses this data to manage the My
webMethods user interfaces (for example, the user interfaces for webMethods
Broker, Monitor, Optimize, and Trading Networks) and to support central user
management in Integration Server and Optimize.

Task Engine writes task status, task distribution, and business data. The Task Engine
user interface displays the data.

Embedded Database versus External RDBMS
When you install My webMethods Server, the installer asks whether you want My
webMethods Server (and Task Engine) to write data to an embedded database or an
external RDBMS. You must use an external RDBMS if you are going to:

Cluster My webMethods Servers.

Install My webMethods Server in a production environment.

If none of the above apply, you can use the embedded database when you are installing
My webMethods Server for the sole purpose of running the Broker Messaging user
interface.

Important: If you choose the embedded database during installation, you cannot later
switch to write data to an external RDBMS.

Using the Embedded Database

My webMethods Server uses Derby, a file-based database, as its embedded database.
If one database file gets corrupted, the entire database might become unusable.
Software AG therefore recommends backing up the Software AG_directory\MWS\server
\server_instance \data\db folder regularly so you will be able to return to the last known
good state if necessary. If you do not take a backup, you can restore the database to an
empty state from the Software AG_directory\MWS\server\template-derby.zip\data\db
directory.
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Using an External RDBMS

When you use an external RDBMS, you must create the MywebMethodsServer database
components in your external RDBMS. When you choose the external RDBMS in the
installer, the installer asks you to supply the database connection.

If you are clustering My webMethods Servers, create a single MywebMethodsServer
database component for the cluster to share. If you are not clustering, create a separate
MywebMethodsServer database component for each My webMethods Server.

Product Database Component Descriptions and Installation
Requirements
This section briefly describes each database component and its installation requirements.

Note: For detailed information on product concepts mentioned in the sections
below, see the relevant product documentation.

ActiveTransfer Database Component
If you installed ActiveTransfer Server, you must create the ActiveTransfer database
component.

ActiveTransfer Server writes listener (port), server, user configuration, and other
metadata to this database component. ActiveTransfer Server also writes run-time data,
such as file transfer transaction information and audit data. MashZone displays the
data from this database component in dashboards. If you are clustering ActiveTransfer
Servers, create a single ActiveTransfer database component for the cluster to share. If
you are not clustering, create a separate ActiveTransfer database component for each
ActiveTransfer Server.

Archive Database Component
If you want to archive data from the ISCoreAudit and ProcessAudit database
components (called the "source" database components in this section), create the Archive
database component.

The Archive database component includes a copy of the ISCoreAudit and ProcessAudit
database components. You must create the Archive database component in the same
type of RDBMS as the source database components. Depending on the RDBMS, you can
do the following:

For Oracle, DB2, or SQL Server, you can create the Archive database component
on the same database server as the source database components. In this case, you
must create the Archive database component in a different schema (Oracle or DB2)
or database (SQL Server) than the source database components.

For Oracle or SQL Server, you can create the Archive database component on a
different database server than the source database components, and then create
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a DBlink name for the Archive database component to use to link to each source
database component. If the two source database components are on the same
database server, the Archive database component can use the same DBLink to
connect to both source database components. For instructions on specifying the
DBlink name, see webMethods Monitor User’s Guide.

BPM

Blaze Database Component

If you installed Blaze, create the Blaze database component. Doing so creates a database
table named BLAZE_REPOSITORY. Supply this name when you create the Blaze
repository using the repository creation wizard (see Using Blaze Rules with BPM and
CAF).

BusinessRules Database Component

If you installed the Rules Engine, create the BusinessRules database component. You
must create the database component in the same schema (Oracle) or database (SQL
Server and DB2) as the ProcessAudit database component.

As each Rules Engine instance starts, it registers itself in this database component and
stores information about deployed projects and the state of business rules instances.
When you modify a business rule, the hot deployment functionality in the Business
Rules user interface enables you to deploy changes to all of the instances registered in
this database component.

If you install multiple Rules Engine instances, create a single BusinessRules database
component for the instances to share.

ProcessAudit Database Component

If you installed the Process Engine, create the ProcessAudit database component.

The following write to this database component:

Process Engines write process audit data for business processes they orchestrate.

Task Engines write task audit data.

Third-party products can write process execution data.

Optimize Analytic Engines read process data from this database component so they can
analyze capabilities such as transition duration and write data about analysis-enabled
processes, then displays this data in the Optimize interface in My webMethods. Monitor
also reads process data from this database and displays it in the Monitor interface in My
webMethods, where you can track the status of process instances, view logged values,
and, in some cases, resubmit process instances.

If you are distributing business process steps, you cluster the Process Engines that
orchestrate the steps. Create a single ProcessAudit database component for the cluster to
share. Integration Servers that host these Process Engines, and also Integration Servers
that host the Blaze Rule Service Support package, register themselves in the shared
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ProcessAudit database component. This registration allows users who modify rules
in the Blaze user interface to deploy the modified rules to the registered Integration
Servers.

If you are not distributing business process steps, and therefore not clustering Process
Engines, you can create either a separate ProcessAudit database component for each
Process Engine or a single shared ProcessAudit database component.

Create a single ProcessAudit database components for all Task Engines to share.

If you are using Process Engines, Task Engines, Optimize Analytic Engines, or some
combination of these, create a single ProcessAudit database component for all to share.

ProcessEngine Database Component

If you installed the Process Engine, create the ProcessEngine database component.
Process Engines write process execution data for processes they orchestrate to this
database component.

If you are distributing business process steps, you cluster the Process Engines that
orchestrate the steps. Create a single ProcessEngine database component for the cluster
to share. If you are not clustering, create a separate ProcessEngine database component
for each Process Engine.

CloudStreamsEvents Database Component
If you installed CloudStreams, create the CloudStreamsEvents database component.

CloudStreams Server writes lifecycle (startup/shutdown), error, policy violation,
monitoring, performance metric, and transaction events to the CloudStreamsEvents
database component. CloudStreams Analytics reads the events data and displays it
using MashApps.

If you have multiple CloudStreams Server instances, regardless of whether they are
clustered or not, create a single CloudStreamsEvents database component for them to
share.

Software AG Designer
See "Staging and Reporting Database Components" on page 165.

Integration Server
See " Integration Server Data Storage" on page 157.

MediatorEvents Database Component
If you installed Mediator, create the MediatorEvents database component in the
same schema (Oracle) or database (SQL Server and DB2) as the ISCoreAudit database
component. Mediator writes events about certain SOA policies to the MediatorEvents
database component.
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MobileSupport Database Component
If you installed the Mobile Support package on Integration Server, create the
MobileSupport database component. Mobile Support writes data used for synchronizing
mobile solutions, and metadata about that data, to this database component.

My webMethods Server
See " My webMethods Server Data Storage" on page 160.

OneDataMetadata, OneDataWorkArea, OneDataReleaseArea Database
Components
If you installed OneData, create the OneDataMetadata, OneDataWorkArea, and
OneDataReleaseArea database components.

OneData writes internal configuration data to the OneDataMetadata database
component.

OneData users create data objects and work-in-progress data values in the
OneDataWorkArea database component.

The OneDataReleaseArea database component contains the same data objects as the
OneDataWorkArea database component, and approved data values. Data values are
deployed from the OneDataReleaseArea database component.

You must create each OneData database component in a separate schema (Oracle)
or database (SQL Server), and use a different database user for each database
component. You must create the OneDataMetadata database component first, then
the OneDataWorkArea database component, then the OneDataReleaseArea database
component.

Optimize

Analysis Database Component

If you installed Optimize, create the Analysis database component.

Optimize Analytic Engines write computed analytics and process and monitoring data
received from Infrastructure Data Collectors and Web Service Data Collectors to the
Analysis database component. The Optimize user interface displays the data.

Create a single Analysis database component for all Optimize Analytic Engines to share.
If you are going to use root cause analysis for business processes, install the Analysis
and ProcessTracker database components in the same schema (Oracle) or database (DB2
or SQL Server).

CentralConfiguration Database Component

The CentralConfiguration database component is automatically created when you create
the MywebMethodsServer database component. The CentralConfiguration database
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component stores the Optimize configuration information you enter in the Central
Configuration interface in My webMethods.

Note: The CentralConfiguration database component is not automatically dropped
when you drop the MywebMethodsServer database component. If you want
to drop the CentralConfiguration database component, you must do so
manually.

ProcessAudit Database Component

If you installed Optimize, create the ProcessAudit database component. See
"ProcessAudit Database Component" on page 162.

ProcessTracker Database Component

If you installed Optimize, create the ProcessTracker database component.

Optimize Analytic Engines write business and process status data received from
processes that are not orchestrated by the Process Engine to the ProcessTracker database
component. The Optimize user interface displays the data. Monitor reads process status
data from this database and displays it in the Monitor interface in My webMethods.

Create a single ProcessTracker database component for all Optimize Analytic Engines
to share. If you are going to use root cause analysis for business processes, install the
ProcessTracker and Analysis database components in the same schema (Oracle) or
database (DB2 or SQL Server).

Staging and Reporting Database Components
If you want to simulate business processes in Software AG Designer using historical
data, create the Staging and Reporting database components. Services you run will
extract the historical data from the ProcessAudit database component and aggregate and
load the data using the Staging and Reporting database components.

You can create the Reporting and Staging database components in the same schema
(Oracle) or database (DB2 or SQL Server). However, the services that aggregate and load
the historical data consume large amounts of the CPU. For best performance, install the
Reporting and Staging database components on a database server that will not adversely
affect the ProcessAudit or ProcessEngine database components.

The ProcessAudit, Staging, and Reporting database components have a 1-to-1-to-1
relationship. This means that you cannot gather data from multiple ProcessAudit
database components into a single Reporting database component. Simulation can be
performed from only one Reporting database component at a time.

Trading Networks

TradingNetworks Database Component

If you installed Trading Networks Server, create the TradingNetworks database
component.
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Trading Networks Server writes metadata (partner profiles, trading partner agreements,
document types, processing rules, and partner profile groups) and run-time data
(documents, document content parts, aributes, and delivery information) to the
TradingNetworks database component. Trading Networks Server also logs entries about
document processing steps. The Trading Networks user interface displays the data.

If you are clustering Trading Networks Servers, create a single TradingNetworks
database component for the cluster to share. If you are not clustering, create a separate
TradingNetworks database component for each Trading Networks Server.

TradingNetworksArchive Database Component

If you want to archive Trading Networks data, also create the TradingNetworksArchive
database component. Create the TradingNetworks and the TradingNetworksArchive
database components in the same schema (Oracle) or database (SQL Server and DB2).

Infrastructure Database Components
The Storage database component creates default storage structures, such as tablespaces
and user credentials, for all database components.

The table below lists infrastructure database components that are automatically created
when you create product-related database components.

Database Component Description

ComponentTracker Tracks the database components that are created or
dropped.

DataPurge Provides a common method for purging data from the
Analysis and database components.

DatabaseManagement Provides core routines for data purge functionality.

OperationManagement Provides a common method for configuration, logging,
and error handling for any database component.

Preparing for Database Component Creation

Database User
You can create one database user for multiple database components, or you can create
a different database user for each database component. Later sections in this chapter
explain how to create database users.
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The database user must have the permissions listed in the file below.

RDBMS Path to File

Oracle Software AG_directory\common\db\scripts\oracle\storage
\25\create\ora_str_c_ddl_user.sql

Note: Software AG scripts require ALTER SESSION permission
at the time of creating database tables. You can revoke this
permission after the tables have been created.

SQL
Server

Software AG_directory\common\db\scripts\mssql\storage
\30\create\mss_str_c_ddl_user.sql

DB2 Software AG_directory\common\db\scripts\db2\storage\30\create
\db2_str_c_ddl_user.sql

Storage
You can create all database component objects in the same storage or you can create the
objects for each database component in its own storage. If database storage does not yet
exist, you must create it at the same time you create your database components. Later
sections in this chapter explain how to create storage.

By default, all database components follow the storage convention below. You can use a
different storage convention when you create storage.

RDBMS Data Storage Unit Index Storage Unit BLOB Storage
Unit

Oracle tablespaces WEBMDATA WEBMINDX WEBMDATA

SQL Server filegroups Primary Primary Primary

DB2 for LUW
tablespaces

WEBMDATA WEBMINDX WEBMBLOB

Database Administrator Account
You need DBA access only if you want to use the Database Component Configurator to
create the necessary database users and storage objects.

Your products are designed to use the database users you create for the database
components.
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Character Set and Sort Order
Your products are globalized and support Unicode. Software AG strongly recommends
choosing a Unicode encoding for your database and the most appropriate sort order for
your environment. A database character set determines which languages a database can
represent. Database sort order determines collation and comparison behavior.

The sections below list the most appropriate Unicode character encoding and sort order
for each RDBMS that your products support. If you want to use a different character set
or sort order than recommended below, consult your database administrator and your
RDBMS vendor's documentation so you can carefully choose a database character set
that supports the languages your data is in.

If you use the Database Component Configurator to create your database components,
you can check whether the selected RDBMS is configured for the Unicode character
set. If the RDBMS does not support Unicode, the configurator lists the character set the
RDBMS does support.

Important: You must set character set and sort order before creating storage.

Oracle
Database schemas for Oracle use character data types. For character data types, Oracle
supports the UTF8 and AL32UTF8 Unicode encodings. While UTF8 is CESU-8 compliant
and supports the Unicode 3.0 UTF-8 Universal character set, AL32UTF8 conforms to
the Unicode 3.1 or higher UTF-8 Universal character set. For nchar data types, Oracle
supports the AL32UTF8 and AL16UTF16 Unicode encodings. The supported Unicode
version for AL32UTF8 depends on the Oracle database version. Oracle database schemas
for your products do not have linguistic indexes. Software AG recommends these
character sets and sort order:

For... Software AG recommends...

Character set AL32UTF8

Nchar character set AL16UTF16

Sort order Binary

You can check database configuration and session seings by viewing the
SYS.NLS_DATABASE_PARAMETERS or V$NLS_PARAMETERS parameter.

SQL Server
Database schemas for SQL Server use nchar data types. SQL Server provides support
for UTF-16 through its nchar data types. Since nchar data types are always in UTF-16,
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you do not have to perform any special database configuration and can choose the most
appropriate code page for your environment as a database character set. Software AG
recommends these character sets and sort order:

For... Software AG recommends...

Character set The appropriate encoding for the languages your data is in.

Nchar character
set

UTF-16

Sort order Any case-insensitive collation type.

Important: If you do not choose a case-insensitive sort order, you
will not be able to create some database components in
SQL Server.

You can check the database configuration using the sp_helpdb database  stored
procedure.

DB2 for LUW
Database schemas for DB2 use character data types. DB2 supports UTF-8 for character
data types and UTF-16 for graphic data types. Software AG recommends these character
sets and sort order:

For... Software AG recommends...

Character set CCSID 1208 (UTF-8)

Note: My webMethods Server requires this character set.

Graphic Character Set UTF-16

Sort order IDENTITY_16BIT

Note: This sort order ensures the same sorting result for
both character and graphic data types.

You can check the database configuration using the GET DATABASE
CONFIGURATION command.

Page and Block Size
Use the page and block sizes specified below for each type of RDBMS.
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RDBMS Required Page and Block Size Default

Oracle 8k page/block size 8k

SQL Server 8k page/block size 8k

DB2 32k page size 4k

Set Database Options

Oracle
For your products to function properly, you must set the NLS_LENGTH_SEMANTICS
initialization parameter to BYTE.

Important: Your products use BYTE rather than CHAR semantics because BYTE is
the default configuration of Oracle database and is used by most Oracle
users. If you try to use your products with CHAR semantics, unexpected
results might occur. For example, since CHAR semantics allow storage of
longer data than BYTE semantics (for Japanese, varchar(12 byte) takes four
characters in UTF8 while varchar(12 char) takes 12), using CHAR semantics
could cause the buffer in some products to overflow.

SQL Server
The following database seings are required for your products to function properly:
ALTER DATABASE database_name SET ALLOW_SNAPSHOT_ISOLATION ON;           
ALTER DATABASE database_name SET READ_COMMITTED_SNAPSHOT ON;

In addition, enable Named Pipes and TCP/IP protocols using the SQL Server
Configuration Manager.

By default, SQL Server uses case-insensitive collations. If you create the My webMethods
Server database component, do not change this option from the default; My
webMethods Server does not support case-sensitive collations.

Install the Database Component Configurator and Database
Scripts
The Database Component Configurator and database scripts are available through the
Software AG Installer. For complete instructions on using the installer, see Using the
Software AG Installer.
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1. Download the Software AG Installer as instructed by your installation email from
Software AG to the appropriate machine, as follows:

If you are going to create database
components...

Download the Software AG Installer to...

Automatically, using the
Database Component
Configurator

Any machine on the same network as your
database server

Manually, using database scripts A machine equipped with the database client
for your type of RDBMS

2. Start the installer.

3. In the product selection list, select Database Configuration > Database Scripts or Database
Component Configurator, as desired.

4. The Database Component Configurator has the default environment seings shown
below. If necessary, you can change them as described below.

a. Go to the Software AG_directory \common\db\bin directory.

b. Open the setEnv.{bat|sh} file in the text editor and edit the fields as necessary.

Setting Determines whether the configurator... Default

-DtermOutOn Writes execution information to
the console.

true

-DspoolOn Logs execution information. true

-DlogLevel Sets the log level to INFO (high-
level information) or DEBUG
(more detailed information,
including internal processing
and SQL calls).

INFO

-Dlog.dir This seing specifies the full
path to the directory in which
to store the log files. Make sure
you have permission to write to
this directory.

Software AG_directory\
common\db\logs

c. Save and close the file.
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Use the Database Component Configurator Graphical User
Interface
This section explains how to use the Database Component Configurator graphical user
interface (GUI) to create or drop a database user and storage, and to create or drop
database components. Each run of the configurator operates on a single schema.

You can use the Database Component Configurator GUI on all operating systems that
are supported by your products. UNIX systems must have an X Windows environment.

The configurator writes execution information to the Results tab and to a log file named
dcc_yyyymmddHHMMss  in the Software AG_directory\common\db\logs directory.

Create Database Components, Database User, and Storage
If database storage does not yet exist, you must create it either before or at the same time
that you create your database components.

Important: When you create database components in DB2 using the Database
Component Configurator, the configurator creates the schema name in all
uppercase leers. Since DB2 is case sensitive for schema names, you must
use all uppercase leers for the schema names when you type them in URLs
for JDBC connection pools, or you will experience problems.

Start the Database Component Configurator GUI
Start the Database Component Configurator GUI as follows:

System Action

Windows On the Start menu, go to Programs > Software AG> Tools > Database
Component Configurator.

UNIX Go to Software AG_directory and run the command
dbConfigurator.sh.
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Initially, some of the fields on the Inputs tab show values you entered for the same fields
in the Software AG Installer during product installation. You can change these values
and specify other field values.

Choose the Action to Perform
In the Action area, in the Type list, click the action to perform, as follows:

Option Action

create Creates the database components you select in the Action area,
and lets you create a database user and storage.
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Option Action

recreate Drops and then re-creates the database components you select in
the Action area.

catalog Displays existing database components on the Results tab.

checkEncoding Checks whether your RDBMS is Unicode-enabled and displays
the answer on the Results tab.

Specify the Connection to the RDBMS
Specify the connection for the configurator to use to connect to the RDBMS.

1. In the RDBMS list, click the RDBMS in which to create the database components.

2. In the URL field, provide the URL for the RDBMS. Sample URL formats for the
DataDirect Connect JDBC 5.1 driver are displayed. Below is additional information
for completing this field.

For Oracle, if you are going to create storage and the Data Purge database
component, you must specify the sysLoginRole connection option on the URL
(for example, ;sysLoginRole=sysdba).

For DB2, if you are going to create database components in a schema other
than the default schema for the specified database user, you must specify these
connection options in the URL, where AlternateID is the name of the default
schema used to qualify unqualified database objects in dynamically prepared
SQL statements:
;AlternateId=schema ;"InitializationString=(SET CURRENT 
PATH=current_path ,schema )"

Important: If you are creating Optimize database components (that is,
Analysis and ProcessTracker), you must specify schema using
all uppercase leers. In addition, you must specify the options
CreateDefaultPackage=true,ReplacePackage=true, and
DynamicSections=3000. These seings will affect all database
components in the same schema or database.

For information about options supported by the DataDirect Connect JDBC 5.1
driver used by your products, including options that support clustering, data
encryption (SSL), and different authentication methods, see DataDirect Connect for
JDBC User's Guide and Reference 5.1, available on the Software AG Documentation
website.

3. In the User ID and Password fields, your entries depend on the task you are going to
perform, as described below.
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Note: You can choose to specify this authentication information in the URL,
using DataDirect options, rather than in these fields.

If you are... Specify...

Creating a database user
and storage in Oracle or
SQL Server

The database user and password to create.

Note: For SQL Server, the user will be created and a
default schema named dbo will be assigned to
that user.

Important: For Oracle, do not use the SYSTEM user
to create the database components in the
SYSTEM schema.

Creating a database user
and storage in DB2 for
LUW

The OS user to which to grant permissions, and
the password for that user.

Creating database
components or
performing the catalog
action

An existing database user and password.

Performing the
checkEncoding action

An existing database user that has create session
and create table privileges, and that database
user's password.

Create Database Components, Database User, and Storage
If you selected create in the Action Type list, do the following In the Action area:

1. Select the database components to create. You can use any of the options below.

Click Component and select one or more database components to create. You can
select All to create all database components.

Click Product and select one or more products whose database components to
create. You can see the list of database components for a product by clicking
Product, clicking print in the Action Type list, clicking Execute, and then clicking the
Results tab.

2. Select from the Version list as follows:
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If you selected... Click...

One or more database
components

Latest. The configurator will create the latest version
of the database component or of all database
components, respectively.

One or more products Latest

3. If you want to also create the database user and storage, follow the steps below.

a. Select the check box labeled as follows:

RDBMS Label

Oracle Create Tablespaces and Database User

SQL
Server

Create Database and Database User

DB2 Create Tablespaces and Grant Permissions to OS User

Note: For DB2 on Linux systems, tablespaces are created for each DB2
database. If you are creating database components in more than one
DB2 database, either the tablespace directory or the tablespace names
must be unique for each DB2 database.

b. In the Admin ID field, identify the database user or operating system user that
has database administrator credentials to create the database user and storage.
Supply the password for the user in the Admin Password field.

c. The next field and your entry depend on your RDBMS.

RDBMS Field and Entry

Oracle or DB2
for LUW

In the Tablespace Directory field, identify the directory in which
to create the tablespaces.

SQL Server In the Database field, specify the database to create.

4. For Oracle or DB2 for LUW, you can select the Use Custom Tablespace Names check
box and specify custom tablespace names in the fields.

For Oracle, the custom tablespace names will replace the defaults WEBMDATA
and WEBMINDX.
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For DB2 for LUW, the custom tablespace names will replace the defaults
WEBMDATA, WEBMINDX, and WEBMBLOB. You can also specify a custom
name to use for the buffer pool for your products (WEBMBUFF by default).

Note: Your products support all tablespace configurations deployed by users.

Execute the Specified Action
1. If you intend to run the configurator more than once, you can set the current field

values as the defaults for subsequent runs by clicking Save Settings as Default. You
can also export field values to .xml files by clicking Export, then later import the
values from a file by clicking Import Configuration. In each case, the values for the two
Password fields are not saved.

2. Click Execute. The execution information is displayed on the Results tab and is
wrien to the log file dcc_yyyymmddHHMMss  in the Software AG_directory \common
\db\logs directory.

Drop Database Components
1. Shut down all products that are connected to the database components you want to

drop, and back up the database components.

2. Start the Database Component Configurator GUI as follows:

System Action

Windows On the Start menu, go to Programs > Software AG> Tools > Database
Component Configurator.

UNIX Go to Software AG_directory and run the command
dbConfigurator.sh.

3. In the Action area, in the Type list, click the action to perform, as follows:

Value Action

drop Drops the database components you select in the Action area.

catalog Lists existing database components on the Results tab.

4. In the Connection area, specify the connection for the configurator to use to connect to
the RDBMS, as follows:
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Field Do this...

RDBMS Click the RDBMS from which to drop the database components.

URL Type the URL for the RDBMS. Sample URL formats for the
DataDirect Connect JDBC 5.1 driver are displayed.

User
ID and
Password

Specify the database user and password to use to connect to the
RDBMS.

5. In the Action area, select the database components to drop, or the products whose
database components to drop.

6. In the Action area, select from the Version list as follows:

If you selected... Click...

One or more database
components

Latest. The configurator will create the latest version
of the database component or of all database
components, respectively.

One or more products Latest

7. Click Execute. The execution information is displayed on the Results tab and is
wrien to the log file dcc_yyyymmddHHMMss  in the Software AG_directory \common
\db\logs directory.

Drop the Storage and Revoke Database User Permissions
If you have dropped all database components in a schema, you can drop the storage and
revoke the database user permissions.

1. Start the Database Component Configurator GUI as follows:

System Action

Windows On the Start menu, go to Programs > Software AG> Tools > Database
Component Configurator.

UNIX Go to Software AG_directory and run the command
dbConfigurator.sh.

2. In the Action Type list, click drop.
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3. In the Action area, click Component and select All.

4. In the Connection area, specify the connection for the configurator to use to connect to
the RDBMS, as follows:

Field Do this...

RDBMS Click the RDBMS from which to drop the database components.

URL Type the URL for the RDBMS. Sample URL formats for the
DataDirect Connect JDBC 5.1 driver are displayed.

User
ID and
Password

Specify the database user and password to use to connect to the
RDBMS.

5. Select the Drop tablespaces and database user check box.

a. In the Admin ID field, identify the database user or operating system user that has
database administrator credentials to drop the database user and storage. Supply
the password for the database user in the Admin password field.

b. The next field depends on your RDBMS.

RDBMS Fields and Entries

DB2 for LUW
and Oracle

In the Tablespace directory field, identify the directory that
contains the tablespaces to drop. If you specified custom
tablespace names, supply those names in the Tablespaces area.

SQL Server In the Database field, specify the database that contains the
storage.

6. Click Execute. The execution information is displayed on the Results tab and is
wrien to the log file dcc_yyyymmddHHMMss  in the Software AG_directory \common
\db\logs directory.

Use the Database Component Configurator Command Line
Interface
This section explains how to use the Database Component Configurator command
line interface to create or drop a database user and storage, and to create or drop
database components. Each run of the configurator operates on a single schema. If
database storage does not yet exist, you must create it before you create your database
components.
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You can use the Database Component Configurator command line interface on all
operating systems that are supported by your products.

Important: When you create database components in DB2 using the Database
Component Configurator, the configurator creates the schema name in all
uppercase leers. Since DB2 is case sensitive for schema names, you must
use all uppercase leers for the schema names when you type them in URLs
for JDBC connection pools, or you will experience problems.

Before dropping any database component, shut down all products that are connected to
the database component.

If you have dropped all the database components from a schema, you can drop the
storage and revoke the database user permissions.

Database Component Configurator Command
You can perform an action on one database component or on all database components,
or on the database components for one product, using the command below. You run the
command from the Software AG_directory\common\db\bin directory.

Main Parameters
dbConfigurator.{bat|sh} {-a|--action} action
{- d|-- dbms}{oracle|sqlserver|db2luw|db2i} 
{{-c|--component} db_component {-v|--version} version
{-l|--url} RDBMS_URL
{-u|--user} db_user  {- p|--password} password
[{-au|--admin_user} db_admin_user  {-ap|--admin_password} password ]

Additional Parameters
[{-tsdata|--tablespacefordata} data_tspace_name ] 
[{-tsindex|--tablespaceforindex} index_tspace_name ] 
[{-tsblob|--tablespaceforblob} BLOB_tspace_name ] 
[{-b|--bufferpool} buffer_pool_name ] 
[-t|--tablespacedir directory ] 
[-n|--dbname database_name ] 
[{-e|--export|-i|--import} {-dir|--configdir} directory
{-file|--configfile} file_name ] 
[-r|--runCatalog] 
[-h|--help] 
[-ab|--about] 
[-pa|--printActions] [-pd|--printDatabase] [-pc|--printComponents] 
[-pp|--printProducts] [-pe]

The parameters and their possible values are explained below.

Main Parameters
{-a|--action} action - action to perform. You can specify the values below.
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Value Action

catalog Displays existing database components.

create Creates db_component or the database components for product.

drop Drops db_component or the database components for product.

recreate Drops db_component or the database components for product,
then creates db_component or the database components for
product.

checkEncoding Checks whether your RDBMS is Unicode-enabled and displays
the answer.

{-d|--dbms} {oracle|sqlserver| db2luw} - RDBMS on which to perform action.
You can specify the values below.

Value RDBMS

oracle Oracle

sqlserver SQL Server

db2luw DB2 for LUW

{-c|--component}db_component {-v|--version}version - database component
version for which to perform action. For db_component, you can specify one or more
database component codes or names. You can see the list of database component codes
and names by specifying -c all with the print action. If you want to specify multiple
codes or names, use commas as separators. For version, you can specify the value
latest. If you specified one database component for db_component, perform action
for the latest version of db_component. If you specified multiple database components
or ALL for db_component, you must specify latest for db_component_version. The
configurator will create the latest version of each database component.

{-pr|--product}product {-v|--version}release - product release associated
with the database components for which to perform action. For product, you can
specify one or more product codes or names, or ALL. You can see the list of database
components for a product by specifying this parameter with the print action. If you
want to specify multiple codes or names, use commas as separators. For release, you
can specify the values below.



M
Even Header

Creating and Dropping Database Components

Installing Software AG Products Version 9.9 182

Value Description

latest Perform action on the database components for the latest
release of product or products.

release Release of product or products for whose database components
to perform action. The configurator will create the correct
versions of the database components for the specified release.

{-l|--url} RDBMS_URL - URL for the RDBMS. For information about options
supported by the DataDirect Connect JDBC 5.1 driver used by your products, see
DataDirect Connect for JDBC User's Guide and Reference 5.1, available on the Software AG
Documentation website. When working with database components on UNIX systems,
you must enclose the URL in double quotes. You can specify the values below.

RDBMS Sample Format for DataDirect Connect Driver

Oracle jdbc:wm:oracle://server:
{1521|port} ;serviceName=service [;option=value]. ..

Important: For Oracle, if you are going to create storage and the
Data Purge database component, you must specify
the sysLoginRole connection option on the URL (for
example, ;sysLoginRole=sysdba).

SQL Server jdbc:wm:sqlserver://server:
{1433|port} ;databaseName=database [;option=value]...

DB2 for
Linux, UNIX,
Windows

jdbc:wm:db2://server:
{50000|port} ;databaseName=database [;option=value]...

For DB2, if you are going to create database components in a
schema other than the default schema for the specified database
user, you must specify these connection options in the URL:
;AlternateId=schema ;"InitializationString=(SET 
CURRENT PATH=current_path ,schema )"

AlternateID is the name of the default schema used to qualify
unqualified database objects in dynamically prepared SQL
statements.

If you are creating Optimize database components (that is,
Analysis and ProcessTracker), you must specify schema  using
all uppercase leers. In addition, you must specify the options
CreateDefaultPackage=true, ReplacePackage=true, and
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RDBMS Sample Format for DataDirect Connect Driver
DynamicSections=3000. These seings will affect all database
components in the same schema or database.

{-u|--user} db_user {-p|--password}password - depends on the action you are
performing.

Note: You can choose to specify this authentication information in the URL, using
DataDirect options, rather than in these parameters.

If you are... Specify...

Creating a
database
user and
storage in
Oracle or
SQL Server

Database user and password to create.

Note: For SQL Server, the user will be created and a default
schema named dbo will be assigned to that user.

Important: For Oracle, do not use the SYSTEM user to create the
database components in the SYSTEM schema.

Creating a
database
user and
storage in
DB2 for
LUW

OS user to which to grant permissions.

Performing
the
checkEncoding
action

Existing database user that has create session and create table
privileges, and that database user's password.

Performing
any other
action

Existing database user and password.

[{-au|--admin_user}db_admin_user {-ap|--admin_password}password] - if you
are going to create a database user and storage, or drop storage and revoke the database
user permissions, database user or operating system user and password that has the
necessary database administrator credentials.

Additional Parameters
[{-tsdata| --tablespacefordatadata_tspace_name] [{-
tsindex|-- tablespaceforindex}index_tspace_name] [{-tsblob|--
tablespaceforblob}BLOB_tspace_name] [{-b|--bufferpool}buffer_pool_name]
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- if you are going to create database components in Oracle and DB2 for LUW, you can
specify custom tablespace names. Your products support all tablespace configurations
deployed by users. For Oracle, the custom tablespace names will replace the defaults
WEBMDATA and WEBMINDX. For DB2 for LUW, the custom tablespace names will
replace the defaults WEBMDATA, WEBMINDX, and WEBMBLOB. You can also specify
a custom name to use for the buffer pool (WEBMBUFF by default). For Oracle or DB2
for LUW, if you are going to drop storage and revoke the database user permissions,
provide the custom tablespace names.

[-t|--tablespacedirdirectory] - if you are going to create a database user and
storage, and want to create a tablespace directory for DB2 for LUW or Oracle, full
path to the directory. For DB2 on Linux systems, tablespaces are created for each DB2
database. If you are creating database components in more than one DB2 database,
either the tablespace directory or the tablespace names must be unique for each DB2
database. If you are going to drop storage and revoke the database user permissions or
DB2 for LUW or Oracle, identify the directory that contains the tablespaces to drop.

[-n|--dbnamedatabase_name] - if you are going to create a database user and storage
in SQL Server, name of the target database. If you are going to drop storage and revoke
the database user permissions in SQL Server, identify the database that contains the
storage.

{-e|--export} {-dir|--configdir}directory {-file|--configfile} file_name
- exports values for all required parameters except the password parameters to an .xml
file.

{-i|--import} {-dir|--configdir}directory {-file|--configfile}file_name
- imports values for all parameters from an .xml file. Password parameters are not saved,
so you must specify them on the command.

[-r|--runCatalog] - runs the catalog action at the end of every execution.

[-h|--help] - lists command line interface help.

[-ab|--about] - lists information about the Database Component Configurator.

[-pa|--printActions] - lists the actions you can perform, like create or drop.

[-pd|--printDatabase] - lists RDBMS the configurator supports.

[-pc|-- printComponents] - lists database components the configurator supports.

[-pp|--printProducts] - lists products the configurator supports.

[-pe] - lists command line interface examples.

Examples

Important: On UNIX systems, you must enclose the RDBMS URL in your commands in
double quotes.
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Create the Database User and Storage
This command creates the database user and the two tablespaces (default names) for
Oracle:
dbConfigurator.bat -a create -d oracle -c storage -v latest 
-l jdbc:wm:oracle://DBserver:1521;serviceName=myservicename -au adminuser 
-ap adminpass -u webmuser -p w3bmpass -t tablespace_dir

This command creates the database user and the two tablespaces (custom names) for
Oracle:
dbConfigurator.bat -a create -d oracle -c storage -v latest 
-l jdbc:wm:oracle://DBserver:1521;serviceName=myservicename -au adminuser 
-ap adminpass -u webmuser -p w3bmpass -t tablespace_dir  -tsdata MYDATA 
-tsindex MYINDEX

This command creates the database and database user for SQL Server:
dbConfigurator.bat -a create -d sqlserver -c storage -v latest 
-l jdbc:wm:sqlserver://DBserver:1433;databaseName=master -u webmuser -p w3bmpass 
-au sa -ap sa_password -n webmdb

This command creates the buffer pool and tablespaces (default names), and grants
permissions for DB2:
dbConfigurator.bat -a create -d db2luw -c storage -v latest 
-l jdbc:wm:db2://vmxpdb01:50000;databaseName=amol -u webmuser -au adminuser 
-ap admin_password -t tablespace_dir

This command creates the buffer pool and tablespaces (custom names), and grants
permissions for DB2:
dbConfigurator.bat -a create -d db2luw -c storage -v latest 
-l jdbc:wm:db2://vmxpdb01:50000;databaseName=amol -u webmuser -au adminuser 
-ap admin_password -t tablespace_dir  -tsdata MYDATA -tsindex MYINDEX 
-tsblob MYBLOB -b MYBUFF

Drop the Storage and Revoke Database User Permissions
If you drop all database components in a schema, you can drop the storage and revoke
the database user permissions.

This command drops the two tablespaces (default names) for Oracle:
dbConfigurator.bat -a drop -d oracle -c storage -v latest 
-l jdbc:wm:oracle://DBserver:1521;serviceName=myservicename -au adminuser 
-ap adminpass -u webmuser -p w3bmpass -t tablespace_dir

This command drops the two tablespaces (custom names) for Oracle:
dbConfigurator.bat -a drop -d oracle -c storage -v latest 
-l jdbc:wm:oracle://DBserver:1521;serviceName=myservicename -au adminuser 
-ap adminpass -u webmuser -p w3bmpass -t tablespace_dir  -tsdata MYDATA 
-tsindex MYINDEX

This command drops the database for SQL Server:
dbConfigurator.bat -a drop -d sqlserver -c storage -v latest 
-l jdbc:wm:sqlserver://DBserver:1433;databaseName=master -u webmuser 
-p w3bmpass -au sa -ap sa_password -n webmdb
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This command drops the buffer pool and tablespaces (default names), and revokes
permissions for DB2:
dbConfigurator.bat -a drop -d db2luw -c storage -v latest 
-l jdbc:wm:db2://vmxpdb01:50000;databaseName=amol -u webmuser -au adminuser 
-ap admin_password -t tablespace_dir

This command drops the buffer pool and tablespaces (custom names), and revokes
permissions for DB2:
dbConfigurator.bat -a drop -d db2luw -c storage -v latest 
-l jdbc:wm:db2://vmxpdb01:50000;databaseName=amol -u webmuser -au adminuser 
-ap admin_password -t tablespace_dir  -tsdata MYDATA -tsindex MYINDEX 
-tsblob MYBLOB -b MYBUFF

Create Database Components
This command creates the latest version of the ProcessAudit and ProcessEngine database
components in Oracle:
dbConfigurator.bat -a create -d oracle -c processaudit,processengine -v latest 
-l jdbc:wm:oracle://DBserver:1521;serviceName=myservicename 
-u webmuser -p w3bmpass

This command recreates (drops and then creates) the latest versions of all database
components in SQL Server:
dbConfigurator.bat -a recreate -d sqlserver -c all -v latest 
-l jdbc:wm:sqlserver://DBserver:1433;databaseName=webmdb -u webmuser -p w3bmpass

This command displays the database components that currently exist in DB2 for LUW:
dbConfigurator.bat -a catalog -d db2udb 
-l jdbc:wm:db2://DBserver:50000;databaseName=webmdb -u webmuser -p w3bmpass

This command creates the latest database components in DB2 when creating in
ALTSCHEMA rather than the default schema for the specified database user:
dbConfigurator.bat -a create -d db2luw -c all -v latest 
-l "jdbc:wm:db2://DBserver:50000;databaseName=webmdb 
;AlternateId=ALTSCHEMA;InitializationString=\SET CURRENT 
PATH=current_path ,ALTSCHEMA\" -u webmuser -p w3bmpass

Drop Database Components
Before dropping, shut down all products that are connected to the database component
and back up the database component.

You cannot drop the Component Tracker database component using the configurator;
you must use a script. For instructions, see "Use the Database Scripts" on page 187.

This command drops the latest ProcessAudit and ProcessEngine database components
from Oracle:
dbConfigurator -a drop -d oracle -c processaudit,processengine -v latest 
-l jdbc:wm:oracle://myserver:1521;serviceName=myservicename -u webmuser 
-p w3bmpass

This command drops the latest versions of all database components from SQL Server:
dbConfigurator.bat -a drop -d sqlserver -c core -v latest 
-l jdbc:wm:sqlserver://myserver:1433;databaseName=webmdb -u webmuser -p w3bmpass
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The command drops the latest version of the Analysis database component from DB2 for
LUW:
dbConfigurator.bat -a drop -d db2luw -c analysis -v latest 
-l jdbc:wm:db2://DBserver:50000;databaseName=webmdb -u webmuser -p w3bmpass

This command drops the latest version of the Analysis database component from DB2
when dropping from ALTSCHEMA rather than the default schema for the specified
database user:
dbConfigurator.bat -a drop -d db2luw -c analysis -v latest 
-l jdbc:wm:db2://DBserver:50000;databaseName=webmdb;AlternateId=ALTSCHEMA 
;"InitializationString=(SET CURRENT PATH=current_path ,ALTSCHEMA)" -u webmuser 
-p w3bmpass

Use the Database Scripts
This section explains how to use database scripts provided by Software AG to create
storage, create a database user and grant database user permissions, drop storage and
revoke database user permissions, and create or drop database components.

If database storage does not yet exist, you must create it before you create your database
components.

Modify Storage Convention
By default, all database components follow this storage convention:

RDBMS Data Storage
Unit

Index Storage Unit BLOB Storage
Unit

Oracle tablespaces WEBMDATA WEBMINDX WEBMDATA

SQL Server filegroups Primary Primary Primary

DB2 for LUW
tablespaces

WEBMDATA WEBMINDX WEBMBLOB

If you want to use a different storage convention when you create database components,
do the following:

1. Go to the Software AG_directory \common\db\scripts directory.

2. Copy the creation scripts for your RDBMS to another directory.

3. Modify the values listed in the table above in the creation scripts.
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Note: Commercial and public domain utilities provide search and replace
functionality across subdirectories. Your products support all tablespace
configurations deployed by users.

Run the Database Scripts
You run the database scripts from your database client. By default, the scripts are stored
in the Software AG_directory\common\db\scripts directory. If you modified the storage
conventions, the creation scripts are stored in the directory to which you copied them.

To determine which scripts to run, go to the Software AG_directory\common\db\bin
directory and run the appropriate command below. The order in which the scripts are
listed is the order in which you should run them. For explanations of the parameters
in the commands below, see " Database Component Configurator Command" on page
180.

Create a Database User and Storage
To list the scripts for creating a database user and storage, run this command:
dbConfigurator.{bat|sh} -a print -d {oracle|sqlserver|db2luw|db2i} -c storage 
-v latest

Drop Storage and Revoke Database User Permissions
If you have dropped all database components from a schema, you can drop the database
user and storage.

To list the scripts for dropping storage and revoking database user permissions, run this
command:
dbConfigurator.{bat|sh} -a print -d {oracle|sqlserver|db2luw|db2i} -cstorage  
-v latest

Create Database Components
To list the scripts for creating individual database components, or all database
components, run the appropriate command below.
dbConfigurator.{bat|sh} -a print -d {oracle|sqlserver|db2luw|db2i}           
-c db_component  -v db_component_version    

To list the scripts for creating the database components for a certain product, run this
command:
dbConfigurator.{bat|sh} -a print -d {oracle|sqlserver|db2luw|db2i} -pr product
-v product_release    
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Drop Database Components
Before dropping, shut down all products that are connected to the database component
and back up the database component.

To list the scripts for dropping individual database components, or all database
components, run this command:
dbConfigurator.{bat|sh} -a print -d {oracle|sqlserver|db2luw|db2i}           
-c db_component  -v db_component_version    

To list the scripts for dropping the database components for a certain product, run this
command:
dbConfigurator.{bat|sh} -a print -d {oracle|sqlserver|db2luw|db2i} -pr product
-v product_release    

Connect Products to Database Components
This section explains how to define the following database connections, if you did not
define them during installation, or if you want to modify the database connections you
set during installation:

From Integration Server or products it hosts to the ActiveTransfer, Archive,
BusinessRules, CloudStreamsEvents, CrossReference, DocumentHistory, ISInternal,
ISCoreAudit, MediatorEvents, MobileSupport, ProcessAudit, ProcessEngine, Staging
and Reporting, and TradingNetworks and TradingNetworksArchive database
components.

From Integration Server to the central user management feature in My webMethods
Server. This feature allows My webMethods Server users to access Integration
Server, enables Integration Server to delegate user management to My webMethods
Server, and enables My webMethods Server's user interfaces to call Integration
Server services.

For instructions on defining the database connections for other products, if you did not
define them during installation, or if you want to modify the database connections you
set during installation, see the following:

Product Documentation

Blaze Using Blaze Rules with BPM and CAF

Software AG
Designer

Software AG Designer online help

My webMethods
Server

Administering My webMethods Server
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Product Documentation

OneData Administering webMethods OneData

Optimize Configuring BAM

Task Engine webMethods Task Engine User’s Guide

Database Connections for Integration Server and Hosted Products
You use Integration Server Administrator to connect Integration Server to database
components, as follows:

You define JDBC database connection pools in Integration Server Administrator. Each
pool defines the connection to a database server that hosts database components.

Integration Server Administrator provides functions that correspond to most
database components (for example, IS Core Audit Log function that corresponds to
the ISCoreAudit database component, a Cross Reference function that corresponds
to the CrossReference database component, and so on). You direct each function
to write to its database components by pointing the function at the appropriate
connection pool.

During Integration Server installation, if you chose an external RDBMS for the
Integration Server database components and supplied the database connection
parameters, the installer automatically did the following:

Configured Integration Server to write to the external RDBMS.

Created a default connection pool from the Integration Server database connection
parameters you supplied.

Pointed the Cross Reference, Distributed Locking, Document History, IS Internal, IS
Core Audit Log, Process Audit Log, and Process Engine functions at that pool.

Note: If you created the MediatorEvents database component, you created it in
the same schema or database as the IS Core Audit Log. Integration Server
therefore writes to the MediatorEvents database component using the
IS Core Audit Log function. Similarly, if you created the BusinessRules
database component, you created it in the same schema or database as the
Process Audit Log. Integration Server therefore writes to the BusinessRules
database component using the Process Audit Log function. There is no
separate function for the MediatorEvents or BusinessRules database
component.

You can edit the default connection pool using the instructions in this section, or you
can create separate pools and redirect individual functions to use them. At run time,
Integration Server creates a separate instance of the appropriate connection pool for each
database component.
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You also use Integration Server Administrator to connect other products to database
components, as follows:

During Trading Networks Server installation, you supplied the database connection
parameters for the TradingNetworks database component. The installer created a
connection pool from those parameters and pointed the Trading Networks function
at that pool. You can edit the connection using Integration Server Administrator
and the instructions below. The same is true for ActiveTransfer Server and Mobile
Support.

If you created the CloudStreamsEvents database component, you must point
that function at a connection pool. The same is true for the Archive, Staging, and
Reporting database components.

You must point the Simulation function at the connection pool for the Reporting
database component.

Integration Server can authenticate clients using internally-defined user and group
information, or it can use the My webMethods Server central user management
feature. To use the laer, and to use the single sign on feature for My webMethods
Server, Integration Server must have a connection pool that points to the My
webMethods Server database component, and the CentralUsers function in
Integration Server must point at that connection pool.

If you installed My webMethods Server in the same directory as Integration Server,
the installer created a connection pool from the My webMethods Server database
parameters you supplied and pointed the CentralUsers function at that pool. If you
installed My webMethods Server in a different directory from Integration Server,
you must create the connection pool and point the CentralUsers function at that pool
using Integration Server Administrator and the instructions below.

Define an Integration Server Connection Pool
1. Start Integration Server, open Integration Server Administrator, and go to the

Settings > JDBC Pools page.

2. On the Settings > JDBC Pools page, click Create a new Pool Alias Definition and complete
the fields as described in the Integration Server online help.

3. Make sure Integration Server can connect to the database by clicking Test Connection.
Then click Save Settings.

Point Integration Server Functions at Connection Pools
1. In Integration Server Administrator, go to the Settings > JDBC Pools page.

2. In the Functional Alias Definitions area, click Edit in the Edit Association column for a
function. In the Associated Pool Alias list, click the pool you want the function to point
to, and then click Save Settings.
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3. In the Functional Alias Definitions area, initialize the pool by clicking Restart in the
Restart Function column for the function. Make sure Integration Server can connect to
the database by clicking  in the Test column for the function.

4. Repeat the previous steps for all functions you want to point at a connection pool.

5. If you created a connection pool for the My webMethods Server database component
and pointed the CentralUsers function at it, go to the Settings > Resources page and
make sure the MWS SAML Resolver URL field is pointing to your My webMethods
Server host and port.

6. Restart Integration Server.

Drop Redundant Database Component
If you used the Database Component Configurator to install database components, and
you installed the Integration Server database components and the Optimize database
components in two different schemas, you will have two instances of the Process Audit
Log database component. Configure Integration Server and Optimize to point to the
same instance using the instructions above for Integration Server and in Configuring
BAM for Optimize. You can then drop the other, redundant instance.
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Overview
If you want products on UNIX systems to automatically start when you start the system
and automatically stop when you shut down the system, you register their daemons.

Many Software AG products provide rc-scripts and a script named daemon.sh so you
can register daemons for those products. When you register the daemon for a product
using daemon.sh, an init-script is generated. At system start and shutdown time, the
init-script changes the current user ID from the root user to the user that owns the rc-
script and then calls the rc-script with the start or stop option, as appropriate.

Other Software AG products provide rc-scripts but not the daemon.sh script. You can
use the daemon.sh script from another product, or you can create your own init-script
and run commands to register those daemons.

Products not mentioned in this appendix do not support UNIX daemon mode.

This appendix explains how to use rc-scripts and the daemon.sh script to register
daemons, and how to create init-scripts and run commands to register daemons.

The products below require the use of sudo when installing on a UNIX system. For
these products, daemons were registered during installation or when you ran the
afterInstallasRoot script after installation.

CentraSite Registry Repository

Software AG Runtime

Command Central

Platform Manager

EntireX and System Management Hub

Apama and MashZone have their own commands to register their daemons, and Presto
can run as a daemon. See the product documentation for more information.

Register Daemons for Products that Provide rc-scripts and
daemon.sh
The table below lists the products that provide both rc-scripts and the daemon.sh script.
The daemon.sh script for each product is in the same directory as the rc-script. All
daemon.sh scripts are identical, so you can use the same one to register all daemons.
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Product Daemon rc-script

CentraSite
Registry
Repository

CentraSite Registry/
Repository

CentraSite/bin/saginm99

Command
Central

Software AG Command
Central Server

profiles/CCE/bin/sagcce99

Integration
Agent

Software AG Integration
Server

profiles/instance_name /bin/
sagis99

Integration
Server

Software AG Integration
Server

profiles/instance_name /bin/
sagis99

My
webMethods
Server

Software AG My
webMethods Server

profiles/instance_name /bin/
sagmws99_default

OneData Software AG OneData
Server

profiles/ODE/bin/sagode99

Optimize

Infrastructure
Data
Collector

Software AG Optimize
Infrastructure Data
Collector

profiles/InfraDC/bin/
saginfrastructuredatacollector99

Platform
Manager

Software AG Platform
Manager

profiles/SPM/bin/sagspm99

Software AG
Runtime

Software AG Runtime profiles/CTP/bin/sagctp99

System
Management
Hub

Software AG Instance
Manager

InstanceManager/bin/cim96

You can execute the daemon.sh script with the options indicated below to register or
unregister daemons for these products. You must log on to your system as the root user
to run the script.
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To do this... Run this command...

Register a daemon for a
specified product

daemon.sh -f full_path_to_rc_script

For Integration Server and My webMethods Server,
add the option -n instance_name.

Unregister a daemon for
a specified product

daemon.sh -r -f full_path_to_rc_script

Register Daemons for Products that Provide rc-scripts but
not daemon.sh
The table below lists the products that provide rc-scripts but do not provide the
daemon.sh script.

Product Daemon rc-script

API-Portal APICloudAgent99 API_Portal/server/sagyap99

webMethods
Broker

webMethods Enterprise
Broker subsystem

Broker/aw_broker96

Content
Service
Platform

CSP Server (Software AG
webMethods Content
Service Platform)

CSP/wrapper/Unix/csp

Optimize
Web Service
Data
Collector

Software AG Optimize WS
Data Collector

optimize/DataCollector/bin/
sagoptimizeDC.sh

Optimize
Analytic
Engine

webMethods Optimize
Analysis Engine

optimize/analysis/bin/
sagoptimizeAE.sh

Terracoa Terracoa Server Array Terracoa/server/wrapper/bin/
tsa-service

Universal
Messaging

nserverdaemon UniversalMessaging/
server/instance_name /bin/
nserverdaemon
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You can execute the daemon.sh script from another product to register the daemons
listed in this section. For a list of products that provide the daemon.sh script, see
"Register Daemons for Products that Provide rc-scripts and daemon.sh" on page 194.

If you did not install any of the products listed in "Register Daemons for Products that
Provide rc-scripts and daemon.sh" on page 194, you can manually create init-scripts
for the products listed in this section and register their daemons as explained below.

Note: The execution of daemon.sh and the manual steps in this section use specific
run-levels and methods for registering UNIX daemons that have been tested
by Software AG. Some systems may offer valid alternative ways for the
daemon registration that are not documented here.

Manually Register a Daemon on an AIX System
1. Log on to the system as the root user.

2. In the /etc directory, create an init-script using the naming convention sagrc-
script_name  (for example, sagis_default99). If you need to create multiple init-scripts
because you have multiple product instances on the same machine, use the naming
convention sagunique_numberrc-script_name .

3. Add the content below to the init-script.
#!/bin/sh
### BEGIN INIT INFO
# Provides:       description
# Required-Start: $network $remote_fs syslog
# Required-Stop:
# Should-Start:   cupsd winbind nmb
# Should-Stop:
# Default-Start:  2 3 5
# Default-Stop:   0 1 6
# Description:    Start/stop script for Software AG daemons
### END INIT INFO
# @full_path_to_rc-script @  # ID for daemon.sh compatibility. 
#
SAGUSER=user_that_installed_products
PATH=/usr/bin":"$PATH
export PATH
USER=`id | cut -d'(' -f2|cut -d')' -f1`
case "${USER}" in
  root)
    su $SAGUSER -c "/bin/sh -c 'full_path_to_rc-script  ${1}'" 
    ;;
  ${SAGUSER})
full_path_to_rc-script  ${1}
    ;;
  *)
    echo "[rc-script_name ] ABORT: user ${USER} may not call this script"
    exit 1
    ;;
esac

4. Execute this command:
chmod +x /etc/sagoptional_unique_numberrc-script_name
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5. Register the daemon by running this command:
/usr/sbin/mkitab "init-script_name :523:wait:/etc/init-script_name
start > /dev/console 2>&1"

Manually Register a Daemon on an HP-UX System
1. Log on to the system as the root user.

2. In the /sbin/init.d directory, create an init-script using the naming convention sagrc-
script_name  (for example, sagis_default99). If you need to create multiple init-scripts
because you have multiple product instances on the same machine, use the naming
convention sagunique_numberrc-script_name .

3. Add the content shown in step 3 of "Manually Register a Daemon on an AIX System"
on page 197 to the init-script.

4. Execute this command:
chmod +x /sbin/init.d/sagoptional_unique_numberrc-script_name

5. Register the daemon by running these commands:
ln -s /sbin/init.d/init-script_name  /sbin/rc2.d/S020init-script_name
ln -s /sbin/init.d/init-script_name  /sbin/rc2.d/K020init-script_name
ln -s /sbin/init.d/init-script_name  /sbin/rc3.d/S020init-script_name
ln -s /sbin/init.d/init-script_name  /sbin/rc3.d/K020init-script_name

Manually Register a Daemon on a Solaris System
1. Log on to the system as the root user.

2. In the /etc/init.d directory, create an init-script using the naming convention sagrc-
script_name  (for example, sagis_default99). If you need to create multiple init-scripts
because you have multiple product instances on the same machine, use the naming
convention sagunique_numberrc-script_name .

3. Add the content shown in step 3 of "Manually Register a Daemon on an AIX System"
on page 197 to the init-script.

4. Execute this command:
chmod +x /etc/init.d/sagoptional_unique_numberrc-script_name

5. Register the daemon by running these commands:
ln -s /etc/init.d/init-script_name  /etc/rc2.d/S020init-script_name
ln -s /etc/init.d/init-script_name  /etc/rc0.d/K020init-script_name
ln -s /etc/init.d/init-script_name  /etc/rc1.d/K020init-script_name
ln -s /etc/init.d/init-script_name  /etc/rcS.d/K020init-script_name

Manually Register a Daemon on a SUSE Enterprise Server System
1. Log on to the system as the root user.
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2. In the /etc/init.d directory, create an init-script using the naming convention sagrc-
script_name  (for example, sagis_default99). If you need to create multiple init-scripts
because you have multiple product instances on the same machine, use the naming
convention sagunique_numberrc-script_name .

3. Add the content shown in step 3 of "Manually Register a Daemon on an AIX System"
on page 197 to the init-script.

4. Execute this command:
chmod +x /etc/init.d/sagoptional_unique_numberrc-script_name

5. Open the system file /etc/sysconfig/boot and check the RUN_PARALLEL variable.

If the variable is set to yes, you are running in parallel boot mode. Register the
daemon by running this command:
insserv -f /etc/init.d/init-script_name

If the variable is set to no, you are running in non-parallel boot mode. Register the
daemon by running these commands:
ln -s /etc/init.d/init-script_name  /etc/rc.d/rc2.d/S020init-script_name
ln -s /etc/init.d/init-script_name  /etc/rc.d/rc2.d/K020init-script_name
ln -s /etc/init.d/init-script_name  /etc/rc.d/rc3.d/S020init-script_name
ln -s /etc/init.d/init-script_name  /etc/rc.d/rc3.d/K020init-script_name
ln -s /etc/init.d/init-script_name  /etc/rc.d/rc5.d/S020init-script_name
ln -s /etc/init.d/init-script_name  /etc/rc.d/rc5.d/K020init-script_name

Manually Register a Daemon on a Red Hat Enterprise Linux 6.x
System
1. Log on to the system as the root user.

2. In the /etc/init.d directory, create an init-script using the naming convention sagrc-
script_name  (for example, sagis_default99). If you need to create multiple init-scripts
because you have multiple product instances on the same machine, use the naming
convention sagunique_numberrc-script_name .

3. Add the content shown in step 3 of "Manually Register a Daemon on an AIX System"
on page 197 to the init-script.

4. Execute this command:
chmod +x /etc/init.d/sagoptional_unique_numberrc-script_name

5. Register the daemon by running these commands:
ln -s /etc/init.d/init-script_name  /etc/rc.d/rc2.d/S020init-script_name
ln -s /etc/init.d/init-script_name  /etc/rc.d/rc2.d/K020init-script_name
ln -s /etc/init.d/init-script_name  /etc/rc.d/rc3.d/S020init-script_name
ln -s /etc/init.d/init-script_name  /etc/rc.d/rc3.d/K020init-script_name
ln -s /etc/init.d/init-script_name  /etc/rc.d/rc5.d/S020init-script_name
ln -s /etc/init.d/init-script_name  /etc/rc.d/rc5.d/K020init-script_name
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Manually Register a Daemon on a Red Hat Enterprise Linux 7.x
System
1. Log on to the system as the root user.

2. In the /usr/lib/systemd/system directory, create an init-script using the naming
convention sagrc-script_name .service (for example, sagis_default99.service).
If you need to create multiple init-scripts because you have multiple product
instances on the same machine, use the naming convention sagunique_numberrc-
script_name .service.

3. Add the content below to the init-script.
# @full_path_to_rc-script @  ID for daemon.sh compatibility.
[Unit]
Description=description
After=multi-user.target
[Service]
Type=forking
User=user_that_installed_products
ExecStart=full_path_to_rc-script  start
ExecStop=full_path_to_rc-script  stop
[Install]
WantedBy=multi-user.target

4. Register the daemon by running this command:
systemctl enable init-script_name .service

Manually Register a Daemon on a Mac OS X System
1. Log on to the system as the root user.

2. In the /Library/LaunchDaemons directory, create an init-script using
the naming convention com.sag.sagrc-script_name .plist (for example,
com.sag.sagis_default99.plist). If you need to create multiple init-scripts because you
have multiple product instances on the same machine, use the naming convention
sagunique_numberrc-script_name .plist.

3. Add the content below to the init-script.
<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE plist PUBLIC "-//Apple Computer//DTD PLIST 1.0//EN"
 "http://www.apple.com/DTDs/PropertyList-1.0.dtd">
<!-- @full_path_to_rc-script @ -->
<plist version="1.0">
<dict>
  <key>Label</key>
  <string>description </string>
  <key>ProgramArguments</key>
  <array>
    <string>/Library/LaunchDaemons/saglaunch.sh</string>
    <string>full_path_to_rc-script </string>
    <string>start</string>
  </array>
  <key>Disabled</key> <false/>
  <key>RunAtLoad</key> <true/>
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  <key>KeepAlive</key> <false/>
  <key>AbandonProcessGroup</key> <true/>
  <key>UserName</key> <string>user_that_installed_products </string>
  <key>GroupName</key> <string>group_for_user </string>
</dict>
</plist>

4. In the same directory, create a file named saglaunch.sh and add the content below.
This script is a stub for calling all further rc-scripts after waiting 120 seconds for NFS
to be available.
#!/bin/sh
# wait for disk and execute
i=120; while [ $i -gt 0 -a ! -f $1 ]; do sleep 1; i=`expr $i - 1` ; done
cd `dirname $1`
$*

5. Set execution permissions for saglaunch.sh.

6. Register the daemon by running this command:
launchctl load -w /Library/LaunchDaemons/init-script_name .plist
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Overview
Software AG products are designed for use anywhere in the world, and enable you to
exchange data with systems and users who speak languages other than your own.

The products use the Universal Character Set (ISO/IEC 10646-2, or Unicode) as the
character set for all internal operations. At minimum, the products support the
requirements of Unicode 3.0. HTML content, including administration tools, uses
Unicode UTF-8 encoding.

For specific information on the testing, configuration, capabilities, and limitations of any
product, see the product’s readme.

Language Packs
The Software AG Installer always installs the U.S. English files necessary to run your
products. However, for many products, you can also install language packs that provide
translated user interfaces, messages, help, and documentation.

Most products support multiple languages at a time; you can install as many language
packs as you need. For products that support multiple languages, your client setup
(that is, browser language preference, default locale in which the product is started,
and locale selected in your user profile) will determine which language you see. If you
operate a product in a locale for which language packs are not available or installed, you
will see U.S. English.

Language packs are available for webMethods Broker on all supported operating
systems. Language packs are available for other products on all supported operating
systems except Mac OS X.

Software AG Designer Language Packs
By default, the language that Software AG Designer uses depends on your JRE default
locale, which in turn depends on your operating system locale seing. If the operating
system locale is not set to the language you want to use, you can override the seing
for Software AG Designer by starting Software AG Designer with the -nl option. For
example, open a command window and enter eclipse.exe -nl ja_JP.

Software AG Designer is based on the Eclipse platform and its projects. Software AG
language packs do not include language packs for plug-ins provided by Eclipse projects.
If you need language packs for those plug-ins, follow the steps below. For background
information about the available translations, their completeness, and more, go to the
Eclipse web site.

1. Start Software AG Designer.

2. Go to Help > Software Updates, click the Available Software tab, and then click Add Site.
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3. In the Location field, type the URL for Eclipse Luna-compatible language packs (for
example, http://download.eclipse.org/technology/babel/update-site/
R0.13.0/luna/) and click OK.

4. Click Refresh, select the language pack for the language you need, and click Install.
Confirm the language pack to install and click Next.

5. Read the license agreement. If you accept the terms, select the check box and click
Finish.

6. Restart Software AG Designer.

Extended Character Set
The Software AG Installer offers an extended character set that extends Java's
java.nio.Charset class to support additional installable character encodings and adds
more than 870 custom character encodings. The extended character set allows you to
use custom character encodings such as EBCDIC and OEM character encodings with
Integration Server, adapters, and services.

Configure Browsers and JRE Font
Some HTML interfaces for Software AG products detect the language seing for your
browser. If you have installed language packs on your products, those interfaces try to
supply the user interface, messages, and data in that language. You can indicate which
of the installed languages to display in your browser as explained below. For supported
browser releases, see System Requirements for Software AG Products.

Browser Action

Firefox Go to Tools > Options > Content, click Choose, and add the
language you want to use to the top of the list.

Google
Chrome

Go to Settings > Show Advanced Settings > Languages, click spell-
checker seings, and add the language you want to use to the
top of the list.

Internet
Explorer

Go to Tools > Internet Options, click Languages, and add the
language you want to use to the top of the list.

Safari Go to System Preferences > Language & Text > Language, and add
the language you want to use to the top of the list.

Your JRE might require modification to display non-ASCII data. If you see hollow
boxes or black squares where you would expect to see non-ASCII characters, you might
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need to modify your JRE’s font configuration file to provide an appropriate font for
displaying these characters. For example, you might install a full Unicode font, such as
Arial Unicode MS, or you can install a font for a particular language. For information on
modifying font configuration file, see J2SE at the Oracle Java SE documentation Web site.

Configure the Proper Locale
If you are going to install or run your products in a locale other than U.S. English, follow
the instructions below.

System Action

Windows These instructions are for Windows 7; instructions for other Windows
systems vary slightly.

1. On the Start menu, go to Control Panel > Regional and Language.

2. Click the Keyboards and Languages tab. If the language you want to
use is not yet installed, click Install/Uninstall Languages and install the
language. In the Display Language area, select the language and click
OK.

3. Make the display locale seing take effect by logging off Windows
and then logging in again.

UNIX Set your shell to the proper locale by seing the LANG environment
variable. Run the appropriate command below:

In an sh shell: LANG=locale; export LANG

In a csh shell: setenv LANG locale
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Overview
This appendix explains how to install your products in Amazon Elastic Compute Cloud
(EC2) and VMWare virtualized environments. The appendix assumes you are familiar
with Amazon EC2 and VMWare.

If you are installing Process Performance Manager, read the PPM Cloud Infrastructure
guide before continuing with this chapter. An Elastic IP is required for the installation.

Running Your Products in an Amazon Elastic Compute Cloud
Environment

Overview
Amazon Elastic Compute Cloud (EC2) provides a robust, infrastructure-as-a-service
(IaaS) solution for provisioning virtual machines. EC2 virtual machines comprise
hardware and an operating system.

You create an account with Amazon EC2 to gain access to this functionality. You then
create preconfigured EC2 virtual machines, or EC2 instances, and install your products
on the instances just as you would install on physical machines. The installed products
in the virtual environment will operate just as they operate on physical hardware with a
few exceptions noted in this appendix.

For information on the operating systems that are supported by your products and by
Amazon EC2, see the System Requirements for Software AG Products.

Configuring a DNS Server
By default, EC2 instance IP addresses are dynamic. If applications outside EC2 will need
to connect to EC2 instances, or if EC2 instances will need to communicate with each
other, configure a DNS server so that the EC2 instance host names can be resolved into
IP addresses.

Logging In to Amazon Web Services
1. In an Internet browser, enter the URL http://aws.amazon.com/ec2/.

2. Create an AWS account, or sign in to your existing AWS account if you have one.

3. Make sure you are signed up for these services:
Amazon Elastic Compute Cloud (EC2)
Amazon Simple Storage Service (S3)
Amazon Cloud Watch
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Elastic Block Store (EBS).

4. Sign in to the AWS Management Console.

5. Click the Amazon EC2 tab.

Creating a Security Group
Click Help in the AWS Management Console and search Documentation for instructions
on creating a security group.

Ask your network or security administrator for a security group to use for your EC2
instances, or work with the administrator to set one up. A security group defines rules
that specify the protocols and IP addresses to use to access EC2 instances. For your
Windows EC2 instances, create a rule that specifies the protocol as RDP and the source
as the public IP address for your organization’s proxy server. This rule will allow
machines in your network to access your Windows EC2 instances.

Note: By default, rules are configured to allow access from anywhere (source
0.0.0.0/0). Change this default to restrict access to only those computers or
networks that require access to this EC2 instance. The number after the /
indicates a range of addresses.

You can also let other Amazon security groups access your security group, and therefore
your EC2 instances.

Creating a Key Pair
Later in this appendix, you will create EC2 instances.

For each Windows EC2 instance, you will ask Amazon to generate a Windows
Administrator password. The passwords will be encrypted, and you will need a key
pair to decrypt the passwords. You will use the passwords to connect to Windows EC2
instances.

For Linux EC2 instances, you do not need passwords. Instead, you will use key pairs to
connect to instances.

Ask your network or security administrator for a key pair to use, or click Help in the
AWS Management Console and search Documentation for instructions on creating a key
pair.

In Windows, when you create the key pair, Amazon generates a .pem file that contains
the private key you will need to decrypt the password. Depending on your browser
seings, you might be prompted to download the file, or the file might be copied
automatically to a predefined location on the local machine. Make sure you know the
location of the file so you can provide it later to decrypt the password.
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Creating and Launching an EC2 Instance
1. Create the EC2 instance from a Software AG-supported operating system image. For

information on the operating systems that are supported by your products and by
Amazon EC2, see the System Requirements for Software AG Products.

Create the EC2 instance with Elastic Block Storage (EBS) boot. EBS (elastic block
storage) is a service that provides block-level storage volumes for use with EC2
instances, and provides permanent storage for the data on your EC2 instance. When
you use an image with EBS, you can stop and start the instance, and your data is
retained across power operation stages. For the latest EBS options for Amazon web
services, go to hp://aws.amazon.com/ebs.

Note: Amazon EC2 also offers instance-stored storage, which is disk storage
that is physically aached to the host computer for an EC2 instance,
and has the same lifespan as the instance. When you use an image with
instance-stored storage, however, you can only end an instance by deleting
(terminating) the instance entirely, and your data is then lost. Create your
EC2 instances with ESB boot instead.

2. Launch the image. For instructions, see the Geing Started guide available at hp://
aws.amazon.com/documentation.

3. In the EC2 instance wizard, do the following:

a. Specify the number of EC2 instances to create, and the size to use for the
instances. For hardware requirements for your products, see "How to Use
This Guide, Recommendations, and Product Licenses" on page 15. Select no
preference for availability zone. Click Continue.

b. You do not need to select or modify any advanced EC2 instance options.

c. In the list of key/value pairs, or tags, specify the Name tag. This tag identifies
your EC2 instance in the AWS Management Console. Type the unique name to
use for the instance in the Value field for the Name key.

Note: The Name tag identifies your EC2 instance in the AWS Management
Console only. It has no relation to the EC2 instance’s machine or host
name.

d. Choose the key pair to use from the list of existing key pairs.

Note: If you just created the key pair, it might take a few minutes to appear. If
the key pair is not yet present, exit the wizard and click Launch Instance
again.

e. Choose the security group to use from the list of existing security groups.

http://aws.amazon.com/ebs
http://aws.amazon.com/documentation
http://aws.amazon.com/documentation
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Note: After you launch the EC2 instance, you will not be able to change to a
different security group for the instance. However, you can add, edit, or
delete security group rules at any time.

f. Click Launch to launch the EC2 instance.

4. On the Instances page, wait for the status of the EC2 instance to change to running.

5. If you configured a DNS server (see "Configuring a DNS Server" on page 208),
update the DNS server with the EC2 instance’s IP address.

Important: Any time you stop and start the EC2 instance, it will be assigned a new
IP address, and you must update your DNS server with that new IP
address.

Connecting to the Linux EC2 Instance
1. In Linux, open an SSH client such as PuTTY. Connect to the Linux EC2 instance

and provide the key pair you obtained earlier. You are logged into the EC2 instance
console as the root user.

2. Set up the fully qualified domain name (FQDN, or FQN) for the Linux EC2 instance
as follows:

a. Update the machine host name for the EC2 instance to an FQN.

Important: If you configured a DNS server (see "Configuring a DNS Server"
on page 208), and you updated your DNS server with this EC2
instance’s IP address, the FQN for the machine host name must
exactly match the entry in the DNS server.

b. If you configured a DNS server, update your DNS client configuration file to
specify the DNS server.

Important: If you reboot your Linux EC2 instance, Amazon will remove the DNS
seing and you will have to update the configuration again.

Connecting to the Windows EC2 Instance
1. In Windows, decrypt the Windows Administrator password you need to access the

EC2 instance from your local machine, as follows:

a. On the Instances page, right-click the row for the EC2 instance and click Get
Windows Password. Amazon displays an encrypted Windows Administrator
password.

Note: It might take as long as 20 minutes after you launch the instance for the
password to become available.
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b. Click Choose and browse to the key pair you created earlier.

c. Decrypt the password and write it down.

Note: You can change the EC2 instance password later as you would any
other Windows user password.

2. Connect to the running Windows EC2 instance as follows:

a. On the Instances page, click the EC2 instance. Copy the public DNS from the
Description tab.

b. Go to the remote desktop connection on your local machine and paste in the
public DNS as the computer name.

c. Connect to the running EC2 instance.

Note: If you see a message that says you cannot connect, reboot the EC2
instance and then try again to connect.

d. Log in to the remote EC2 instance desktop as administrator, and supply the
Windows Administrator password you decrypted. The EC2 instance desktop
opens on the local machine.

3. Set up the fully qualified domain name (FQDN, or FQN) for the Windows EC2
instance as follows:

a. On the Windows Start menu in the EC2 instance desktop, under All Programs,
click EC2ConfigService Settings. Click the General tab and clear the Set Computer
Name check box. Apply the change.

Note: If you do not see EC2ConfigService Settings in the Windows Start menu,
go to the Amazon directory under Program Files in your file system
and locate and run the EC2 configuration application.

b. Update the machine host name for the EC2 instance to an FQN.

Important: If you configured a DNS server (see "Configuring a DNS Server"
on page 208), and you updated the DNS server with this EC2
instance’s IP address, the FQN for the machine host name must
exactly match the entry in the DNS server.

c. When prompted to restart your computer, restart and then reconnect your local
machine to the running EC2 instance using the instructions above.

Installing Your Products on the EC2 Instance
1. Open an Internet browser on the EC2 instance desktop.

2. Follow the instructions in Using the Software AG Installer to download the
Software AG Installer to the EC2 instance and start the installer.
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3. Follow the instructions in this guide ( Installing Software AG Products) to install your
products on the EC2 instance. When you connect your products to each other after
installation, use DNS names to identify host machines rather than IP addresses or the
public DNS name you used earlier to remotely connect to the EC2 instance.

Important: Software AG recommends that you not change the FQN for the EC2
instance after installing your products.

4. Register ports in the security group rules. Open ports that allow access to the
installed products from other security groups and from the Internet. In most cases,
only a front-end load balancer need be directly accessible to the Internet.

Clustering Your Products on EC2 Instances
You can cluster some products in Amazon EC2. You will need to configure a DNS server
(see "Configuring a DNS Server" on page 208. The EC2 instances will use the DNS
server to resolve their fully qualified domain names (FQDNs, or FQNs) into IP addresses
through the Amazon private internal IP address. Then follow the instructions in the
appropriate product documentation to configure the cluster.

You cannot cluster Optimize or Process Performance Manager in Amazon EC2.

Obtaining an Elastic IP Address and Associating It with an EC2
Instance
Each EC2 instance you create has two IP addresses: Amazon’s private internal IP
address, and the external IP address that Internet users will use to access the EC2
instance. By default, the IP addresses are dynamic, which means that each time the EC2
instance is stopped and restarted, the IP addresses for the EC2 instance change.

You can obtain static, or elastic, external IP addresses and associate them with EC2
instances. For example, if you are hosting My webMethods on an EC2 instance, you
would associate an elastic IP address with the instance so users can connect to My
webMethods. Conversely, if you are running your products in Amazon EC2 and
a webMethods Broker is installed for the sole purpose of coordinating messaging
among EC2 instances, you would typically not associate an elastic IP address with the
webMethods Broker host EC2 instance.

Go to the NETWORK & SECURITY > Elastic IPs page, allocate a new elastic IP address, and
then associate the address with an EC2 instance.

You can change the association of an elastic IP address from one EC2 instance to another.
If you stop and start the associated EC2 instance from the AWS Management Console,
you will have to associate the elastic IP address with the EC2 instance again. Any time
you associate or re-associate an elastic IP address with an EC2 instance, you must
update your DNS server with the IP address and the corresponding host name.
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Maintaining and Securing EC2 Instances
For instructions on tasks such as starting, stopping, rebooting, and deleting EC2
instances; monitoring EC2 instance usage; deleting security groups or rules, and
changing elastic IP address associations, click Help in the AWS Management Console and
search the Documentation.

Secure EC2 instances as you secure other security-critical resources in your organization.
For example:

Keep up to date on security patches for OS and third-party applications.
Use the OS firewall in addition to other security mechanisms.
Take appropriate backups.
Protect data stored in the virtualized environment.
Follow best practices for applications, including:

Change all default passwords.
Use encryption on network connections as appropriate.
Enable and review security audit.

Responsibility for security is shared by AWS and you. For the AWS security statement,
go to hp://aws.amazon.com/security.

Running Your Products in a VMWare Virtualized Environment

Overview
With VMWare, you set up virtual machines, or VMWare Guest OSs. You can then install
your products on the VMWare Guest OSs. You can also create clusters or your products
on the VMWare Guest OSs.

For information on the operating systems supported by your products and by VMWare,
see the System Requirements for Software AG Products on the Software AG Documentation
Web site.

Configuring a DNS Server
Configure a DNS server so that your VMWare Guest OS host names can be resolved into
IP addresses.

Setting Up a VMWare Guest OS
Ask your VMWare administrator to set up a VMWare Guest OS. This includes installing
VMWare virtual infrastructure and installing VMWare tools and drivers on the Guest
OS.

http://aws.amazon.com/security
http://documentation.softwareag.com
http://documentation.softwareag.com
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Connecting to the VMWare Guest OS
1. Ask your VMWare administrator for the IP address or DNS name for the VMWare

Guest OS.

2. Connect remotely to the VMWare Guest OS and enter the IP address or DNS name
for the VMWare Guest OS machine.

3. Verify that the machine host name for the VMWare Guest OS is a fully qualified
domain name (FQDN, or FQN).

4. To verify your setup, run the command nslookup FQN (for example, nslookup
mws.softwareag.com). If the command does not return a valid IP address, work
with your DNS administrator to set up the DNS server correctly ("Configuring a
DNS Server" on page 214).

Installing Your Products on the VMWare Guest OS
1. Open an Internet browser on the VMWare Guest OS.

2. Follow the instructions in Using the Software AG Installer to download the
Software AG Installer to the VMWare Guest OS.

3. Follow the instructions in this guide ( Installing Software AG Products) to start the
installer and install your products on the VMWare Guest OS.

Important: Software AG recommends that you not change the machine host name
for the VMWare Guest OS after installing your products.

Clustering Your Products on VMWare Guest OSs
If you want to create a cluster of a certain product on VMWare Guest OSs, use the
instructions in this appendix to create as many VMWare Guest OSs as you need and
to install the product on each VMWare Guest OS. Then follow the instructions in the
appropriate product documentation to configure the cluster.

Securing VMWare Guest OSs
Maintain VMWare Guest OSs as you maintain other security-critical resources in your
organization. For example:

Keep up to date on security patches for OS and third-party applications.
Use the OS firewall in addition to other security mechanisms.
Take appropriate backups.
Protect data stored in the virtualized environment.
Follow best practices for applications, including:

Change all default passwords.
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Use encryption on network connections as appropriate.
Enable and review security audit.
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